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•	 Apple, Mac, Mac OS, and MacBook are trademarks of Apple Inc. registered in the U.S. and other countries.

•	 Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered 
trademark or trademark of Microsoft Corporation in the United States and/or other countries.

•	 MicroSaver is a registered trademark of Kensington Computer Products Group, a division of ACCO Brands.

•	 Adobe, Adobe PDF, Adobe Reader, and Acrobat are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries.

•	 Virtual Remote Tool uses WinI2C/DDC library, © Nicomsoft Ltd.

•	 HDMI, the HDMI Logo and High-Definition Multimedia Interface are trademarks or registered trademarks of HDMI 
Licensing LLC.

•	 DisplayPort and DisplayPort Compliance Logo are trademarks owned by the Video Electronics Standards Associa-
tion.

•	 HDBaseT™ is a trademark of HDBaseT Alliance.

•	 DLP and BrilliantColor are trademarks of Texas Instruments. 

•	 Trademark PJLink is a trademark applied for trademark rights in Japan, the United States of America and other 
countries and areas.

•	 Wi-Fi®, Wi-Fi Alliance®, and Wi-Fi Protected Access (WPA, WPA2)® are registered trademarks of the Wi-Fi Alliance.

•	 Blu-ray is a trademark of Blu-ray Disc Association

•	 CRESTRON and ROOMVIEW are registered trademarks of Crestron Electronics, Inc. in the United States and other 
countries.

•	 Ethernet is either a registered trademark or trademark of Fuji Xerox Co., Ltd.

•	 Other product and company names mentioned in this user’s manual may be the trademarks or registered trademarks 
of their respective holders.

•	 TOPPERS Software Licenses

	 The product includes software licensed under TOPPERS License.

	 For more information on each software, see “readme.pdf” inside the “about TOPPERS” folder on the supplied CD-
ROM.

NOTES
(1)	The contents of this user’s manual may not be reprinted in part or whole without permission.

(2)	The contents of this user’s manual are subject to change without notice.

(3)	Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable 
points, errors or omissions, please contact us.

(4)	Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed 
to result from using the Projector.
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Safety Cautions
Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily 
accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical 
shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this 
unit has been provided.
The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS 
CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus complies with Canadian ICES-003.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

CAUTION
Avoid displaying stationary images for a prolonged period of time.
Doing so can result in these images being temporarily sustained on the surface of the LCD panel.
If this should happen, continue to use your projector. The static background from previous images will 
disappear.

Disposing of your used product

EU-wide legislation as implemented in each Member State requires that used electrical and electronic prod-
ucts carrying the mark (left) must be disposed of separately from normal household waste. This includes 
projectors and their electrical accessories or lamps. When you dispose of such products, please follow the 
guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us 
reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human health 
and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member States.
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WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California 
to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those 
specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regu-
lation could void your right to operate this equipment. This equipment has been tested and found to comply with 
the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a 
particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and receiver.
•	 Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
•	 Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (five Amps) fuse installed for use with 
this equipment. If a power cord is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them 
carefully and heed all warnings.

 Installation
•	 Do not place the projector in the following conditions:
-	 on an unstable cart, stand, or table.
-	 near water, baths, or damp rooms.
-	 in direct sunlight, near heaters, or heat radiating appliances.
-	 in a dusty, smoky or steamy environment. 
-	 on a sheet of paper or cloth, rugs or carpets.
•	 If you wish to have the projector installed on the ceiling:
-	 Do not attempt to install the projector yourself.
-	 The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 
of bodily injury.
-	 In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 
with any local building codes.
-	 Please consult your dealer for more information.
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WARNING
•	 Do not place any objects, which are easily affected by heat, in front of the projector lens. Doing so could lead 
to the object melting from the heat that is emitted from the light output. 

Do not use the projector with it leaning to the left and right. This may result in a malfunction, however, portrait instal-
lation* is possible. For portrait installation, install the projector with the intake vent at the bottom. Observe precautions 
for portrait installation.
*	 A customized stand and a safety cover (sold separately) need to be attached to the projector. (→ page 136)

 Fire and Shock Precautions 
•	 Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your 
projector. Allow enough space between your projector and a wall. (→ page vii)
•	 Do not try to touch the exhaust vent on the left front (when seen from the front) as it can become heated while the 
projector is turned on and immediately after the projector is turned off. Parts of the projector may become temporarily 
heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal 
projector operation. 
	 Use caution when picking up the projector.
•	 Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve 
any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your 
projector. If something should fall into your projector, disconnect it immediately and have the object removed by a 
qualified service personnel.
•	 Do not place any objects on top of the projector.
•	 Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
•	 The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply 
fits this requirement before attempting to use your projector.
•	 Do not look into the lens while the projector is on. Serious damage to your eyes could result.
•	 Do not look into the light source using optical instruments (such as magnifying glasses and mirrors). Visual impair-
ment could result.
•	 When turning on the projector, make sure no one within projection range is looking at the lens.

	
•	 Keep any items (magnifying glass etc.) out of the light path of the projector. The light path being projected from the 
lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause 
an unpredictable outcome such as a fire or injury to the eyes.
•	 Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent.
	 Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the exhaust 
vent.
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•	 Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
-	 Do not use any power cord other than the one supplied with the projector.
-	 Do not bend or tug the power cord excessively.
-	 Do not place the power cord under the projector, or any heavy object.
-	 Do not cover the power cord with other soft materials such as rugs.
-	 Do not heat the power cord.
-	 Do not handle the power plug with wet hands.
•	 Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under 
the following conditions:
-	 When the power cord or plug is damaged or frayed.
-	 If liquid has been spilled into the projector, or if it has been exposed to rain or water. 
-	 If the projector does not operate normally when you follow the instructions described in this user’s manual.
-	 If the projector has been dropped or the cabinet has been damaged.
-	 If the projector exhibits a distinct change in performance, indicating a need for service.
•	 Disconnect the power cord and any other cables before carrying the projector.
•	 Turn off the projector and unplug the power cord before cleaning the cabinet.
•	 Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
•	 When using a LAN cable:
	 For safety, do not connect to the terminal for peripheral device wiring that might have excessive voltage.

 CAUTION
•	 Do not place your fingers inside the lens hood while performing a lens shift. Failure to do so could result in fingers 
being pinched between the cabinet and lens.
•	 Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hang-
ing on the wall can cause damage to the projector.
•	 Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the 
soft case could be damaged.
•	 Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select 
[SETUP] → [OPTIONS(1)] → [FAN MODE] → [MODE] → [HIGH].)
•	 Do not bring the projector holding it by the lens hood. The projector may be dropped down and it may be cause 
of human injury.
•	 If a safety cover (sold separately) is used, do not carry the projector by the cover. The safety cover can come off 
and the projector may be dropped, causing personal injury.
•	 Do not unplug the power cord from the wall outlet or projector when the projector is powered on. Doing so can 
cause damage to the AC IN terminal of the projector and (or) the prong plug of the power cord. 
	 To turn off the AC power supply when the projector is powered on, use the projector’s main power switch, a power 
strip equipped with a switch, or a breaker.

Caution on Handling the Optional Lens
When shipping the projector with the lens, remove the lens before shipping the projector. Always attach the dust cap 
to the lens whenever it is not mounted on the projector. The lens and the lens shift mechanism may encounter damage 
caused by improper handling during transportation. 
Do not hold the lens part when carrying the projector.
Doing so could cause the focus ring to rotate, resulting in accidental dropping of the projector.

Remote Control Precautions
•	 Handle the remote control carefully.
•	 If the remote control gets wet, wipe it dry immediately.
•	 Avoid excessive heat and humidity.
•	 Do not short, heat, or take apart batteries.
•	 Do not throw batteries into fire.
•	 If you will not be using the remote control for a long time, remove the batteries.
•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.
•	 Do not use new and old batteries together, or use different types of batteries together.
•	 Dispose of used batteries according to your local regulations.
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Light Module

1.	 A light module containing multiple laser diodes is equipped in the product as the light source.

2.	 These laser diodes are sealed in the light module. No maintenance or service is required for the performance of 
the light module.

3.	 End user is not allowed to replace the light module.

4.	 Contact qualified distributor for light module replacement and further information.

Laser Safety Caution
•	 This product is classified as Class 2 of IEC60825-1 Second edition 2007-03.
	 Also complies with FDA performance standards 21 CFR 1040.10 and 1040.11 for laser products except for devia-
tions pursuant to Laser Notice No.50, dated June 24, 2007. 
	 Obey the laws and regulations of your country in relation to the installation and management of the device.
•	 The laser module is equipped in this product.
	 Use of controls or adjustments of procedures other than those specified herein may result in hazardous radiation 
exposure.

DO NOT STARE INTO THE LENS WHILE IN USE.

•	 This caution labels are on the side face of the cabinet.

	 The explanatory label of the CLASS 2 LASER PRODUCTS is on the right side of the projector body.

About High Altitude mode
•	 Set [FAN MODE] to [HIGH] when using the projector at altitudes approximately 2500 feet/760 meters or higher.
	 Using the projector at altitudes approximately 2500 feet/760 meters or higher without setting to [HIGH] can cause 
the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the 
projector.
•	 Using the projector at altitudes approximately 2500 feet/760 meters or higher can shorten the life of optical compo-
nents such as the light module.

About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue 
such as a coffee shop or hotel and employing compression or expansion of the screen image with the following func-
tions may raise concern about the infringement of copyrights which are protected by copyright law.
[ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yönetmeliğine Uygundur.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflec-
tions at visual display workplaces this device must not be placed in the direct field of view.
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 Health precautions to users viewing 3D images

Before viewing, be sure to read health care precautions that may be found in the user’s manual included with your 3D 
eyeglasses or your 3D compatible content such as Blu-ray Discs, video games, computer’s video files and the like.
To avoid any adverse symptoms, heed the following:
•	 Do not use 3D eyeglasses for viewing any material other than 3D images.
•	 Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a 
distance can strain your eyes.
•	 Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour 
of viewing.
•	 If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D 
images.
•	 While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry 
vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor. 
•	 View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain. 

Replacing the light source
•	 The laser light source of this device is rated for 20,000 hours* of use. The service life of light source can be affected 
by the usage environment. Contact the NEC customer service support center to purchase a replacement light source.
*	 It is the nominal hours by 50% brightness reduction of the independent  laser light source, and it is not guaranteed.

Power management function
In order to keep power consumption low, the following power management functions (1) and (2) have been set when 
shipped from the factory. Please display the on-screen menu and change the settings (1) and (2) according to the 
aim of using the projector.

1.	 STANDBY MODE (Factory preset: NORMAL)

•	 When [NORMAL] is selected for [STANDBY MODE], the following terminals and functions will not work:

	 HDMI OUT terminal, Ethernet/HDBaseT Port, USB Port, LAN functions, Mail Alert function

	 (→ page 114)

2.	 AUTO POWER OFF (Factory preset: 1 hour)

•	 When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 1 
hour if there is no signal received by any input or if no operation is performed.

	 (→ page 115)
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Clearance for Installing the Projector
Allow ample clearance between the projector and its surroundings as shown below.
The high temperature exhaust coming out of the device may be sucked into the device again.
Avoid installing the projector in a place where air movement from the HVAC is directed at the projector.
Heated air from the HVAC can be taken in by the projector's intake vent. If this happens, the temperature inside the 
projector will rise too high causing the over-temperature protector to automatically turn off the projectors power.

Example 1 – If there are walls on both sides of the projector.

30 cm/11.8" or greater 30 cm/11.8" or greater

Intake ventExhaust vent

NOTE:
The drawing shows the proper clearance required for the front, back and top of the projector.

Example 2 – In the case of portrait projection.

Intake vent

Safety cover

30 cm/11.8" or greater

NOTE:
•	 The drawing shows the proper clearance required for the front, back and top of the projector.
•	 See page 135 for an installation example on portrait projection.
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1. Introduction
❶ What’s in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer.
Please save the original box and packing materials if you ever need to ship your projector.

Projector

Dust cap for lens
*	 The projector is shipped without 

a lens. For the types of lens and 
throw distances, see page 153.

Remote control
(7N901041)

AA alkaline batteries (x2)

Power cord
(US: 79TG0251)
(EU: 79TG0261)

3 Stacking holders (79TG0291)
When stacking projectors (double stacking), the tilt foot of the upper 
projector will be placed onto these stacking holders. (→ page 139)

For North America only
Limited warranty
For customers in Europe: 
You will find our current valid Guar-
antee Policy on our Web Site: 
www.nec-display-solutions.com•	 Important Infomation 

(7N8N5111)
•	 Quick Setup Guide (7N8N5131)
•	 Security Sticker 
	 (Use this sticker when security 

password is set on.)

NEC Projector CD-ROM
User’s manual (PDF) and the 
utility software
(7N952061)
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❷ Introduction to the Projector
This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector
This projector is one of the very best projectors available today. The projector enables you to project precise images 
up to 500 inches across (measured diagonally) from your PC or Mac computer (desktop or notebook), VCR, Blu-ray 
player, or document camera.
You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen, 
and the projector can be permanently mounted on a ceiling*1. The remote control can be used wirelessly.

*1	 Do not attempt to mount the projector on a ceiling yourself.

	 The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 
of bodily injury.

	 In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 
with any local building codes. Please consult your dealer for more information.

 
General

•	 Single-chip DLP projector with high resolution and high brightness

Model name DMD panel Resolution Aspect ratio

PX602UL-WH/PX602UL-BK 0.67 type 1,920 × 1,200 pixels 16:10

PX602WL-WH/PX602WL-BK 0.65 type 1,280 × 800 pixels 16:10

Light source · Brightness

•	 A long-life laser diode is equipped in the light module

	 The product can be operated at low cost because the laser light source (rated for 20,000 hours of use*) can be 
used for a long time without requiring replacement or maintenance.

*	 It is the nominal hours by 50% brightness reduction of the independent  laser light source, and it is not guar-
anteed.

•	 Brightness can be adjusted within a wide range

	 Unlike with ordinary light sources, the brightness can be adjusted from 20 to 100% in 1% increments.

•	 [CONSTANT BRIGHTNESS] mode

	 Brightness normally decreases with use, but by selecting [CONSTANT BRIGHTNESS] mode, sensors inside the 
projector detect and automatically adjust the output, thereby maintaining constant brightness throughout the life 
of the light module. 

	 However, if brightness output is set at the maximum, brightness will decrease with use.

Installation

•	 Wide range of optional lenses selectable according to the place of installation

	 This projector supports 4 types, however PX602UL-WH and PX602UL-BK support 3 types of optional lenses, 
providing a selection of lenses adapted to a variety of places of installation and projection methods.

	 In addition, the lenses can be mounted and removed in one touch.

	 Note that no lens is mounted upon shipment from the factory. Please purchase optional lenses separately.

•	 Tilt-free, portrait projection

	 This projector can be set to any angle within a vertical 360° range.

	 It can also rotate the picture 90° into portrait orientation.

	 This projector cannot be installed with right or left slant besides the portrait projection.

•	 Double stackable for high light output projection

	 By stacking 2 projectors, increased brightness on a large screen is possible.
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•	 Power lens control for quick and easy adjustment

	 By using buttons on the projector or the remote control, zoom, focus, and position (lens shift) can be adjusted.

Videos

•	 Wide range of input/output terminals (HDMI, DisplayPort, BNC, HDBaseT, etc.) and built-in monaural speaker

	 The projector is equipped with a variety of input/output terminals: HDMI, DisplayPort, BNC (5-core), computer 
(analog), HDBaseT, etc.

	 The projector’s HDMI input/output terminals and DisplayPort input terminal support HDCP.

	 HDBaseT, promoted and advanced by the HDBaseT Alliance, is a consumer electronic (CE) and commercial con-
nectivity technology.

•	 Slot for optional board

	 This projector has a slot for optional boards (sold separately).

•	 Simultaneous display of 2 images (PIP/PICTURE BY PICTURE)

	 Two images can be projected simultaneously with a single projector.

	 There are two types of layouts for the two images: “picture-in-picture” (PIP) in which a sub-picture is displayed 
on the main picture, and “picture-by-picture” (PICTURE BY PICTURE) in which the main and sub pictures are 
displayed next to each other.

•	 Multi-screen projection using multiple projectors

	 This projector is equipped with multiple HDMI input & output terminals that can connect multiple projectors in a 
daisy chain. A high quality picture is achieved by dividing and projecting high resolution videos among the various 
projectors.

	 Furthermore, the boundaries of the screens are smoothed using an edge blending function.

•	 Supports HDMI 3D format

	 This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear 
and 3D emitters that support Xpand 3D.

Network

•	 Convenient utility software (User Supportware) provided as standard

	 The three utility software stored in the enclosed NEC Projector CD-ROM (Virtual Remote Tool, PC Control Utility 
Pro 4 (for Windows ) and PC Control Utility Pro 5 (for Mac OS )) can be used. 

•	 CRESTRON ROOMVIEW compatible

	 This projector supports CRESTRON ROOMVIEW,allowing multiple devices connected to the network to be man-
aged from a computer or controller.

Energy-saving

•	 Energy-saving design with a standby power consumption of 0.5 watts

	 When the on-screen menu’s standby mode is set to “NORMAL”, the power consumption in the standby mode is 
0.5 watts.

•	 “LIGHT MODE” for low power consumption and “Carbon Meter” display

	 The projector is equipped with an “LIGHT MODE” for reducing power consumption during use. Furthermore, the 
power-saving effect when the LIGHT MODE is set is converted into the amount of reductions of CO2 emissions 
and this is indicated on the confirmation message displayed when the power is turned off and at “Information” on 
the on-screen menu (CARBON METER).
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About this user’s manual
The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to 
review the user’s manual. This may save you time later on. At the beginning of each section of the manual you’ll find 
an overview. If the section doesn’t apply, you can skip it.
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❸ Part Names of the Projector
Front/Top
The lens is sold separately. The description below is for when the NP35ZL lens is mounted.

Controls
(→ page 7)

Lens

Remote Sensor
(→ page 11)

Lens Hood
Protects the lens.

Remote Sensor (located on the 
front and the rear)
(→ page 11)

Adjustable Tilt Foot 	
(→ page 22)

Indicator Panel
(→ page 7)

Adjustable Tilt Foot
(→ page 22)

Exhaust vent
Heated air is exhausted from here.
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Rear

Stacking holder fixing position 	
(3 positions)
For stacking up the projectors, fas-
ten up the stacking holders supplied 
with this projector.

Safety cover fixing hole 	
(7 positions) 

The fixing holes for installing the 
safety cover (sold separately) that is 

used for portrait installation.
Remote Sensor (located on the 
front and the rear)
(→ page 11)

AC IN terminal
Connect the supplied power cord’s 
three-pin plug here, and plug the 
other end into an active wall outlet. 
(→ page 13)

Main power switch
While AC power is being supplied, 
set the main power switch to ON 
position (|), then your projector will 
enter a standby state.

*	 This security slot supports the MicroSaver ® Security System.

Built-in Security Slot (  )*

Security Bar 
Attach an anti-theft device.

The security bar accepts security 
wires or chains up to 0.18 inch/4.6 

mm in diameter.

Adjustable Tilt Foot
(→ page 22)

Intake vent
Takes in outside air to cool the unit.
There are air intake and ventilation 

holes on the bottom.
(→ page vii, 141)

Terminals
(→ page 8)
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Controls/Indicator Panel

11 10

7

2 3 4 5 8

1

6

13

14

15 16 17

129

1.	  (POWER) Button 
	 (→ page 14, 24)

2.	 POWER Indicator 
	 (→ page 14, 15, 24, 168)

3.	 STATUS Indicator 
	 (→ page 168)

4.	 LIGHT Indicator 
	 (→ page 29, 169)

5.	 TEMP. Indicator 
	 (→ page 169)

6.	 SOURCE Button 
	 (→ page 16)

7.	 AUTO ADJ. Button 
	 (→ page 23)

8.	 3D REFORM Button 
	 (→ page 32)

9.	 MENU Button 
	 (→ page 62)

10.	▲▼◀▶ Buttons 
	 (→ page 62)

11.	ENTER Button 
	 (→ page 62)

12.	EXIT Button 
	 (→ page 62)

13.	SHUTTER Button
	 (→ page 26)

14.	LIGHT Button
	 (→ page 29)

15.	LENS SHIFT/HOME POSITION Button
	 (→ page 19, 26, 124, 156)

16.	FOCUS +/− Button
	 (→ page 21)

17.	ZOOM +/− Button
	 (→ page 21)
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Terminals Features

9 71

4

238

1312 1011 56

1.	 COMPUTER 1 IN/ Component Input Terminal 
(Mini D-Sub 15 Pin) 

	 (→ page 13, 125, 131, 166)

2.	 DisplayPort IN Terminal (DisplayPort 20 Pin)
	 (→ page 126, 166)

3.	 HDMI IN Terminal (Type A) 
	 (→ page 126, 128, 132, 166)

4.	 BNC Input [R/Cr/CV, G/Y/Y, B/Cb/C, H, V] Termi-
nals (BNC × 5) 

	 (→ page 125, 130)

5.	 BNC (Y/C) Input Terminal (BNC × 2) 
	 (→ page 130)

6.	 BNC (CV) Input Terminal (BNC × 1) 
	 (→ page 130)

7.	 USB Port (Type A) 
	 (→ page 167)
	 (For future expansion. This port allows for power sup-
ply.)

8.	 HDMI OUT Terminal (Type A) 
	 (→ page 129)

9.	 Ethernet/HDBaseT Port (RJ-45) 
	 (→ page 133, 134, 167)

10.	3D SYNC Terminal (Mini DIN 4 Pin) 
	 (→ page 40)

11.	PC CONTROL Port (D-Sub 9 Pin) 
	 (→ page 167, 173)
	 Use this port to connect a PC or control system. 
This enables you to control the projector using serial 
communication protocol. If you are writing your own 
program, typical PC control codes are on page 173.

12.	REMOTE Terminal (Stereo Mini)
	 Use this jack for wired remote control of the projector 
using a commercially available remote cable with ⌀3.5 
stereo mini-plug (without resistance).

	 Connect the projector and the supplied remote control 
using a commercially available wired remote control 
cable.

	 (→ page 11)

NOTE: 
•	 When a remote control cable is connected to the REMOTE 

terminal, infrared remote control operations cannot be per-
formed.

•	 Power cannot be supplied from the REMOTE terminal to the 
remote control.

•	 When [HDBaseT] is selected in the [REMOTE SENSOR] 
and the projector is connected to a commercially-available 
transmission device that supports HDBaseT, remote control 
operations in infra-red cannot be carried out if transmission 
of remote control signals has been set up in the transmission 
device. However, remote control using infrared rays can be 
carried out when the power supply of the transmission device 
is switched off.

13.	SLOT
	 (→ page 157)
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❹ Part Names of the Remote Control

1.	 Infrared Transmitter
	 (→ page 11)

2.	 Remote Jack
	 Connect a commercially available 
remote cable here for wired opera-
tion. (→ page 11)

3.	 POWER ON Button
	 (→ page 14)

4.	 POWER OFF Button
	 (→ page 24)

5.	 INFO/L-CALIB. Button
	 Display the [SOURCE(1)] screen 
of the on-screen menu.

	 (→ page 117)

6.	 VOL./FOCUS +/− Buttons
	 (→ page 21)

7.	 D-ZOOM/ZOOM +/− Buttons
	 (→ page 28)

8.	 TEST Button
	 (→ page 70)

9.	 ECO/L-SHIFT Button
	 (→ page 20, 29)

10.	MENU Button
	 (→ page 62)

11.	EXIT Button
	 (→ page 62)

12.	ENTER Button
	 (→ page 62)

13.	▲▼◀▶ Button
	 (→ page 62)

14.	ON-SCREEN Button
	 (→ page 26)

15.	SHUTTER Button
	 (→ page 26)

16.	AV-MUTE Button
	 (→ page 26)

17.	PICTURE Button
	 (→ page 74, 76)

18.	SOURCE Button
	 (→ page 16)

19.	3D REFORM Button
	 (→ page 32)

20.	PIP/FREEZE Button
	 (→ page 27, 53)

1

3

4

6

14

10

12

16

20

7

2

5

8

9

11

15

18
17

13

2119

25
28
32

23
22

35

24

30

26

29

34

27

31
36

33

21.	AUTO ADJ. Button
	 (→ page 23)

22, 23, 24. COMPUTER 1/2/3 But-
ton

	 (→ page 16) 

25.	VIDEO Button
	 (→ page 16)

26.	S-VIDEO Button
	 (→ page 16)

27.	HDMI Button
	 (→ page 16)

28.	DisplayPort Button
	 (→ page 16)

29.	VIEWER Button
	 (The VIEWER button will not work 
on this series of projectors.)

30.	NETWORK Button
	 (→ page 16)

31.	SLOT Button
	 (→ page 158)

32.	ID SET Button
	 (→ page 105)

33.	Numeric (0 to 9/CLEAR) But-
tons

	 (→ page 105)
	 (The AUX button will not work on 
this series of projectors.)

34.	CTL Button
	 This button is used in conjunction 
with other buttons, similar to a 
CTRL key on a computer.

35.	LIGHT Button
	 This button is used to turn on the 
backlight for the remote control 
buttons.

	 The backlight will turn off if no 
button operation is made for 10 
seconds.

36.	HELP Button
	 (→ page 117)
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Battery Installation
1.	 Press the catch and remove 

the battery cover.
2.	 Install new ones (AA). En-

sure that you have the bat-
teries’ polarity (+/−) aligned 
correctly.

3.	 Slip the cover back over the batteries until 
it snaps into place.

NOTE: Do not mix different types of batteries or new 
and old batteries.

1

2 1 2

Remote Control Precautions

•	 Handle the remote control carefully.

•	 If the remote control gets wet, wipe it dry immediately.

•	 Avoid excessive heat and humidity.

•	 Do not short, heat, or take apart batteries.

•	 Do not throw batteries into fire.

•	 If you will not be using the remote control for a long time, remove the batteries.

•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.

•	 Do not use new and old batteries together, or use different types of batteries together.

•	 Dispose of used batteries according to your local regulations.
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Operating Range for Wireless Remote Control

7 m/276 inch

7 m/276 inch

Remote control
Remote sensor on projector cabinet

7 m/276 inch

7 m/276 inch

30°

30°

30°

30°

15°

30°

30°

30°
15°

30°

•	 The infrared signal operates by line-of-sight up to a distance of above meters and within a 60-degree angle of the 
remote sensor on the projector cabinet.

•	 The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls 
on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.

Using the Remote Control in Wired Operation
Connect one end of the remote cable to the REMOTE terminal and the other end to the remote jack on the remote 
control.

REMOTE

Remote Jack

NOTE: 
•	 When a remote cable is inserted into the REMOTE terminal, the remote control does not work for infrared wireless communication.
•	 Power will not be supplied to the remote control by the projector via the REMOTE jack. Battery is needed when the remote control 

is used in wired operation.
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This section describes how to turn on the projector and to project a picture onto the screen.

❶ Flow of Projecting an Image

Step 1
•	 Connecting your computer / Connecting the power cord (→ page 13)

	

Step 2 
•	 Turning on the projector (→ page 14)

	

Step 3 
•	 Selecting a source (→ page 16)

	

Step 4
•	 Adjusting the picture size and position (→ page 18)

•	 Correcting keystone distortion [CORNERSTONE] (→ page 32)

	

Step 5
•	 Adjusting a picture

-	 Optimizing a computer signal automatically (→ page 23)

	

Step 6
•	 Making a presentation

	

Step 7
•	 Turning off the projector (→ page 24)

	

Step 8
•	 After use (→ page 25)

2. Projecting an Image (Basic Operation)
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2. Projecting an Image (Basic Operation)

❷ Connecting Your Computer/Connecting the Power Cord

1.	 Connect your computer to the projector.

	 This section will show you a basic connection to a computer. For information about other connections, see “(2) 
Making Connections” on page 125.

	 Connect the display output terminal (mini D-sub 15 pin) on the computer to the COMPUTER 1 IN terminal on the 
projector with a commercially-available computer cable (with ferrite core) and then turn the knobs of the terminals 
to secure them.

2.	 Connect the supplied power cord to the projector.

	 First connect the supplied power cord’s three-pin plug to the AC IN terminal of the projector, and then connect the 
other plug of the supplied power cord in the wall outlet.

	 Important Information:

•	 When plugging in or unplugging the supplied power cord, make sure that the main power switch is pushed to 
the off [O] position. Failure to do so may cause damage to the projector.

COMPUTER 1 IN

Make sure that the prongs are fully inserted into 
both the AC IN terminal and the wall outlet.

To wall outlet

Computer cable (with ferrite core) 
(sold commercially)

 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.
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2. Projecting an Image (Basic Operation)

❸ Turning on the Projector
NOTE:
•	 The projector has two power switches: A main power switch and a POWER button (POWER ON and OFF on the remote control)
• Turning on the projector:
1.	 Press the main power switch to the ON position (I).

	 The projector will go into standby mode.

2.	 Press the POWER button .

	 The projector will become ready to use.

• Turning off the projector:
1.	 Press the POWER button.

	 The confirmation message will be displayed.

2.	 Press the POWER button again.

	 The projector will go into standby mode.

3.	 Press the main power switch to the OFF position (O).

	 The projector will be turned off.

 
1.	 Press the main power switch to the ON position ( I ). 

	 The POWER indicator lights up red.*

*	 This indicates that the STANDBY mode is in [NORMAL] 
setting.

	 (→ page 114, 168) 

 WARNING

The projector produces a strong light. When turning on 
the power, make sure no one within projection range is 
looking at the lens.

2.	 Press the  (POWER) button on the projector cabinet 
or the POWER ON button on the remote control. 

	 The POWER indicator goes from a steady red light to 
a flashing blue light, and the picture is projected on the 
screen.

TIP: 
•	 When the message “PROJECTOR IS LOCKED! ENTER YOUR 

PASSWORD.” is displayed, it means that the [SECURITY] 
feature is turned on. (→ page 35)

•	 When the ECO message is displayed, it means that [ON] is 
selected for [ECO MESSAGE]. (→ page 95)

	 After you turn on your projector, ensure that the computer 
or video source is turned on.

NOTE: The logo screen ([LOGO] background) is displayed when no 
signal is being input (by factory default menu settings).
 

 

Standby Blinking Power On

Steady red light Blinking blue 
light

Steady blue 
light

(→ page 168)
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Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one 
of the 29 menu languages.

To select a menu language, follow these steps:

1.	 Use the ▲, ▼, ◀ or ▶ button to select one of the 29 
languages from the menu.

 

2.	 Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu 
operation.
If you want, you can select the menu language later.
(→ [LANGUAGE] on page 66 and 94)

 

NOTE: 
•	 If one of the following things happens, the projector will not turn on.

-	 If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the 
projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool 
down.

-	 If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. 
Cancel the lock by turning it off. (→ page 104)

•	 While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button. (While the 
POWER indicator is blinking blue in long cycles, the OFF TIMER is functioned and the power can be turned off.)
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❹ Selecting a Source
Selecting the computer or video source
NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically
Press the SOURCE button for 1 second or longer. The projector will 
search for the available input source and display it. The input source will 
change as follows: 

HDMI → DisplayPort → BNC → BNC(CV) → BNC(Y/C) → COMUPTER 
→ HDBaseT → SLOT → …

•	 Press it briefly to display the [INPUT] screen. 

	 Press the ▼/▲ buttons to match the target input terminal and then 
press the ENTER button to switch the input. To delete the menu display 
in the [INPUT] screen, press the MENU or EXIT button.

TIP: If no input signal is present, the input will be skipped.

 

Using the Remote Control
Press any one of the HDMI, DisplayPort, COMPUTER 2, VIDEO, S-
VIDEO, COMPUTER 1, NETWORK, or SLOT buttons.
•	 COMPUTER 2 button selects the BNC input terminal.

•	 VIDEO button selects the BNC (CV) input terminal (Composite Video).

•	 S-VIDEO button selects the BNC (Y/C) input terminal (S-Video).
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Selecting Default Source 
You can set a source as the default source so that it will be displayed each time the projector is turned on.

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the ▶ button to select [SETUP] and press the ▼ button or the ENTER button to select [BASIC].

3.	 Press the ▶ button to select [SOURCE OPTIONS].

4.	 Press the ▼ button four times to select [DEFAULT INPUT SELECT] and press the ENTER button.

	 The [DEFAULT INPUT SELECT] screen will be displayed.

	 (→ page 112)

5.	 Select a source as the default source, and press the ENTER button.

6.	 Press the EXIT button three times to close the menu.

7.	 Restart the projector.

	 The source you selected in step 5 will be projected.

NOTE: Even when [AUTO] is turned on, the [HDBaseT] will not be automatically selected. To set your network as the default source, 
select [HDBaseT].

TIP: 
•	 When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER 1 IN input 

will power on the projector and simultaneously project the computer’s image.
	 ([AUTO POWER ON SELECT] → page 115)
•	 On the Windows 7 keyboard, a combination of the Windows and P keys allows you to set up external display easily and quickly.
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2. Projecting an Image (Basic Operation)

❺ Adjusting the Picture Size and Position
Use the lens shift dial, the adjustable tilt foot lever, the zoom lever/zoom ring and the focus ring to adjust the picture 
size and position.
In this chapter drawings and cables are omitted for clarity.

Adjusting the projected image’s vertical and horizontal 
position
[Lens shift]
(→ page 19)

Adjusting the focus
[Focus]
(→ page 21)

Finely adjusting the size of an image
[Zoom]
(→ page 21)

Adjusting the projected image’s height and horizontal tilt
[Tilt foot] *¹
(→ page 23)

NOTE*1: Adjust the projected image’s height using the tilt feet when you want to project the image at a position higher than the lens 
shift adjustment range.
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Adjusting the vertical position of a projected image (Lens shift)

 CAUTION
•	 Perform the adjustment from behind or from the side of the projector. Performing adjustment from the front could 
expose your eyes to strong light which could injure them.
•	 Keep hands away from the lens hood while the lens shift is in operation. Failure to do so could result in fingers 
being pinched between the lens and the lens hood.

Adjusting with buttons on the cabinet
1.	 Press the LENS SHIFT/HOME POSITION button.

	 The [LENS SHIFT] screen will be displayed. 

2.	 Press the ▼▲◀ or ▶ button.

	 Use the ▼▲◀▶ buttons to move the projected image.

•	 Returning the lens shift position to the home position

	 Press and hold the LENS SHIFT/HOME POSITION button for 2 seconds to return the lens shift position to the 
home position (nearly center position)
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Adjusting with the remote control
1.	 Hold the CTL button and press the ECO/L-SHIFT button.

	 The [LENS SHIFT] screen will be displayed. 

2.	 Press the ▼▲◀ or ▶ button.

	 Use the ▼▲◀▶ buttons to move the projected image.

TIP: 
•	 The diagram below shows the lens shift adjustment range for the PX602UL-WH and PX602UL-BK (projection mode: desktop 

front). To raise the projection position higher than this, use the tilt feet. (→ page 22)
•	 For the PX602WL-WH/PX602WL-BK and the ceiling mount/front projection lens shift adjustment range, see page 156.

100%V

50%V

50%V
20%V* 20%V*

20%V*20%V*

100%H

15%H

15%H

15%H

15%H

10%H

10%H 10%H

10%H

Height of projected image

Width of projected image

*	 30%V for the PX602WL-WH/PX602WL-BK.
	 Description of symbols: V indicates vertical (height of the projected image), H indicates horizontal (width of the projected image).
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Focus
1.	 Press the FOCUS +/− button.

•	 On the remote control, while pressing on the CTL button, press on VOL/FOCUS (+) or (−) button.

	 The focus is adjusted.

Zoom
1.	 Press the ZOOM +/− button.

•	 On the remote control, while pressing on the CTL button, press the D-ZOOM/ZOOM (+) or (−) button.

	 The zoom is adjusted.
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Adjusting the Tilt Foot
1.	 The position to project image may be adjusted by the tilt feet 

positioned at right, left and rear of the cabinet bottom.

	 The tilt foot height can be adjusted by its turn.

	 “To adjust the height of the projected image”

	 The height of the projected image is adjusted by turning the left and 
right tilt feet.

	 “If the projected image is tilted”

	 If the projected image is tilted, turn one of the tilt feet to adjust the 
image so that it is level.

	 “To adjust the projector so that it is perpendicular to the screen”

	 Turn the rear tilt foot to adjust its height.

•	 If the projected image is distorted, see “3-7 Correcting Horizontal 
and Vertical Keystone Distortion [CORNERSTONE]” (→ page 32) 
and “[GEOMETRIC CORRECTION]” (→ page 100).

•	 The tilt foot can be lengthened by a maximum of 48 mm.

•	 The tilt foot can be used to tilt the projector by a maximum of 6°.

NOTE:
•	 Do not lengthen the tilt foot any more than 50 mm/1.9". Doing so will make the 

tilt feet’s mount section unstable and could cause the tilt feet to come off the 
projector.

•	 Do not use the tilt foot for any purpose other than adjusting the projector’s 
projection angle.

	 Handling the tilt foot improperly, such as carrying the projector by grasping the 
tilt foot or hooking it onto a wall using the tilt foot, could damage the projector.

 

Up

Tilt foot
(there is one more in the rear)

Down
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❻ Optimizing Computer Signal Automatically
Adjusting the Image Using Auto Adjust
When an image from HDMI IN, DisplayPort IN, BNC input terminal (analog RGB), COMPUTER 1 IN, or HDBaseT is 
being projected, and the edge is cut off or the image quality is poor, this button can be used to automatically optimize 
the projection image on the screen.

Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer 
for the first time.

 

[Poor picture] [Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
•	 If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] 

manually. (→ page 78, 79)
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❼ Turning off the Projector
To turn off the projector:

1.	 First, press the  (POWER) button on the projector 
cabinet or the POWER OFF button on the remote con-
trol. 

	 The [POWER OFF / ARE YOU SURE ? / CARBON SAV-
INGS- SESSION 0.000[g-CO2]] message will appear.

 

2.	 Secondly, press the ENTER button or press the  
(POWER) or the POWER OFF button again.

	 When the projector is in STANDBY MODE, the POWER 
indicator lights up red. (When [STANDBY MODE] is in 
[NORMAL] setting)

3.	 Make sure the projector is in STANDBY MODE, then 
turn off the main power switch (○ OFF)

	 The POWER indicator will go off and the main power will 
turn off.

•	 While the POWER indicator is blinking blue in short 
cycles, the power cannot be turned off.

Power On

Steady blue light

Standby

Steady red light
Press twice

 CAUTION:
Parts of the projector may temporarily overheat if the projector is turned off with the main power switch or the AC 
power supply is disconnected while the projector is in operation or the cooling fan is running. Handle with care.
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NOTE:
•	 Do not unplug the power cord from the projector or from the power outlet while an image is being projected. Doing so could 

deteriorate the projector’s AC IN terminal or the power plug’s contact. To turn off the AC power supply when the projector is 
powered on, use the projector’s main power switch, a power strip equipped with a switch, or a breaker.

•	 Do not turn off the main power switch or disconnect the AC power supply within 10 seconds of making adjustments or setting 
changes and closing the menu. Doing so can cause loss of adjustments and settings.

❽ After Use
Preparation: Make sure that the projector is turned off.

1.	 Unplug the power cord.

2.	 Disconnect any other cables.

3.	 Mount the lens cap on the lens.

4.	 Before moving the projector, screw in the tilt feet if they have been lengthened.
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3. Convenient Features
❶ Turn off the light of the projector (LENS SHUTTER)
Press the SHUTTER button. 
The light source will turn off and the light of the projector will temporarily 
go dark.
Press again to allow the screen to become illuminated again.
•	 Another way to shut the light source off is to press the SHUTTER 
button on the remote control.

 

NOTE: 
•	 Do not press and hold the LENS SHIFT/HOME POSITION button for 2 seconds or longer.
	 Doing so will cause the lens shift position to return to the home position.
 

❷ Turning off the Image
Press the AV-MUTE button to turn off the image for a short period of time. 
Press again to restore the image.

TIP:
•	 The video will disappear but not the menu display.

❸ Turning Off the On-Screen Menu (On-Screen Mute)
A press of the ON-SCREEN button on the remote control will hide the 
on-screen menu, the source display and other messages. Press again 
to restore them. 

TIP:
•	 To confirm that the on-screen mute is turned on, press the MENU button. If the on-screen menu is not displayed even though 

you press the MENU button, it means the on-screen mute is turned on.
•	 The on-screen mute is maintained even when the projector is turned off,
•	 Holding down the MENU button for at least 10 seconds will turn off the on-screen mute.
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❹ Freezing a Picture
Hold the CTL button and press the PIP/FREEZE button to freeze a picture. 
Press again to resume motion.

NOTE: The image is frozen but the original video is still playing ahead.
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❺ Magnifying a Picture
You can magnify the picture up to four times.

NOTE: The maximum magnification may be less than four times depending on the signal.

To do so:

1.	 Press the D-ZOOM (+) button to magnify the picture.

2.	 Press the ▲▼◀▶ button.
	 The area of the magnified image will be moved

3.	 Press the D-ZOOM (−) button.

	 Each time the D-ZOOM (−) button is pressed, the image is demagni-
fied.

NOTE: 
•	 The image will be magnified or demagnified at the center of the screen.
•	 Displaying the menu will cancel the current magnification.



29

3. Convenient Features

❻ Changing LIGHT MODE/Checking Energy-Saving Effect 
Using LIGHT MODE [LIGHT MODE]
When either [ECO1] or [ECO2] in [LIGHT MODE] is selected, motion noise of the projector is cut down by lowering 
brightness of its light source. By saving energy consumption, the CO2 emission from this projector can be reduced.

LIGHT MODE
Icon at the bottom 
of the menu

Description

NORMAL 100% brightness
The screen will be brightly lit.

ECO1 Brightness will be at about 80%.
The cooling fan will also slow down accordingly.
Lower power consumption

ECO2 Brightness will be at about 50%.
The cooling fan will also slow down accordingly.
Lower power consumption considerably

*	 When the brightness is lowered, the cooling fan speed will be reduced accordingly.

To turn on the [LIGHT MODE], do the following: 
1.	 Press LIGHT button on the cabinet.

•	 In another way, press ECO/L-SHIFT button on the remote control.

	 The [LIGHT MODE] screen will be displayed.

 

2.	 Press the ENTER button.

	 The [LIGHT MODE] selection screen will be displayed.

3.	 Use the ▼▲ buttons to make a selection, and press the ENTER 
button.

	 The display will return to the [LIGHT MODE] screen and the selected 
option will be applied.

	 Press the MENU button to return to the original screen.
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NOTE: 
•	 The [LIGHT MODE] can be changed by using the menu.
	 Select [SETUP] → [INSTALLATION] → [LIGHT MODE] → [LIGHT MODE].
•	 There is an [ECO MESSAGE] function for displaying the LIGHT MODE setting in use on the screen when the power is turned on. 

To change settings for this message, select [SETUP] → [MENU SETUP] → [ECO MESSAGE]. (→ page 95)
•	 The light module hours used can be checked in [USAGE TIME]. Select [INFO.] → [USAGE TIME].
•	 After a lapse of 1 minute from when the projector displays a blue, black or logo screen, [LIGHT MODE] will automatically switch 

to [ECO]. 
•	 If the projector is overheated in [NORMAL] mode, there may be a case where the [LIGHT MODE] automatically changes to [ON] 

mode to protect the projector. This is called “Forced LIGHT MODE”. When the projector is in the Forced LIGHT MODE, the picture 
brightness decreases slightly and the TEMP. indicator lights orange. At the same time the Thermometer symbol [  ] is displayed 
at the bottom right of the screen.

	 When the projector comes back to normal temperature, the Forced LIGHT MODE is cancelled and the [LIGHT MODE] returns to 
[NORMAL] mode.
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Checking Energy-Saving Effect [CARBON METER]
This feature will show energy-saving effect in terms of CO2 emission reduction (kg) when the projector’s [LIGHT MODE] 
is set to either [ECO1] or [ECO2]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON 
SAVINGS] message shows the total amount of CO2 emission reduction from the time of shipment up to now. You can 
check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 117)

The [CARBON SAVINGS-SESSION] message shows the amount of CO2 emission reduction between the time of 
changing to LIGHT MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-
SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE ?] message at the time of power-off.

TIP:
•	 The formula shown below is used to calculate the amount of CO2 emission reduction. Amount of CO2 emission reduction = (Power 

consumption in [NORMAL] LIGHT MODE – Power consumption in current setting) × CO2 conversion factor.* When an energy-
saving LIGHT MODE is selected, or the Lens Shutter is used, there will be a further reduction in CO2 emission.
*	 Calculation for amount of CO2 emission reduction is based on an OECD publication “CO2 Emissions from Fuel Combustion, 

2008 Edition”.
•	 The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
•	 This formula will not apply to the power consumption which is not affected by whether [LIGHT MODE] is turned on or off.
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❼ Correcting Horizontal and Vertical Keystone Distortion 
[CORNERSTONE]

Use the [CORNERSTONE] feature to correct keystone (trapezoidal) distortion to make the top or bottom and the left 
or right side of the screen longer or shorter so that the projected image is rectangular.

1.	 Press and hold the 3D REFORM button for 2 seconds at least to reset current adjustments.

	 Current adjustments for [GEOMETRIC CORRECTION] will be cleared.

2.	 Project an image so that the screen is smaller than the area of the raster.

Projected image

The drawing shows the upper right corner.

3.	 Pick up any one of the corners and align the corner of the image with a corner of the screen.

4.	 Press the 3D REFORM button.

	 Display the [GEOMETRIC CORRECTION] screen of the on-screen menu.
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5.	 Press the ▼ button to align with the [CORNERSTONE] and then press the ENTER button.

The drawing shows the upper left icon ( ) is selected.

	 The screen will switch to the [CORNERSTONE] screen.

NOTE:
•	 When a [GEOMETRIC CORRECTION] function other than [CORNERSTONE] has been set up, the [CORNERSTONE] screen 

will not be displayed. When the screen is not displayed, either press the 3D REFORM button for 2 or more seconds, or run 
[RESET] in[GEOMETRIC CORRECTION] to clear the adjustment value of [GEOMETRIC CORRECTION].

6.	 Use the ▲▼◀▶ button to select one icon (▲) which points in the direction you wish to move the projected 
image frame.

7.	 Press the ENTER button.

8.	 Use the ▲▼◀▶ button to move the projected image frame as shown on the example.

9.	 Press the ENTER button.

10.	Use the ▲▼◀▶ button to select another icon which points in the direction.

11.	Repeat steps from 7 to 10 to complete the cornerstone adjustment.

12.	On the [CORNERSTONE] screen, select [EXIT] or press the EXIT button on the remote control.

	 The confirmation screen is displayed.
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13.	Press the ◀ or ▶ button to highlight the [OK] and press the ENTER button.

	 This completes the [CORNERSTONE] correction.

•	 Returning to the [CORNERSTONE] screen, select [CANCEL] and press the ENTER button.

NOTE: 
•	 Even when the projector is turned on, the last used correction values are applied.
•	 Carry out either one of the following actions to clear the adjustment value of [CORNERSTONE].

•	 In Step 12, select [RESET] and then press the ENTER button.
•	 Press the 3D REFORM button for 2 or more seconds.
•	 Run [DISPLAY] → [GEOMETRIC CORRECTION] → [RESET] in the on-screen menu.

•	 Using CORNERSTONE correction can cause the image to be slightly blurred because the correction is made electronically.
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❽ Preventing the Unauthorized Use of the Projector [SECURITY]
A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword 
is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the pro-
jector cannot project an image. 
• The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the ▶ button twice to select [SETUP] and press the ▼ button or the ENTER button to select [MENU].

3.	 Press the ▶ button to select [CONTROL].

4.	 Press the ▼ button three times to select [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

5.	 Press the ▼ button to select [ON] and press the ENTER button.

	 The [SECURITY KEYWORD] screen will be displayed.

6.	 Type in a combination of the four ▲▼◀▶ buttons and press the ENTER button.

NOTE: A keyword must be 4 to 10 digits in length.

	 The [CONFIRM KEYWORD] screen will be displayed.

NOTE: Make a note of your password and store it in a safe place.
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7.	 Type in the same combination of ▲▼◀▶ buttons and press the ENTER button.

	 The confirmation screen will be displayed.

8.	 Select [YES] and press the ENTER button.

	 The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1.	 Press the  button.

•	 If using the remote control, press the POWER ON button.

	 The projector will be turned on and display a message to the effect 
that the projector is locked.

 

2.	 Press the MENU button.

3.	 Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
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To disable the SECURITY function:

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Select [SETUP] → [CONTROL] → [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

3.	 Select [OFF] and press the ENTER button.

	 The SECURITY KEYWORD screen will be displayed.

4.	 Type in your keyword and press the ENTER button.

	 When the correct keyword is entered, the SECURITY function will be disabled.

NOTE: If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request 
code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-EYA8] 
is a request code.
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❾ Projecting 3D videos
This projector supports DLP-Link glasses and 3D emitter.

 CAUTION

Health precautions
Before use, please make sure to read any health precautions that may be stated in the operating manuals enclosed 
with the 3D eyewear and 3D video software (Blu-ray player, games, computer animation files, etc.).
Please take note of the following in order to avoid adverse health effects.
•	 Please do not use the 3D eyewear for purposes other than to watch 3D videos.
•	 Please keep a distance of at least 2 m away from the screen when watching videos. Watching a video too close 
to the screen will increase eye fatigue.
•	 Please do not watch videos continuously for a long period of time. Please take a 15 minutes’ break after every 
hour of watching.
•	 Please consult a doctor before watching if you or any of your family members have a history of suffering from 
seizures caused by light sensitivity.
•	 Please stop watching immediately and take a rest when you feel physically unwell while watching (vomiting, gid-
diness, nausea, headaches, sore eyes, blurred vision, cramps and dumbness in the limbs, etc.). Please consult 
a doctor if the symptoms persist.
•	 Please watch a 3D video directly in front of the screen. If you watch a 3D video obliquely from the sides, this may 
result in physical and eye fatigue.

Procedure to watch 3D videos using this projector
The description here are for DLP® Link. [DLP® Link] is default setting for [3D GLASSES] at the factory.

3D eyewear and 3D emitter preparations
Use DLP® Link glasses or other compatible commercially-available liquid crystal shutter spectacles.

1.	 Connect the video device to the projector.

2.	 Switch on the projector.

3.	 Run the 3D video software. 

	 The 3D video will be projected.

	 The default factory setting is [AUTO]. When 3D image is not projected, it may cause input signal does not contain 
3D detection signal or it can not be detected by this projector. In this case, please set up the format manually.

(1)	Press the MENU button.

	 The MENU will be displayed.

(2)	Press the ▶ button, select [ADJUST], then press ENTER.

	 [PICTURE] will be highlighted.

(3)	Use the ▶ button to select [3D SETTINGS].
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	 The [3D SETTINGS] screen will be displayed.

(4)	Use the ▼ button to align the cursor with [FORMAT], then press ENTER.

	 The [FORMAT] screen will be displayed.

(5)	Use the ▼/▲ buttons to align the cursor at one among format options, then press ENTER for setting it up.

	 The display will return to the [FORMAT] screen.

	 Press the MENU button to return to the original screen.

•	 The 3D caution message screen will be displayed when switching to a 3D video (default factory setting when 
shipped). Please read the “Health Precautions” on the previous page to watch videos in the correct manner. The 
screen will disappear after 60 seconds or when the ENTER button is pressed. (→ page 95)

4.	 Turn on the power supply of the 3D eyewear and wear the eyewear to watch the video.

	 A normal video will be shown when a 2D video is input.

	 To watch a 3D video in 2D, select [OFF(2D)] in the [FORMAT] screen mentioned above in (3).

NOTE:
•	 If 3D content is played back on your computer and the performance is poor, it may be caused by the CPU or graphics chip. In this 

case you may have difficulty seeing the 3D images as they were intended. Check to see if your computer meets the requirements 
provided in your user’s manual included with your 3D content.

•	 The DLP® Link compatible 3D eyeglasses allow you to view 3D images by receiving synch signals, which are included in left eye 
and right eye images, reflected from the screen. Depending on environments or conditions such as the ambient brightness, screen 
size or viewing distance, the 3D eyeglasses may fail to receive synch signals, causing poor 3D images.

•	 When the 3D mode is enabled, the Keystone correction range will be narrower.
•	 When the 3D mode is enabled, the following settings are invalid.
	 [WALL COLOR], [PRESET], [REFERENCE], [COLOR TEMPERATURE], [DYNAMIC CONTRAST], [Brilliant Color]
•	 Signals other than those listed in “Compatible Input Signal List” on page 160 and 161 will be out of range or displayed in 2D.
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Using a 3D emitter
This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear. In 
order to synchronize the 3D video and eyewear, a commercially-available 3D emitter needs to be connected to the 
projector (on the projector side).
The 3D eyewear receives information from the 3D emitter and performs opening and closing on the left and right. 

3D eyewear and 3D emitter preparations
Please use an active shutter-type 3D eyewear that conforms with the VESA standard.
A commercially-available RF type made by Xpand is recommended.

3D eyewear	������������ Xpand X105-RF-X2
3D emitter	�������������� Xpand AD025-RF-X1

Connect your 3D emitter to the 3D SYNC terminal of the projector.
Change [3D GLASSES] setting to [OTHERS].

NOTE:
•	 Upon switching to 3D image, the following functions will be cancelled and disabled. [BLANKING], [PIP/PICTURE BY PICTURE], 

[GEOMETRIC CORRECTION], [EDGE BLENDING] ([GEOMETRIC CORRECTION] and [EDGE BLENDING] adjustment values will 
be maintained.)

•	 The output may not automatically switch to a 3D video depending on the 3D input signal.
•	 Check the operating conditions described in the user manual of the Blu-ray player.
•	 Please connect the DIN terminal of the 3D emitter to the 3D SYNC of the main projector.
•	 The 3D eyewear allows videos to be viewed in 3D by receiving synchronized optical signals output from the 3D emitter.
	 As a result, the 3D image quality may be affected by conditions such as the brightness of the surroundings, screen size, viewing 

distance, etc.
•	 When playing a 3D video software on a computer, the 3D image quality may be affected if the computer CPU and graphics chip 

performance are low. Please check the required operating environment of the computer that is stated in the operating manual 
attached to the 3D video software.

•	 Depending on the signal, [FORMAT] and [L/R INVERT] may not be able to be selected. Please change the signal in that case.
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When videos cannot be viewed in 3D
Please check the following points when videos cannot be viewed in 3D.
Please also read the operating manual attached to the 3D eyewear.

Possible reasons Solutions

The selected signal does not support 3D output. Please change the video signal input to one that supports 3D.

The format for the selected signal is turned to [OFF(2D)]. Please change the format in the on-screen menu to [AUTO] or a 
format that supports 3D.

A eyewear that is not supported by the projector is being used. Please purchase a commercially-available 3D eyewear or 3D emit-
ter (recommended). (→ page 40)

Please check the following points when a video cannot be viewed 
in 3D using a 3D eyewear that is supported by the projector.

The power supply of the 3D eyewear is turned off. Please turn on the power supply of the 3D eyewear.

The internal battery of the 3D eyewear is flat. Please charge or replace the battery.

The viewer is located too far away from the screen. Please get closer to the screen until the video can be seen in 3D.

Please turn the L/R INVERT in the on-screen menu to [OFF].

Due to multiple 3D projectors working at the same time in the 
vicinity, the projectors may interfere with one another. Alter-
natively, there may be a bright light source near the screen.

Please maintain sufficient distance between the projectors.

Please keep the light source away from the screen.

Please turn the L/R INVERT in the on-screen menu to [OFF].

Please check the following points when videos played back on the 
computer cannot be viewed in 3D.

Settings on the computer are not compatible with 3D video 
playback.

Check to make sure that settings on the computer meet require-
ments for 3D video playback.

Image resolution on the computer cannot be recognized by 
the projector as 3D video.

Change the image resolution on the computer to one that the 
projector can recognize as 3D video.

The vertical scan rate on the computer cannot be recognized 
by the projector as 3D video.

Change the vertical scan rate on the computer to 60 Hz or 120 Hz.

There is an obstacle between the optical receiver of the 3D eye-
wear and the 3D emitter.

Please remove the obstacle.

The 3D format of the 3D video contents is not supported. Please check with the company selling the 3D video contents.
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❿ Controlling the Projector by Using an HTTP Browser
Overview
The HTTP Server function provides settings and operations for:
1.	 Setting for wired network (NETWORK SETTINGS)

	 To use wired LAN connection, connect the projector to the computer with a commercially available LAN cable. (→ 
page 133)

2.	 Setting Alert Mail (ALERT MAIL)

	 When the projector is connected to a wired network, error messages will be sent via e-mail.

3.	 Operating the projector

	 Power on/off, selecting input, volume control and picture adjustments are possible.

4.	 Setting PJLink PASSWORD and AMX BEACON

Access to the HTTP server function is available:
•	 Start the Web browser on the computer via the network connected to the projector and enter the following 

URL :

	 http://<the projector’s IP address> /index.html

TIP: The factory setting IP address is [DHCP ON].

NOTE: 
•	 To use the projector in a network, consult with your network administrator about network settings.
•	 The display’s or button’s response can be slowed down or operation may not be accepted depending the settings of your network.
	 Should this happen, consult your network administrator. The projector may not respond if its buttons are repeatedly pressed in 

rapid intervals. Should this happen, wait a moment and repeat. If you still can’t get any response, turn off and back on the projec-
tor.

•	 If the PROJECTOR NETWORK SETTINGS screen does not appear in the web browser, press the Ctrl+F5 keys to refresh your web 
browser (or clear the cache).

•	 This projector uses “JavaScript” and “Cookies” and the browser should be set to accept these functions. The setting method will 
vary depending on the version of browser. Please refer to the help files and the other information provided in your software.

Preparation before Use
Connect the projector to a commercially available LAN cable before engaging in browser operations. (→ page 133)
Operation with a browser that uses a proxy server may not be possible depending on the type of proxy server and the 
setting method. Although the type of proxy server will be a factor, it is possible that items that have actually been set 
will not be displayed depending on the effectiveness of the cache, and the contents set from the browser may not be 
reflected in operation. It is recommended that a proxy server not be used unless it is unavoidable.
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Handling of the Address for Operation via a Browser
Regarding the actual address that is entered for the address or entered to the URL column when operation of the pro-
jector is via a browser, the host name can be used as it is when the host name corresponding to the IP address of the 
projector has been registered to the domain name server by a network administrator, or the host name corresponding 
to the IP address of the projector has been set in the “HOSTS” file of the computer being used.

Example 1: �When the host name of the projector has been set to “pj.nec.co.jp”, access is gained to the network 
setting by specifying 
  http://pj.nec.co.jp/index.html 
for the address or the entry column of the URL.

Example 2: �When the IP address of the projector is “192.168.73.1”, access is gained to the network setting by 
specifying 
  http://192.168.73.1/index.html 
for the address or the entry column of the URL.

PROJECTOR ADJUSTMENT

POWER: This controls the power of the projector.
ON	������������������������� Power is switched on.
OFF	������������������������ Power is switched off.

VOLUME: Can not be used for this device.

AV-MUTE: This controls the mute function of the projector.
PICTURE ON	���������� Mutes the video.
PICTURE OFF	��������� Cancels the video muting.
SOUND ON	������������ Cannot be used for this device.
SOUND OFF	����������� Cannot be used for this device.
ALL ON	������������������ Mutes the video functions.
ALL OFF	����������������� Cancels the muting of the video functions.
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PICTURE: Controls the video adjustment of the projector.
BRIGHTNESS ▲	���� Increases the brightness adjustment value.
BRIGHTNESS ▼	���� Decreases the brightness adjustment value.
CONTRAST ▲	�������� Increases the contrast adjustment value.
CONTRAST ▼	�������� Decreases the contrast adjustment value.
COLOR ▲	�������������� Increases the color adjustment value.
COLOR ▼	�������������� Decreases the color adjustment value.
HUE ▲	������������������� Increases the hue adjustment value.
HUE ▼	������������������� Decreases the hue adjustment value.
SHARPNESS ▲	����� Increases the sharpness adjustment value.
SHARPNESS ▼	����� Decreases the sharpness adjustment value.
•	 The functions that can be controlled will vary depending on the signal being input to the projector. (→ page 76, 
77)

SOURCE SELECT: This switches the input terminal of the projector.
HDMI	��������������������� Switches to the HDMI IN terminal.
DisplayPort	������������ Switches to the DisplayPort IN.
BNC	����������������������� Switch to BNC video input.
BNC(CV)	���������������� Switch to BNC (CV) video input.
BNC(Y/C)	��������������� Switch to BNC (Y/C) video input.
COMPUTER	����������� Switches to the COMPUTER 1 IN terminal.
HDBaseT	���������������� Switch to image input sent from a transmission device that supports HDBaseT.
SLOT	���������������������� The projector switches to video input from the optional board when an optional board (sold separately) is 

equipped on.

PROJECTOR STATUS: This displays the condition of the projector.
LIGHT HOURS USED	����������Displays how many hours the light module has been used.
ERROR STATUS	������������������Displays the status of errors occurring within the projector.

LOG OFF: Logging off your projector and returning to the authentication screen (LOGON screen).
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NETWORK SETTINGS

• SETTINGS

WIRED

SETTING Set for wired LAN.

APPLY Apply your settings to wired LAN.

PROFILE 1/PROFILE 2 Two settings can be set for wired LAN connection. Select PROFILE 1 or PROFILE 2. 

DISABLE Turn off wired LAN connection

DHCP ON Automatically assign IP address, subnet mask, and gateway to the projector from your 
DHCP server.

DHCP OFF Set IP address, subnet mask, and gateway to the projector assigned by your network 
administrator.

IP ADDRESS Set your IP address of the network connected to the projector.

SUBNET MASK Set your subnet mask number of the network connected to the projector.

GATEWAY Set the default gateway of the network connected to the projector.

AUTO DNS ON DHCP server will automatically assign IP address of DNS server connected to the 
projector.

AUTO DNS OFF Set your IP address of DNS server connected to the projector.
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• NAME

PROJECTOR NAME Enter a name for your projector so that your computer can identify the projector. A 
projector name must be 16 characters or less. 
TIP: Projector name will not be affected even when [RESET] is done from the menu.

HOST NAME Enter the hostname of the network connected to the projector. A host name must be 
15 or less.

DOMAIN NAME Enter the domain name of the network connected to the projector. A domain name 
must be 60 characters or less.

• ALERT MAIL

ALERT MAIL This option will notify your computer of lamp replace time or error messages via e-mail 
when using wired LAN. 
Placing a checkmark will turn on the Alert Mail feature.
Clearing a checkmark will turn off the Alert Mail feature.
Sample of a message to be sent from the projector:
Subject: [Projector] Projector Information
THE COOLING FAN HAS STOPPED.
[INFORMATION]
PROJECTOR NAME:  PX602UL Series
LIGHT HOURS USED:  0000[H]

SENDER’S ADDRESS Enter sender’s address. 

SMTP SERVER NAME Enter the SMTP server name to be connected to the projector.

RECIPIENT’S ADDRESS 
1, 2, 3

Enter your recipient’s address. Up to three addresses can be entered.

TEST MAIL Send a test mail to check whether your settings are correct or not
NOTE:
•	 If you execute a test, you may not receive an Alert mail. Should this happen, check if network 

settings are correct.
•	 If you entered an incorrect address in a test, you may not receive an Alert mail. Should this 

happen, check if the Recipient’s Address is correct.

SAVE Click this button to save your settings to the projector’s memory.
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• NETWORK SERVICE

PJLink PASSWORD Set a password for PJLink*. A password must be 32 characters or less. Do not forget 
your password. However, if you forget your password, consult with your dealer.

HTTP PASSWORD Set a password for HTTP server. A password must be 10 characters or less.
When a password is set up, you will be prompted for your user name (arbitrary) and 
password during LOGON.

AMX BEACON Turn on or off for detection from AMX Device Discovery when connecting to the network 
supported by AMX’s NetLinx control system.
TIP: 
When using a device that supports AMX Device Discovery, all AMX NetLinx control system will 
recognize the device and download the appropriate Device Discovery Module from an AMX server.
Placing a checkmark will enable detecting the projector from AMX Device Discovery.
Clearing a checkmark will disable detecting the projector from AMX Device Discovery.

NOTE: If you forget your password, contact your dealer. 

*What is PJLink?
PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard 
protocol is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005.
The projector supports all the commands of PJLink Class 1.
Setting of PJLink will not be affected even when [RESET] is done from the menu.

CRESTRON

• ROOMVIEW for managing from the computer.

DISABLE Disables ROOMVIEW.

ENABLE Enables ROOMVIEW.

• CRESTRON CONTROL for managing from the controller.

DISABLE Disables CRESTRON CONTROL.

ENABLE Enables CRESTRON CONTROL. 

IP ADDRESS Set your IP address of CRESTRON SERVER.

IP ID Set your IP ID of CRESTRON SERVER.

• INFORMATION

WIRED LAN Display a list of settings of wired LAN connection.

UPDATE Reflect settings when they are changed.

TIP: The CRESTRON settings are required only for use with CRESTRON ROOMVIEW.
For more information, visit http://www.crestron.com

http://www.crestron.com
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4. Multi-Screen Projection
❶ Things that can be done using multi-screen projection
This projector can be used singly or arranged in multiple units for multi-screen projection.
We will introduce an example using two projection screens here.

Case 1
Using a single projector to project two types of videos at the same time
[PIP/PICTURE BY PICTURE]

Case 2
Using four projectors (resolution: WUXGA) to project video with a resolution of 2560 × 1600 pixels
[TILING]

Case 1. Using a single projector to project two types of videos [PIP/PICTURE BY 
PICTURE]

Connection example and projection image

In the case of [PICTURE BY PICTURE] In the case of [PIP]

On-screen menu operations
Display [DISPLAY] → [PIP/PICTURE BY PICTURE] → [MODE] screen in the on-screen menu and select [PIP] or 
[PICTURE BY PICTURE].
For details, please refer to “4-2 Displaying Two Pictures at the Same Time”. (→ page 52)
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Case 2. Using four projectors (resolution: WUXGA) to project videos with a resolution of 
2560 × 1600 pixels [TILING]

Connection example and projection image

On-screen menu operations
1	 Four similar videos are displayed when four projectors are projected.

	 Please request the dealer to adjust the projection position of each projector.
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2	 Operate the on-screen menu using the four respective projectors to divide the image into four portions.

	 Display [DISPLAY] → [MULTI SCREEN] → [PICTURE SETTING] Screen in the on-screen menu and select [TIL-
ING].

(1)	In the screen for setting the number of horizontal units, select [2 UNITS]. (number of units in the horizontal direc-
tion)

(2)	In the screen for setting the number of vertical units, select [2 UNITS]. (number of units in the vertical direction)

(3)	In the screen for setting the horizontal order, select [1st UNIT] or [2nd UNIT].

	 (look at the screens, the one on the left is the [1st UNIT] while the one on the right is the [2nd UNIT])

(4) In the screen for setting the vertical order, select the [1st UNIT] or the [2nd UNIT].

	 (look at the screens, the one at the top is the [1st UNIT] while the one at the bottom is the [2nd UNIT])

3	 Adjust the lens shift of each projector to fine-tune the boundaries of the screen.

	 For further fine-tuning, adjust using [DISPLAY] → [EDGE BLENDING] in the on-screen menu for each projector.

	 For details, please refer to “4-3 Displaying a Picture Using [EDGE BLENDING]”.

	 (→ page 56)
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Things to note when installing projectors
•	 Leave 1 m or over space between the projectors when projectors are installed side by side, so that the intake and 
exhaust vents of the projectors are not obstructed. In addition, leave a space of at least 30 cm between the intake/
exhaust vent and the wall. When the air intake and discharge outlet are obstructed, the temperature inside the 
projector will rise and this may result in a malfunction.

1 m or greater

•	 Two projectors can be stacked on top of each other (STACK setting). (→ page 138) Do not attempt to directly stack 
three or more projectors. When the projectors are piled up on top of one another, they may fall down, resulting in 
damage and failure.

•	 Installation example when using 3 or more projectors
	 The following installation is recommended when installing a combination of 3 or more projectors for multi-screen 
projection.
[Installation example]

Intake ventExhaust vent Cabinet

Air discharge

Air intake

Front Front

 WARNING

Please request the dealer for special installation services such as when mounting the projector to the ceiling. Never 
carry out the installation by yourself. The projector may fall down and result in injury. Please use a sturdy cabinet 
that can withstand the weight of the projector for the installation. Please do not pile up the projectors directly on 
top of one another.

NOTE:
•	 For the range of the projection distance, please refer to the Appendix “Throw distance and screen size”. (→ page 153)
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❷ Displaying Two Pictures at the Same Time
The projector has a feature that allows you to view two different signals simultaneously. You have two modes: picture 
in picture (PIP) mode and picture by picture (PICTURE BY PICTURE) mode.
The projection video in the first screen display is known as the main display while the projection video that is called 
out subsequently is known as the sub-display.
Select the projection function under [DISPLAY] → [PIP/PICTURE BY PICTURE] → [MODE] in the on-screen menu 
(the default factory setting when shipped is PIP). (→ page 85)
•	 A single screen is projected when power is turned on.

Picture in Picture function (PIP)
A small sub-display is displayed inside the main display.

The sub-display can be set up and adjusted as follows. (→ page 86)
•	 Select whether to display the sub-display at the top right, top left, bottom right 
or bottom left of the screen (the size of the sub-display can be selected and 
the position can be fine-tuned)
•	 Switch the main display with the sub-display

Main Display

Sub-Display

Picture by picture function (PICTURE BY PICTURE)
Display the main display and sub-display side by side.

The main display and sub-display can be set up and adjusted as follows. (→ 
page 86)
•	 Selecting the display boundary (ratio) of the main display and sub-display
•	 Switch the main display and sub-display

Main Display Sub-Display

Input terminals that can be used for the main screen and sub-screen.
The main screen and sub-screen can provide the following input terminals.
•	 The main display and sub-display support computer signals up to WUXGA@60HzRB.

Sub-Display or additional display
HDMI DisplayPort BNC BNC(CV) BNC(Y/C) COMPUTER HDBaseT SLOT

Main Display

HDMI No Yes Yes Yes Yes No NoDisplayPort Yes Yes Yes Yes
BNC Yes Yes

No
No Yes Yes

BNC(CV) Yes Yes Yes Yes Yes
BNC(Y/C) Yes Yes Yes Yes Yes
COMPUTER Yes Yes No Yes Yes No Yes Yes
HDBaseT No Yes Yes Yes Yes No No
SLOT No Yes Yes Yes Yes No No

NOTE:
•	 Some signals may not appear depending on the resolution.
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Projecting two screens
1.	 Press the MENU button to display the on-screen menu and select [DISPLAY] → [PIP/PICTURE BY PICTURE].

	 This displays the [PIP/PICTURE BY PICTURE] screen in the on-screen menu.

2.	 Select [SUB INPUT] using the ▼/▲ buttons, and press the ENTER button.

	 This displays the [SUB INPUT] screen.

3.	 Select the input signal using the ▼/▲ buttons, and press the ENTER button.

	 The [PIP] (PICTURE IN PICTURE) or [PICTURE BY PICTURE] screen set up under [MODE] is projected. (→ page 
85)

•	 When the signal name is displayed in grey, this means that it cannot be selected.

•	 The signal can also be selected by pressing the PIP/FREEZE button on the remote control.

4.	 Press the MENU button.

	 The on-screen menu will disappear.

5.	 When returning to single screen, display the [PIP/PICTURE BY PICTUE] screen one more time and select 
[OFF] in the [SUB INPUT] screen of the Step 3.

TIP:
•	 During dual-screen projection, if the selected input is not supported by the sub-screen, the sub-screen will appear as a black 

screen.
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Switching the main display with the sub-display and vice versa
1.	 Press the MENU button to display the on-screen menu and select [DISPLAY] → [PIP/PICTURE BY PICTURE].

	 This displays the [PIP/PICTURE BY PICTURE] screen in the on-screen menu.

2.	 Select [PICTURE SWAP] using the ▼/▲ buttons and then press the ENTER button.

	 Display the screen for switching the display positions.

3.	 Select [ON] using the ▼ button and then press the ENTER button.

	 The video of the main display will switch with that of the sub-display.

When turned “OFF” When turned “ON”

Sub-display video

Main display video Sub-display video

Main display video

	 The signal output from the HDMI OUT terminal does not change even if the display positions are switched.

4.	 Press the menu button.

	 The on-screen menu will disappear.
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Restrictions

•	 The following operations are enabled only for the main display.

•	 Visual adjustments

•	 Video magnification / demaginification using the partial D-ZOOM/ZOOM +/− buttons.

	 However, magnification / demaginification is up to the boundary set in [PICTURE BY PICTURE].

•	 TEST PATTERN

•	 The following operations are enabled for both the main display and sub-display. These operations cannot be ap-
plied individually.

•	 Momentary deletion of video

•	 Video pause

•	 [PIP/PICTURE BY PICTURE] cannot be used when a 3D video is being displayed.

•	 When using the [PIP/PICTURE BY PICTURE] function, [CLOSED CAPTION] and [DYNAMIC CONTRAST] can 
be used.

•	 [PIP/PICTURE BY PICTURE] cannot be used when the signal input has a resolution of 1920 × 1200 or more.

•	 The HDMI OUT terminal has a repeater function. The output resolution is limited by the maximum resolution of 
the connected monitor and projector.
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❸ Displaying a Picture Using [EDGE BLENDING]
A high resolution video can be projected on an even bigger screen by combining multiple projectors on the left, right, 
top and bottom.
This projector is equipped with an “EDGE BLENDING Function” that makes the edges (boundaries) of the projection 
screen indistinguishable.

NOTE:
•	 For projector throw distances, refer to “Throw distance and screen size” on page 153.
•	 Before performing the Edge Blending function, place the projector in the correct position so that the image becomes square in 

the appropriate size, and then make optical adjustments (lens shift, focus, and zoom).
•	 Adjust the brightness of each projector using [ADJUST] under [LIGHT MODE]. After adjusting the brightness, you can keep the 

set brightness level by turning ON the [CONSTANT BRIGHTNESS] mode. In addition, use [REF. WHITE BALANCE] to adjust the 
[CONTRAST] and [BRIGHTNESS].

Before explaining use of the Edge Blending function
This section explains the case for “Example: Placing two projectors side by side”. As shown, the projected image on 
the left is referred to as “Projector A” and the projected image on the right is referred to “Projector B”. Unless otherwise 
specified hereinafter, the “projector” is used to mean both A and B.

Example: Placing two projectors side by side

Edge Blending area

Projected area Projected area

Projector A Projector B
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Preparation:
•	 Turn on the projector and display a signal.
•	 When performing settings or adjustments using the remote control, enable the [CONTROL ID] so as not to activate 
the other projectors. (→ page 105)

Setting the overlap of projection screens

① Enable [EDGE BLENDING].
1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Select [EDGE BLENDING].

	 The [EDGE BLENDING] screen will be displayed. Align the cursor with [MODE] and then press the ENTER button. 
The mode screen will be displayed.

3.	 Select [MODE] → [ON] and press the ENTER button.

	 This enables the Edge Blending function. The following menu items are available:

	 [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL]

4.	 Select [RIGHT] for Projector A and [LEFT] for Projector B.

	 Press the ENTER button.

	 The following items are available:

	 [CONTROL], [MARKER], [RANGE], and [POSITION]
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5.	 Select [CONTROL] → [ON] and press the ENTER button.

	 Each [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL] has its own [CONTROL], [MARKER], [RANGE], 
and [POSITION].

•	 For Projector A, set the [CONTROL] for the [TOP], [LEFT] and[BOTTOM] to [OFF]. Similarly for Projector B, set 
the [CONTROL] for the [TOP], [RIGHT] and [BOTTOM] to [OFF].

② Adjust [RANGE] and [POSITION] to determine an area of overlapped edges of images 
projected from each projector.
Turning on [MARKER] will display markers in magenta and green.
The magenta marker is used for [RANGE] and green one for [POSITION].

[RANGE]
(Determine an area of overlapped edges of 
images.)

[POSITION]
(Determine the position of overlapped edges of images.)
Green marker

Turn on [RIGHT]

Magenta marker

Turn on [LEFT]

Magenta marker

*	 The 2 screens are separated in the diagram for explanatory purposes.
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1	 Adjust [RANGE].

	 Use the ◀ or ▶ button to adjust the overlapped area.

TIP:
•	 Adjust to overlap one projector’ marker with the other projector’s marker.

2	 Adjust [POSITION].

	 Use the ◀ or ▶ button to align one edge with the other edge of overlapped images.

TIP:
•	 When displaying a signal with a different resolution, perform the Edge Blending function from the start. 
•	 Setting of [MARKER] will not be saved and return to [OFF] when the projector is turned off. 
•	 To display or hide the marker while the projector is running, turn on or off [MARKER] from the menu.
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Black Level Adjustment
This adjusts the black level of the overlapping area and the non-overlapping area of the multi-screen (EDGE BLENDING).
Adjust the brightness level if you feel the difference is too large.

NOTE: 
This function is enabled only when [MODE] is turned on.
Adjustable area varies depending on what combination of [TOP], [BOTTOM], [LEFT] and [RIGHT] are turned on.

Example: Adjusting the Black Level when placing two projectors side by side

Width of overlap

Adjust [CENTER] Adjust [CENTER]

Projector A’s 
image

Projector B’s 
image

Adjust [CENTER-RIGHT] Adjust [CENTER-LEFT]

1.	 Turn on [MODE]

2.	 Select [BLACK LEVEL] and press the ENTER button.

	 The screen will switch to the black level adjustment screen.

3.	 Use the ▼ or ▲ button to select an item and use the ◀ or ▶ to adjust the black level.

	 Do this for the other projector if necessary.
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9-segmented portions for Black Level adjustment
The center projector

This function adjusts the brightness level of 9-segmented portions for the center projector and 4-segmented portions 
for the left bottom projector as shown below.

TOP-LEFT

BOTTOM-LEFT

CENTER-
LEFT

TOP-RIGHT

CENTER-RIGHT

BOTTOM-RIGHT

TOP-CENTER

CENTER

CENTER

BOTTOM-CENTER

TOP-RIGHT

CENTER-RIGHT

TOP-CENTER

TIP:
•	 The number of black level division screens (maximum of nine divisions) changes depending on the number of edge blending 

positions selected (top, bottom, right, left). In addition, when the top / bottom and left / right ends are selected, the corner division 
screen appears.

•	 The edge blending width is the width set in the range and the corner is formed by the intersecting area of the top / bottom ends 
or left / right ends.

•	 The [BLACK LEVEL] can be adjusted to make it brighter only.
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5. Using On-Screen Menu
❶ Using the Menus

NOTE: The on-screen menu may not be displayed correctly depending on input signal and the projector setting.

1.	 Press the MENU button on the remote control or the projector cabinet to display the menu.

NOTE: The commands such as ENTER, EXIT, ▲▼, ◀▶ in the bottom show available buttons for your operation.

2.	 Press the ◀▶ buttons on the remote control or the projector cabinet to display the submenu.

3.	 Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first 
tab.

4.	 Use the ▲▼ buttons on the remote control or the projector cabinet to select the item you want to adjust or 
set.

	 You can use the ◀▶ buttons on the remote control or the projector cabinet to select the tab you want.

5.	 Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

6.	 Adjust the level or turn the selected item on or off by using the ▲▼◀▶ buttons on the remote control or 
the projector cabinet.

	 Changes are stored until adjusted again.

7.	 Repeat steps 2-6 to adjust an additional item, or press the EXIT button on the remote control or the projec-
tor cabinet to quit the menu display.

NOTE: When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

8.	 Press the MENU button to close the menu.

	 To return to the previous menu, press the EXIT button.
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❷ Menu Elements
Slide bar

Solid triangle

Menu mode

Tab

Radio button

HIGH symbol

LIGHT MODE symbol

Menu windows or dialog boxes typically have the following elements:

Highlight	����������������������������� Indicates the selected menu or item. 
Solid triangle	���������������������� Indicates further choices are available. A highlighted triangle indicates the item is active. 
Tab	�������������������������������������� Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
Radio button	�����������������������Use this round button to select an option in a dialog box.
Source	�������������������������������� Indicates the currently selected source.
Menu mode	������������������������ Indicates the current menu mode: BASIC or ADVANCED.
Off Timer remaining time	���� Indicates the remaining countdown time when the [OFF TIMER] is preset.
Slide bar	����������������������������� Indicates settings or the direction of adjustment.
LIGHT MODE symbol	���������� Indicates [LIGHT MODE] is set.
Key Lock symbol	���������������� Indicates the [CONTROL PANEL LOCK] is enabled.
Thermometer symbol	��������� Indicates the [LIGHT MODE] is forcibly set to [ECO] mode because the internal temperature is too 

high.
HIGH symbol	���������������������� Indicates the [FAN MODE] is set to [HIGH] mode.

Source

Available buttons

Thermometer symbol

Key Lock symbol

Off Timer remaining 
time

Highlight
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5. Using On-Screen Menu

*	 The asterisk (*) indicates that the default setting varies depending on the signal.
*1	 The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].
*2	 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
*3	 When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE],  the [COLOR TEMPERATURE] is not available.

• Basic menu items are indicated by shaded area.❸ List of Menu Items
Some menu items are not available depending on the input source.
Menu Item Default Options

INPUT

HDMI *
DisplayPort *
BNC *
BNC(CV) *
BNC(Y/C) *
COMPUTER *
HDBaseT
SLOT
ENTRY LIST
TEST PATTERN

ADJUST

PICTURE

MODE STANDARD STANDARD, PROFESSIONAL

PRESET * HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, sRGB, 
DICOM SIM.

DETAIL SETTINGS

GENERAL

REFERENCE * HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, sRGB, 
DICOM SIM.

GAMMA CORRECTION*1 DYNAMIC, NATURAL, BLACK DETAIL
SCREEN SIZE*2 * LARGE, MEDIUM, SMALL
COLOR TEMPERATURE*3 *
DYNAMIC CONTRAST * OFF, ON
Brilliant Color * OFF, MEDIUM, HIGH
IMAGE MODE * STILL, MOVIE

WHITE BALANCE
CONTRAST R 0
CONTRAST G 0
CONTRAST B 0
BRIGHTNESS R 0
BRIGHTNESS G 0
BRIGHTNESS B 0

COLOR CORRECTION
RED 0
GREEN 0
BLUE 0
YELLOW 0
MAGENTA 0
CYAN 0

CONTRAST 50
BRIGHTNESS 50
SHARPNESS 10
COLOR 50
HUE 0
RESET

IMAGE 
OPTIONS

CLOCK *
PHASE *
HORIZONTAL *
VERTICAL *
BLANKING * TOP, BOTTOM, LEFT, RIGHT
OVERSCAN AUTO AUTO, 0[%], 5[%], 10[%]

ASPECT RATIO

AUTO (COMPUTER) AUTO, 4:3, 5:4, 16:9, 15:9, 16:10, NATIVE

AUTO (COMPONENT/VIDEO/S-VIDEO) AUTO, 4:3, LETTERBOX, WIDE 
SCREEN, ZOOM

AUTO (COMPONENT/VIDEO/S-VIDEO) AUTO, 4:3 WINDOW, LETTERBOX, 
WIDE SCREEN, FULL

INPUT RESOLUTION * –

VIDEO

NOISE REDUCTION
RANDOM NR OFF OFF, LOW, MEDIUM, HIGH
MOSQUITO NR OFF OFF, LOW, MEDIUM, HIGH
BLOCK NR OFF OFF, LOW

DEINTERLACE NORMAL NORMAL, MOVIE, STILL
CONTRAST 
ENHANCEMENT

MODE AUTO OFF, AUTO, NORMAL
GAIN

SIGNAL TYPE AUTO AUTO, RGB, COMPONENT
VIDEO LEVEL AUTO AUTO, NORMAL, ENHANCED, SUPER WHITE

3D SETTINGS FORMAT AUTO
AUTO, OFF(2D), FRAME PACKING, SIDE BY SIDE(HALF), SIDE 
BY SIDE(FULL), TOP AND BOTTOM, FRAME ALTERNATIVE, LINE 
ALTERNATIVE

L/R INVERT OFF OFF, ON
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Menu Item Default Options

DISPLAY

PIP/PICTURE 
BY PICTURE

SUB INPUT OFF, HDMI, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, 
HDBaseT, SLOT

MODE PIP PIP, PICTURE BY PICTURE
PICTURE SWAP OFF OFF, ON

PIP SETTING

START POSITION TOP-LEFT TOP-LEFT, TOP-RIGHT, BOTTOM-LEFT, BOTTOM-RIGHT
HORIZONTAL POSITION
VERTICAL POSITION
SIZE MEDIUM LARGE, MEDIUM, SMALL

BORDER

GEOMETRIC 
CORRECTION

KEYSTONE

HORIZONTAL
VERTICAL
TILT
THROW RATIO

CORNERSTONE TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER-
RIGHT, BOTTOM-LEFT, BOTTOM-CENTER, BOTTOM-RIGHT

HORIZONTAL CORNER TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER-
RIGHT, BOTTOM-LEFT, BOTTOM-CENTER, BOTTOM-RIGHT

VERTICAL CORNER TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER-
RIGHT, BOTTOM-LEFT, BOTTOM-CENTER, BOTTOM-RIGHT

PINCUSHION TOP, BOTTOM, LEFT, RIGHT
PC TOOL OFF OFF, 1, 2, 3
RESET

EDGE 
BLENDING

MODE OFF OFF, ON

TOP

CONTROL ON OFF, ON
MARKER ON OFF, ON
RANGE
POSITION

BOTTOM

CONTROL ON OFF, ON
MARKER ON OFF, ON
RANGE
POSITION

LEFT

CONTROL ON OFF, ON
MARKER ON OFF, ON
RANGE
POSITION

RIGHT

CONTROL ON OFF, ON
MARKER ON OFF, ON
RANGE
POSITION

BLACK LEVEL

TOP-LEFT
TOP-CENTER
TOP-RIGHT
CENTER-LEFT
CENTER
CENTER-RIGHT
BOTTOM-LEFT
BOTTOM-CENTER
BOTTOM-RIGHT

MULTI 
SCREEN

WHITE BALANCE

MODE OFF OFF, ON
CONTRAST W
CONTRAST R
CONTRAST G
CONTRAST B
BRIGHTNESS W
BRIGHTNESS R
BRIGHTNESS G
BRIGHTNESS B

PICTURE SETTING

MODE OFF OFF, ZOOM, TILING

ZOOM

HORIZONTAL ZOOM
VERTICAL ZOOM
HORIZONTAL POSITION
VERTICAL POSITION

TILING

WIDTH 1 UNIT, 2 UNITS, 3 UNITS, 4 UNITS
HEIGHT 1 UNIT, 2 UNITS, 3 UNITS, 4 UNITS
HORIZONTAL POSITION 1st UNIT, 2nd UNIT, 3rd UNIT, 4th UNIT
VERTICAL POSITION 1st UNIT, 2nd UNIT, 3rd UNIT, 4th UNIT
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Menu Item Default Options

SETUP

MENU

LANGUAGE ENGLISH

ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, SVENSKA, 
日本語
DANSK, PORTUGUÊS, ČEŠTINA, MAGYAR, POLSKI, 
NEDERLANDS, SUOMI
NORSK, TÜRKÇE, РУССКИЙ, , Ελληνικά, 中文, 한국어
ROMÂNĂ, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी, ไทย, 

, 繁體中文
COLOR SELECT COLOR COLOR, MONOCHROME
INPUT DISPLAY ON OFF, ON
MESSAGE DISPLAY ON OFF, ON
ID DISPLAY ON OFF, ON
ECO MESSAGE OFF OFF, ON
3D CAUTION MESSAGE ON OFF, ON

DISPLAY TIME AUTO 45 
SEC MANUAL, AUTO  5 SEC, AUTO 15 SEC, AUTO 45 SEC

INSTALLATION

ORIENTATION  AUTO AUTO, DESKTOP FRONT, CEILING REAR, DESKTOP REAR, 
CEILING FRONT

SCREEN TYPE FREE FREE, 4:3 SCREEN, 16:9 SCREEN, 16:10 SCREEN

WALL COLOR OFF OFF, BLACKBOARD, BLACKBOARD (GRAY), LIGHT YELLOW, LIGHT 
GREEN, LIGHT BLUE, SKY BLUE, LIGHT ROSE, PINK

FAN MODE AUTO AUTO, HIGH

LIGHT MODE
LIGHT MODE NORMAL NORMAL, ECO1, ECO2
CONSTANT BRIGHTNESS OFF OFF, ON
ADJUST 20–100%

REF. WHITE BALANCE 

CONTRAST R
CONTRAST G
CONTRAST B
BRIGHTNESS R
BRIGHTNESS G
BRIGHTNESS B
UNIFORMITY R
UNIFORMITY B

3D GLASSES DLP® Link DLP® Link, OTHERS
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Menu Item Default Options

SETUP CONTROL

TOOLS

ADMINISTRA-
TOR MODE

MENU MODE ADVANCED ADVANCED, BASIC
NOT SAVE SETTING VALUES OFF OFF, ON
NEW PASSWORD
CONFIRM PASSWORD

PROGRAM 
TIMER

ENABLE OFF OFF, ON

SETTINGS

EDIT

ACTIVE OFF, ON

DAY SUN, MON, TUE, WED, THU, FRI, SAT, MON-FRI, MON-SAT, EVERY 
DAY

TIME
FUNCTION POWER, INPUT, LIGHT MODE
ADVANCED 
SETTINGS
POWER OFF, ON

INPUT HDMI, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, 
HDBaseT, SLOT

LIGHT MODE NORMAL, ECO1, ECO2
REPEAT OFF, ON

DELETE
UP
DOWN
BACK

DATE AND TIME 
SETTINGS

TIME 
ZONE 
SETTIMGS

GMT

-12:00, -11:30, -11:00, -10:30, -10:00, -09:30, -09:00, -08:30, 
-08:00, -07:30, -07:00, -06:30, -06:00, -05:30, -05:00, -04:30, 
-04:00, -03:30, -03:00, -02:30, -02:00, -01:30, -01:00, -00:30, 
00:00, +00:30, +01:00, +01:30, +02:00, +02:30, +03:00, +03:30, 
+04:00, +04;30, +05:00, +05:30, +06:00, +06:30, +07:00, +07:30, 
+08:00, +08:30, +09:00, +09:30, +10:00, +10:30, +11:00, +11:30, 
+12:00, +12:30, +13:00

DATE 
AND TIME 
SETTINGS

DATE  MM/DD/YYYY
TIME  HH:MM
INTERNET TIME 
SERVER OFF, ON

IP ADDRESS
UPDATE

SUMMER 
TIME 
SETTINGS

ENABLE OFF, ON
MON(START) 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12

DAY(START)
FIRST WEEK, SECOND WEEK, THIRD WEEK, FOURTH WEEK, LAST 
WEEK
SUN, MON, TUE, WED, THU, FRI, SAT

TIME(START)
MON(EXIT) 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12

DAY(EXIT)
FIRST WEEK, SECOND WEEK, THIRD WEEK, FOURTH WEEK, LAST 
WEEK
SUN, MON, TUE, WED, THU, FRI, SAT

TIME(EXIT)
TIME DIFFERENCE +01:00, +00:30, -00:30, -01:00

MOUSE (Note) Cannot be used for this device.
CONTROL PANEL LOCK OFF OFF, ON
SECURITY OFF OFF, ON
COMMUNICATION SPEED 38400bps 4800bps, 9600bps, 19200bps, 38400bps, 115200bps

CONTROL ID CONTROL ID NUMBER 1 1–254
CONTROL ID OFF OFF, ON

REMOTE SENSOR FRONT/
BACK FRONT/BACK, FRONT, BACK, HDBase-T
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Menu Item Default Options

SETUP

NETWORK 
SETTINGS

WIRED LAN

PROFILES DISABLE, PROFILE 1, PROFILE 2
DHCP OFF, ON
IP ADDRESS 192.168.0.10
SUBNET MASK 255.255.255.0
GATEWAY 192.168.0.1
AUTO DNS OFF, ON
DNS CONFIGURATION
RECONNECT

PROJECTOR NAME PROJECTOR NAME PX602UL Series

DOMAIN HOST NAME necpj
DOMAIN NAME

ALERT MAIL

ALERT MAIL OFF, ON
HOST NAME
DOMAIN NAME
SENDER'S ADDRESS
SMTP SERVER NAME
RECIPIENT'S ADDRESS 1
RECIPIENT'S ADDRESS 2
RECIPIENT'S ADDRESS 3
TEST MAIL

NETWORK SERVICE

HTTP 
SERVER

NEW PASSWORD
CONFIRM PASSWORD

PJLink NEW PASSWORD
CONFIRM PASSWORD

AMX 
BEACON OFF, ON

CRESTRON

ROOMVIEW OFF, ON
CRESTRON 
CONTROL (ENABLE, 
CONTROLLER IP 
ADDRESS, IP ID)

SOURCE 
OPTIONS

AUTO ADJUST NORMAL OFF, NORMAL, FINE

COLOR SYSTEM BNC(VIDEO) AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM
BNC(Y/C) AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM

DEFAULT INPUT SELECT LAST LAST, AUTO, HDMI, DisplayPort, BNC, BNC(CV), BNC(Y/C), 
COMPUTER, HDBaseT, SLOT

CLOSED CAPTION OFF OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, TEXT1, TEXT2, 
TEXT3, TEXT4

BACKGROUND LOGO BLUE, BLACK, LOGO

POWER 
OPTIONS

STANDBY MODE NORMAL NORMAL, NETWORK STANDBY
DIRECT POWER ON OFF OFF, ON
AUTO POWER ON SELECT OFF OFF, HDMI, DisplayPort, COMPUTER, HDBaseT, SLOT
AUTO POWER OFF 1:00 OFF, 0:05, 0:10, 0:15, 0:20, 0:30, 1:00
OFF TIMER OFF OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00

SLOT POWER PROJECTOR ON ON OFF, ON
PROJECTOR STANDBY ENABLE DISABLE, ENABLE

RESET
CURRENT SIGNAL
ALL DATA
ALL DATA (INCLUDING ENTRY LIST)
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Menu Item Default Options

INFO.

USAGE TIME LIGHT HOURS USED
TOTAL CARBON SAVINGS

SOURCE(1)

INPUT TERMINAL
RESOLUTION
HORIZONTAL FREQUENCY
VERTICAL FREQUENCY
SYNC TYPE
SYNC POLARITY
SCAN TYPE
SOURCE NAME
ENTRY NO.

SOURCE(2)

SIGNAL TYPE
VIDEO TYPE
BIT DEPTH
VIDEO LEVEL
LINK RATE
LINK LANE
3D FORMAT

SOURCE(3)

INPUT TERMINAL
RESOLUTION
HORIZONTAL FREQUENCY
VERTICAL FREQUENCY
SYNC TYPE
SYNC POLARITY
SCAN TYPE
SOURCE NAME
ENTRY NO.

SOURCE(4)

SIGNAL TYPE
VIDEO TYPE
BIT DEPTH
VIDEO LEVEL
LINK RATE
LINK LANE
3D FORMAT

WIRED LAN

IP ADDRESS
SUBNET MASK
GATEWAY
MAC ADDRESS

VERSION(1)
FIRMWARE
DATA
SUB-CPU

OTHERS

DATE TIME
PROJECTOR NAME
MODEL NO.
SERIAL NUMBER
CONTROL ID (when [CONTROL ID] is set)

HDBaseT

SIGNAL QUALITY
OPERATION MODE
LINK STATUS
HDMI STATUS
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❹ Menu Descriptions & Functions [INPUT]

HDMI
This projects the video of the device connected to the HDMI IN terminal.

DisplayPort
This projects the video of the device connected to the Display Port IN terminal.

BNC
This projects the video of the device connected to the video input terminal.
(This projects the analog RGB signal or component signal.)

BNC(CV)
This projects the video of the device connected to the BNC (CV) video input terminal.
(This projects the composite video signal.)

BNC(Y/C)
This projects the video of the device connected to the BNC (Y/C) video input terminal.
(This projects the S-video signal.)

COMPUTER
This projects the video of the device connected to the COMPUTER 1 IN terminal. 
(This projects the analog RGB signal or component signal.)

HDBaseT
Projecting the HDBaseT or WIRED LAN signal.

SLOT
Projects the picture via the optional board (sold separately) inserted into the SLOT.

ENTRY LIST
Displays a list of signals. See the following pages.

TEST PATTERN
Closes the menu and switches to the test pattern screen. 
Select the pattern using the ◀▶ buttons.
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Using the Entry List
When any source adjustments are made, the adjustments are automatically registered in the Entry List. The (adjust-
ment values of) registered signals can be loaded from the Entry List whenever necessary.
However, only up to 100 patterns can be registered in the Entry List. When 100 patterns have been registered in the 
Entry List, an error message is then displayed and no additional patterns can be registered. You should thus delete 
(adjustment values of) signals that are no longer needed.

Displaying the Entry list
1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the ◀ or ▶ button to select [INPUT].

	 The INPUT list will be displayed.

	

3.	 Use the ◀, ▶, ▲, or ▼ to select [ENTRY LIST] and press the ENTER button.

	 The ENTRY LIST windows will be displayed.

	 If the ENTRY LIST window is not displayed, switch the menu to [ADVANCED].

	 To switch the menu between [ADVANCED] and [BASIC], select [SETUP] → [CONTROL] → [TOOLS] → [ADMIN-
ISTRATOR MODE] → [MENU MODE]. (→ page 99)

	



72

5. Using On-Screen Menu

Entering the currently projected signal into the Entry List [STORE]

1.	 Press the ▲ or ▼ button to select any number.

2.	 Press the ◀ or ▶ button to select [STORE] and press the ENTER button.

	

Calling up a signal from the Entry List [LOAD]
Press the ▲ or ▼ button to select a signal and press the ENTER button.

Editing a signal from the Entry List [EDIT]

1.	 Press the ▲ or ▼ button to select a signal you wish to edit.

2.	 Press the ◀, ▶, ▲, or ▼ button to select [EDIT] and press the ENTER button.

	 The Edit window will be displayed.

	

SOURCE NAME Enter a signal name. Up to 18 alphanumeric characters can be used.
INPUT The input terminal can be changed. Switching between HDMI/DisplayPort/BNC/BNC (CV)/

BNC (Y/C)/Computer/HDBaseT/SLOT is possible.
LOCK Set so that the selected signal cannot be deleted when [ALL DELETE] is executed. The 

changes made after LOCK execution cannot be saved.
SKIP Set so that the selected signal will be skipped during auto search.

3.	 Set the above items and select [OK] and press the ENTER button.

NOTE: The input terminal cannot be changed to the currently projected signal.
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Cutting a signal from the Entry List [CUT]

1.	 Press the ▲ or ▼ button to select a signal you wish to delete.

2.	 Press the ◀, ▶, ▲, or ▼ button to select [CUT] and press the ENTER button.

	 The signal will be deleted from the Entry List and the deleted signal will be displayed on the clipboard at the bottom 
of the Entry List.

NOTE:
•	 The currently projected signal cannot be deleted.
•	 When the locked signal is selected, it will be displayed in gray which indicates it is not available.

TIP:
•	 Data on the clipboard can be passed onto the Entry List.
•	 Data on the clipboard will not be lost after the Entry List is closed.

Copying and pasting a signal from the Entry List [COPY] / [PASTE]

1.	 Press the ▲ or ▼ button to select a signal you wish to copy.

2.	 Press the ◀, ▶, ▲, or ▼ button to select [COPY] and press the ENTER button.

	 The copied signal will be displayed on the clipboard at the bottom of the Entry List.

3.	 Press the ◀ or ▶ button to move to the list.

4.	 Press the ▲ or ▼ button to select a signal.

5.	 Press the ◀, ▶, ▲, or ▼ button to select [PASTE] and press the ENTER button.

	 Data on the clipboard will be pasted to the signal.

Deleting all the signals from the Entry List [ALL DELTE]

1.	 Press the ◀, ▶, ▲, or ▼ button to select [ALL DELETE] and press the ENTER button.

	 The confirmation message will be displayed.

2.	 Press the ◀ or ▶ button to select [YES] and press the ENTER button.

NOTE: The locked signal cannot be deleted.
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❺ Menu Descriptions & Functions [ADJUST]
[PICTURE]

[MODE]
This function allows you to determine how to save settings for [DETAIL SETTINGS] of [PRESET] for each input.

STANDARD	������������ Saves settings for each item of [PRESET] (Preset 1 through 7)
PROFESSIONAL	����� Saves all the settings of [PICTURE] for each input. 

NOTE: 
•	 When [TEST PATTERN] is displayed, [MODE] cannot be selected.

[PRESET]
This function allows you to select optimized settings for your projected image.
You can adjust neutral tint for yellow, cyan or magenta. 
There are seven factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set 
user adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 7].

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values
DICOM SIM.	���������� Recommended for DICOM simulation format.

NOTE: 
•	 The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
•	 DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiol-

ogy (ACR) and the National Electrical Manufacturers Association (NEMA). 
	 The standard specifies how digital image data can be moved from system to system. 
•	 Adjustment may not work depending on input signal.
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[DETAIL SETTINGS]

[GENERAL]
Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 7].
First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERATURE]. 

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values.
DICOM SIM.	���������� Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:

DYNAMIC	�������������� Creates a high-contrast picture.
NATURAL	��������������� Natural reproduction of the picture.
BLACK DETAIL	������� Emphasizes detail in dark areas of the picture.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.

LARGE	������������������� For screen size of 150"
MEDIUM	���������������� For screen size of 100"
SMALL	������������������� For screen size of 50"

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].
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Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.
A value between 5000 K and 10500 K can be set in 100 K units.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
If [ON] is selected, the most optimal contrast ratio is used according to the picture.

NOTE:
•	 Depending on the conditions, projector settings such as [DYNAMIC CONTRAST] may not be able to be selected.

[Brilliant Color]
Selects the brightness of the color white.
Selecting options from [MEDIUM] to [HIGH] increases the brightness of the color white.

NOTE:
•	 If under [REFERENCE], [HIGH-BRIGHT] or [PRESENTATION] are selected, [BrilliantColor] cannot be changed.

Selecting Still Image Mode or Movie Mode [IMAGE MODE]
This function allows you to select the still image mode or the movie mode.

STILL	��������������������� This mode is for a still image.
MOVIE	������������������� This mode is for a movie.

NOTE:
•	 This mode may not be available depending on input signal.

Adjusting White Balance [WHITE BALANCE]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen; 
Brightness for each color (RGB) is used to adjust the black level of the screen.

[COLOR CORRECTION]
Corrects the color for all signals.
Adjusts the tone for the colors red, green, blue, yellow, magenta and cyan.

RED HUE + Direction Magenta direction
− Direction Yellow direction

SATURATION + Direction Vivid
− Direction Weak

GREEN HUE + Direction Yellow direction
− Direction Cyan direction

SATURATION + Direction Vivid
− Direction Weak

BLUE HUE + Direction Cyan direction
− Direction Magenta direction

SATURATION + Direction Vivid
− Direction Weak

YELLOW HUE + Direction Red direction
− Direction Green direction

SATURATION + Direction Vivid
− Direction Weak

MAGENTA HUE + Direction Blue direction
− Direction Red direction

SATURATION + Direction Vivid
− Direction Weak
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CYAN HUE + Direction Green direction
− Direction Blue direction

SATURATION + Direction Vivid
− Direction Weak

[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

[COLOR]
Increases or decreases the color saturation level.

[HUE]
Varies the color level from +/− green to +/− blue. The red level is used as reference.

Input signal CONTRAST BRIGHTNESS SHARPNESS COLOR HUE

RGB system of “COMPUTER/
DisplayPort/HDMI/HDBaseT”

Yes Yes Yes No No

COMPONENT system of “COMPUTER/
DisplayPort/HDMI/HDBaseT”

Yes Yes Yes Yes Yes

Composite Video/S-Video Yes Yes Yes Yes Yes

Yes = Adjustable, No = Not adjustable

NOTE:
•	 When [TEST PATTERN] is displayed, [CONTRAST], [BRIGHTNESS], [SHARPNESS], [COLOR] and [HUE] cannot be adjusted.

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; 
Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected 
will not be reset.
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[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK	������������������� Use this item to fine tune the computer image or to remove any vertical banding that might appear. This 
function adjusts the clock frequencies that eliminate the horizontal banding in the image.
This adjustment may be necessary when you connect your computer for the first time.

PHASE	������������������� Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is 
evident when part of your image appears to be shimmering.)
Use [PHASE] only after the [CLOCK] is complete.

NOTE: The [CLOCK] and [PHASE] items are available for RGB signals only.
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Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

•	 An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.

•	 The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the 
current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, 
its adjustments will be called up and applied.

	 To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] and reset 
the adjustments.

[BLANKING]
Adjusts the display range (blanking) at the top, bottom, left and right edges of the input signal.

Selecting Overscan Percentage [OVERSCAN]
Select overscan percentage (Auto, 0%, 5% and 10%) for signal.

Projected image

Overscaned by 10%

NOTE: 
•	 The [OVERSCAN] item is not available:
	 - �when [NATIVE] is selected for [ASPECT RATIO].
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Selecting the Aspect Ratio [ASPECT RATIO]
Use this function to select the screen’s vertical:horizontal aspect ratio.
Select the screen type (4:3 screen, 16:9 screen or 16:10 screen) at the screen setting before setting the aspect ratio. 
(→ page 97)
The projector automatically identifies the signal being input and sets the optimum aspect ratio.

For Computer signal

For Component/Video/S-Video signals

When the screen type is set to 4:3 When the screen type is set to 16:9 or 16:10

Resolution Aspect Ratio
VGA 640 × 480 4:3
SVGA 800 × 600 4:3
XGA 1024 × 768 4:3
WXGA 1280 × 768 15:9
WXGA 1280 × 800 16:10
HD(FWXGA) 1366 × 768 approx. 16:9
WXGA+ 1440 × 900 16:10
SXGA 1280 × 1024 5:4
SXGA+ 1400 × 1050 4:3
WXGA++ 1600 × 900 16:9
UXGA 1600 × 1200 4:3
WSXGA+ 1680 × 1050 16:10
FHD(1080P) 1920 × 1080 16:9
WUXGA 1920 × 1200 16:10
WQXGA 2560 × 1600 16:10

Options Function

AUTO The projector will automatically determine the incoming signal and display it in its aspect ratio. 
The projector may erroneously determine the aspect ratio depending on its signal. If this occurs, select 
the appropriate aspect ratio from the following.

4:3 The image is displayed in 4:3 aspect ratio.

5:4 The image is displayed in 5:4 aspect ratio

16:9 The image is displayed in 16:9 aspect ratio

15:9 The image is displayed in 15:9 aspect ratio

16:10 The image is displayed in 16:10 aspect ratio
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Options Function

NATIVE The projector displays the current image in its true resolution when the incoming computer signal has a 
lower or higher resolution than the projector’s native resolution. (→ page 2)
When the incoming computer signal has a higher resolution than the projector's native resolution, the 
center of an image will be displayed.

LETTER BOX The image of a letterbox signal (16:9) is stretched equally in the horizontal and vertical directions to fit the 
screen.

WIDE SCREEN The image of a squeeze signal(16:9) is stretched left and right in 16:9.

ZOOM The image of a squeeze signal (16:9) is stretched left and right in 4:3.
Parts of the displayed image are cropped at the left and right edges and therefore not visible.

FULL Project to full screen size.

TIP:
•	 Image position can be adjusted vertically using [POSITION] when the [16:9], [15:9], or [16:10] aspect ratios are selected.
•	 The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect 

ratio for a vide source.
	 The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
•	 The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

[INPUT RESOLUTION]
The resolution is assigned automatically when the resolution of the input signal from the computer video input terminal 
or BNC video input terminal (analog RGB) cannot be distinguished.
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[VIDEO]

Using Noise Reduction [NOISE REDUCTION]
When projecting a video image, you can use the [NOISE REDUCTION] function to reduce the screen noise (roughness 
and distortion). This device is equipped with three types of noise reduction functions. Select the function according to 
the type of noise. Depending on the noise level, the noise reduction effect can be set to [OFF], [LOW], [MEDIUM] or 
[HIGH]. [NOISE REDUCTION] can be selected for SDTV, HDTV signal and component signal input.

RANDOM NR	��������� Reduces flickering random noise in an image. 
MOSQUITO NR	������ Reduces mosquito noise that appears around the edges of an image during Blu-ray playback.
BLOCK NR	������������� Reduces block noise or mosaic-like patterns by selecting ON.

Selecting Interlaced Progressive Conversion Process Mode [DEINTERLACE]
This function allows you to select an interlaced-to-progressive conversion process for video signals.

NORMAL	���������������� Automatically distinguishes a moving image from a static image to create a distinct image. Please select 
[MOVIE] if there are any obvious jitter and noises.

MOVIE	������������������� Select when projecting moving images. This is suitable for signals with a lot of jitter and noise.
STILL	��������������������� Select when projecting static images. The video will flicker when a moving image is projected.

NOTE: This function is not available with RGB signals.

[CONTRAST ENHANCEMENT]
Using the characteristics of the human eye, a picture quality with a sense of contrast and resolution is achieved.

OFF	������������������������ Suite vision is switched off.
AUTO	��������������������� Contrast and picture quality are automatically improved using the suite vision function.
NORMAL	���������������� Adjust the gain manually.
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[SIGNAL TYPE]
Selection of RGB and component signals. Normally, this is set to [AUTO]. Please change the setting if the color of the 
image remains unnatural.

AUTO	��������������������� Automatically distinguishes RGB and component signals.
RGB	����������������������� Switches to the RGB input.
COMPONENT	��������� Switches to the component signal input.

[VIDEO LEVEL]
Selection of the video signal level when connecting an external device to the HDMI IN terminal, DisplayPort input 
terminal, and HDBaseT input terminal of the projector.

AUTO	��������������������� The video level is switched automatically based on the information from the device outputting the signal.
Depending on the connected device, this setting may not be made properly. In this case, switch to [NORMAL” 
or “ENHANCED” from the menu and view with the optimum setting.

NORMAL	���������������� This disables the enhanced mode.
ENHANCED	������������ This improves the image’s contrast, expressing the dark and light sections more dynamically.
SUPER WHITE	������� The video contrast is improved and the dark areas appear more dynamic.



84

5. Using On-Screen Menu

[3D SETTINGS]

Please refer to “3-9 Projecting 3D videos” (→ page 38) for the operation.

FORMAT
Select the 3D video format (recording / transmission format). Select to match the 3D broadcast and 3D media. Nor-
mally, [AUTO] is selected. Please select the 3D input signal format when the 3D detection signal of the format cannot 
be distinguished.

L/R INVERT
Invert the display order of the left and right videos.
Select [ON] if you feel uncomfortable with the 3D display when [OFF] is selected.
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❻ Menu Descriptions & Functions [DISPLAY]
[PIP/PICTURE BY PICTURE]

SUB INPUT
Select the input signal to be displayed in the sub-display.
Please refer to “4-2 Displaying Two Pictures at the Same Time” (→ page 52) for details on the operation.

MODE
Select either PIP or PICTURE BY PICTURE when switching to 2-screen display.

PICTURE SWAP
The videos in the main display and sub-display will be switched.
Please refer to “4-2 Displaying Two Pictures at the Same Time” (→ page 54) for details.

PIP SETTING
Select the display position, position adjustment and size of the sub-display in the PIP screen.

START POSITION	��� Selection of the display position of the sub-display when switching to the PIP screen.
HORIZONTAL POSITION
	������������������������������ Adjust the display position of the sub-display in the horizontal direction. The respective corners will serve 

as reference points.
VERTICAL POSITION
	������������������������������ Adjust the display position of the sub-display in the vertical direction. The respective corners will serve as 

reference points.
SIZE	����������������������� Select the display size of the sub-display.
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TIP:
The horizontal position and vertical position are the amount of movement from the reference points. For example, when TOP-LEFT 
is adjusted, the position is displayed with the same amount of movement even if displayed with other starting positions.
The maximum amount of movement is half the resolution of the projector.

Reference pointAdjust using the horizon-
tal position

Sub-display Main display

Reference point

Adjust using the vertical position

TOP-LEFT TOP-RIGHT

BOTTOM-LEFT BOTTOM-RIGHT

Reference pointReference point

BORDER
Select the display boundary of the main display and sub-display of the [PICTURE BY PICTURE] screen.

Display boundary

Main display Sub-displayMain display Sub-display Main displaySub-display

TIP:
•	 6 steps can be selected on this projector.
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[GEOMETRIC CORRECTION]

KEYSTONE
Display the trapezoid correction screen and adjust the trapezoidal distortion of the projection screen.
To display the [KEYSTONE] screen, select → [DISPLAY] → [GEOMETRIC CORRECTION] → [KEYSTONE] in the 
on-screen menu. The [GEOMETRIC CORRECTION] screen can also be displayed by pressing the 3D REFORM 
button on the remote control.

HORIZONTAL	��������� Adjustments when projecting from a diagonal direction to the 
screen.

VERTICAL	�������������� Adjustments when projecting from the top or bottom direction to 
the screen.

TILT	����������������������� Adjusts the distortion when performing trapezoidal correction with the screen moved in the vertical direction 
using the lens shift.

THROW RATIO	������� Adjusts according to the projection ratio of the optional lens used.

Model name of lens 
unit

Adjustment range

NP34ZL 9–13
NP35ZL 12–17
NP36ZL 12–17
NP37ZL 15–31

NOTE:
•	 When power is supplied to the device, the adjustment value of the [KEYSTONE] used previously is retained even if the gradient 

of the device is changed.
•	 When clearing the adjustment value of [KEYSTONE], press the 3D REFORM button for 2 or more seconds.
•	 When setting other [GEOMETRIC CORRECTION] functions, the [KEYSTONE] menu cannot be selected. When performing trapezoidal 

correction, press the 3D REFORM button for 2 or more seconds to clear the adjustment value of [GEOMETRIC CORRECTION].
•	 As electrical correction is carried out by [KEYSTONE], the brightness may be reduced or the screen quality may deteriorate 

sometimes.
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CORNERSTONE
Display the 4-point correction screen and adjust the trapezoidal distortion of the projection screen.
Please refer to “Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE]” (→ page 32) for details 
on the operation.

HORIZONTAL CORNER/VERTICAL CORNER
Distortion correction for corner projection such as wall surfaces.

HORIZONTAL CORNER
	������������������������������ Performs correction for projection onto a wall lying at an angle to the horizontal direction.

*	 Reverse angle correction is also possible.
VERTICAL CORNER
	������������������������������ Performs correction for projection onto a wall lying at an angle to the vertical direction.

*	 Reverse angle correction is also possible.

NOTE:
•	 When the maximum adjustment range is exceeded, distortion adjustment is disabled. Set up the projector at an optimal angle as 

the deterioration in the image quality increases as the distortion adjustment volume gets larger.
•	 Please note that the image will go out of focus due to the difference in the distance between the upper and lower or left and right 

sides and the center of the screen for projections cutting across corners. Lenses with short focal points are also not recommended 
for projections cutting across corners as the image will go out of focus.
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Adjustment method
1.	 Align the cursor with the [HORIZONTAL CORNER] or [VERTICAL CORNER] of the [GEOMETRIC CORREC-

TION] menu and then press the ENTER button.

•	 The adjustment screen will be displayed.

2.	 Press the ▼▲◀▶ buttons to align the cursor (yellow box) with the target adjustment point and then press 
the ENTER button.

•	 The cursor will change into an adjustment point (yellow in color).

3.	 Press the ▼▲◀▶ buttons to adjust the corners or sides of the screen and then press the ENTER button.

•	 The adjustment point will go back to being a cursor (yellow box).

Explanation of screen transition 

•	 The adjustment points of the four corners (a, c, f and h in the drawing) will move independently.

•	 The following adjustment points differ at the [HORIZONTAL CORNER] and [VERTICAL CORNER].

	 HORIZONTAL CORNER: When Point b in the drawing is moved, and the upper side and Point g are moved, the 
lower side will move in a parallel manner.

	 VERTICAL CORNER: When Point d in the drawing is moved, and the left side and Point e are moved, the right 
side will move in a parallel manner.

	 [Adjustment points of the [HORIZONTAL CORNER] screen and movement points of the projection screen]

a

b

b c

d e

f g h

a c

d e

f
g

h

Point b will be displaced in a parallel manner at the same time as Points a, b, c

Point g will be displaced in a parallel manner at the same time as Points f, g, h

	 [Adjustment points of the [VERTICAL CORNER] screen and movement points of the projection screen]

a

a

b

b
c

c
d

d
ee

f

f

g

g
h

h

Point d will be displaced in a parallel manner at the same time as Points a, d, f

Point e will be displaced in a parallel manner at the same time as Points f, g, h

4.	 Start from Step 2 onwards to adjust the other points.

5.	 When the adjustment is completed, press the ▼▲◀▶ buttons to align the cursor with the [EXIT] in the 
adjustment screen and then press theENTER button.

•	 Switch to the [GEOMETRIC CORRECTION] menu screen.
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PINCUSHION
Adjust the curve distortion of the projection screen.

TOP	������������������������ Adjust the curve distortion of the upper edge of the projection 
screen.

BOTTOM	���������������� Adjust the curve distortion of the lower edge of the projection 
screen.

LEFT	���������������������� Adjust the curve distortion of the left edge of the projection screen.
RIGHT	�������������������� Adjust the curve distortion of the right edge of the projection 

screen.

TOP

LEFT RIGHT

BOTTOM

PC TOOL
Recall the geometric correction data that is registered in the projector beforehand.
There are three types of registered data.

NOTE:
•	 KEYSTONE, CORNERSTONE, and PINCUSHION cannot be selected when setting the geometric correction using a PC tool.
•	 To clear the [GEOMETRIC CORRECTION] data that has been set up, press the 3D REFORM button for 2 or more seconds.
•	 As electrical correction is carried out in geometric correction, the brightness may be affected and the picture quality may be 

degraded.

RESET
Reset the adjustment value that has been set up in GEOMETRIC CORRECTION (return to the initial value).
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[EDGE BLENDING]

This adjusts the edges (boundaries) of the projection screen when projecting high resolution videos using a combina-
tion of several projectors in the up, down, left and right positions.

MODE
This enables or disables the EDGE BLENDING function.
When MODE is set to ON, the TOP, BOTTOM, LEFT, RIGHT and BLACK LEVEL settings can be adjusted.

TOP/BOTTOM/LEFT/RIGHT
This selects the EDGE BLENDING locations on the left, right, top and bottom on the screen.
The following settings can be adjusted when an item is selected. (→ page 57)

CONTROL	�������������� Enable TOP, BOTTOM, LEFT and RIGHT functions.
MARKER	���������������� Set whether to display marker or not when adjusting the range and display position. When turned on, a 

magenta marker for adjusting the range adjustment and a green marker for adjusting the display position 
will be displayed.

RANGE	������������������� Adjust the range (width) of the edge blending.
POSITION	�������������� Adjust the display position of the edge blending.

BLACK LEVEL
Divide the screen into nine parts and keep the black level uniform for each projector.
The nine divisions screens are TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER, CENTER-RIGHT, 
BOTTOM-LEFT, BOTTOM-CENTER and BOTTOM-RIGHT. (→ page 60)
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[MULTI SCREEN]

WHITE BALANCE
This adjusts the white balance for each projector when projecting using a combination of several projectors.
This can be adjusted when [MODE] is set to [ON].

BRIGHTNESS W, BRIGHTNESS R, BRIGHTNESS G, BRIGHTNESS B
	������������������������������ Adjusting the black color of the video.
CONTRAST W, CONTRAST R, CONTRAST G, CONTRAST B
	������������������������������ Adjusting the white color of the video.

PICTURE SETTING
This sets the division condition when projecting using a combination of several projectors.
Please refer to “4. Multi-Screen Projection” (→ page 48) for details.

MODE OFF Use the projector in a standalone state.

ZOOM This adjusts the position and width of the video area that you wish to divide. The edge 
blending width will also be automatically set to that width.

TILING This assigns the divided screens to the projectors. The edge blending function will also 
be set automatically.

ZOOM HORIZONTAL 
ZOOM

This maginifies the video area in the horizontal direction.

VERTICAL 
ZOOM

This maginifies the video area in the vertical direction.

HORIZONTAL 
POSITION

This shifts the video area in the horizontal direction.

VERTICAL PO-
SITION

This shifts the video area in the vertical direction.

TILING WIDTH This selects the number of projectors to be arranged horizontally.

HEIGHT This selects the number of projectors to be arranged vertically.

HORIZONTAL 
POSITION

This selects the position of the projector starting from the left among those arranged 
horizontally.

VERTICAL PO-
SITION

This selects the position of the projector starting from the top among those arranged 
vertically.
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Conditions for using tiling
•	 All the projectors need to fulfil the following conditions.
•	 The panel size must be the same
•	 The projection screen size must be the same
•	 The left and right ends or top and bottom ends of the projection screen must be consistent.
•	 The settings for the left and right edges of the edge blending are the same
•	 The settings for the top and bottom edges of the edge blending are the same
	 If the tiling conditions are satisfied, the video screen of the projector at each installation position will be automatically 
extracted and projected.
	 If the tiling conditions are not satisfied, adjust the video screen of the projector at each installation position using 
the zoom function.
•	 Assign a unique control ID to each projector.
•	 Set the “Color Setting” and “DeepColor Setting” on your Blu-ray player or computer to “Auto”. Refer to the owner’s 
manual accompanying your Blu-ray player or computer for more information.
	 Connect the HDMI output of your Blu-ray player or computer to the first projector. Then connect to the HDMI IN input 
terminal of the second and subsequent tiled projectors.

Tiling setting example) Number of horizontal units = 2, Number of vertical units = 2

Horizontal order = Second unit
Vertical order = First unit
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❼ Menu Descriptions & Functions [SETUP]

[MENU]

Selecting Menu Language [LANGUAGE] 
You can choose one of 29 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [INPUT DISPLAY]
This option turns on or off input name display such as HDMI, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, 
HDBaseT to be displayed on the top right of the screen.

Turning messages on and off [MESSAGE DISPLAY]
This option selects whether or not to display projector messages at the bottom of the projected image.
Even when “OFF” is selected, the security lock warning is displayed. The security lock warning turns off when the 
security lock is canceled.

Turning ON/OFF Control ID [ID DISPLAY]
ID DISPLAY	����������� This option turns on or off the ID number which is displayed when the ID SET button on the remote control 

is pressed. (→ page 105)
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Turning On / Off Eco Message [ECO MESSAGE]
This option turns on or off the following messages when the projector is turned on. 

The Eco Message prompts the user to save energy. When [NORMAL] is selected for [LIGHT MODE], you will get a 
message prompting you to select [ECO1] or [ECO2].

When one of the [LIGHT MODE] options have been selected.

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 
30 seconds.

When [NORMAL] is selected for [LIGHT MODE]

Pressing the ENTER button will display the [LIGHT MODE] screen. (→ page 98)
To close the message, press the EXIT button.

[3D CAUTION MESSAGE]
This selects whether to display a caution message or not when switching to a 3D video.
The default condition when shipped from the factory is ON.

OFF	������������������������ The 3D caution message screen will not be displayed.
ON	������������������������� The 3D caution message screen will be displayed when switching to a 3D video. Press the ENTER button 

to cancel the message.
•	 The message will disappear automatically after 60 seconds or when other buttons are pressed. If it disap-

pears automatically, the 3D caution message will be displayed again when switching to a 3D video.

Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The 
preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the fac-
tory preset.
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[INSTALLATION]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, 
desktop rear projection, and ceiling front projection.

NOTE: 
•	 Please consult the dealer if you require special installation services e.g. when mounting the projector to a ceiling. Never install 

the projector on your own. This may result in the projector falling down and causing injury to people.

AUTO	��������������������� This automatically detects and projects the DESKTOP FRONT and CEILING FRONT.

NOTE:
•	 The DESKTOP REAR and CEILING REAR will not be detected. Please select manually.

DESKTOP FRONT CEILING REAR

DESKTOP REAR CEILING FRONT

TIP:
•	 Check whether the automatic DESKTOP FRONT is installed within ± 10 degrees for floor installation and whether the CEILING 

FRONT is within ±10 degrees for ceiling installation. Select manually when the projection screen is inverted.
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Selecting Aspect Ratio and Position for Screen [SCREEN TYPE]

Screen type Sets the aspect ratio of the projection screen.

FREE The ratio of the liquid crystal panel is selected. Select this when projecting 
multi-screen and 17:9 screen (2K).

4:3 screen For a screen with a 4:3 aspect ratio

16:9 screen For a screen with a 16:9 aspect ratio

16:10 screen For a screen with a 16:10 aspect ratio

NOTE:
•	 After changing the screen type, check the setting of [ASPECT RATIO] in the menu. (→ page 80)

Using the Wall Color Correction [WALL COLOR]

This function allows for quick adaptive color correction in applications where the screen material is not white.

Selecting Fan Mode [FAN MODE]
Fan Mode is used to set the speed of the internal cooling fan.

MODE	�������������������� Select three modes for fan speed: AUTO and HIGH.
AUTO: The built-in fans automatically run at a variable speed according to the internal temperature.
HIGH: The built-in fans run at a high speed. Select this option when using the projector at altitudes ap-
proximately 2500 feet/760 meters or higher. 

NOTE: 
•	 Make sure the speed is set to [HIGH] when you are using this device continuously for several days.
•	 Set [FAN MODE] to [HIGH] when using the projector at altitudes approximately 2500 feet/760 meters or higher.
•	 Using the projector at altitudes approximately 2500 feet/760 meters or higher without setting to [HIGH] can cause the projector 

to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
•	 Using the projector at altitudes approximately 2500 feet/760 meters or higher can shorten the life of optical components such as 

the light module.
•	 Your setting will not be affected even when [RESET] is done from the menu.

TIP: 
•	 When [HIGH] is selected for [FAN MODE], a symbol icon  will be displayed at the bottom of the menu.
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[LIGHT MODE]
Adjusting the energy savings settings and the brightness of each projector in multi-screen projection. For energy 
savings settings, see page 29 “3-6. Changing LIGHT MODE/Checking Energy-Saving Effect Using LIGHT MODE 
[LIGHT MODE]”.

LIGHT MODE NORMAL The light module luminance (brightness) will become 100% and the screen will turn bright.

ECO1 By controlling the brightness and fan speed according to the selected setting, energy can 
be saved and motion noise and the power consumption can be lowered.
Can be selected when [CONSTANT BRIGHTNESS] mode is set to [OFF].ECO2

CONSTANT 
BRIGHTNESS

OFF [CONSTANT BRIGHTNESS] mode will be canceled.

ON Maintains the brightness that is in effect at the time [ON] is selected. Unless [OFF] is se-
lected, the same settings will remain in effect even when the projector is turned off.
•	 To re-adjust the brightness, first turn this setting OFF before making further adjustments.

NOTE:
•	 [CONSTANT BRIGHTNESS] mode is a function used to maintain the brightness at a constant 

level. Color will not be fixed.

ADJUST Brightness can be adjusted in 1% increments from 20 to 100%.
When several projectors are used for multi-screen projection, the brightness can be ad-
justed individually on each projector.
The adjustment is effective when [NORMAL] [LIGHT MODE] is selected and [CONSTANT 
BRIGHTNESS] mode is turned [OFF].

TIP: 
•	 Brightness normally decreases with use, but by selecting [CONSTANT BRIGHTNESS] mode, sensors inside the projector detect 

brightness and automatically adjust the output, thereby maintaining a constant brightness throughout the life of the light module.
	 However, if output is already at its maximum, brightness will decrease with use.
	 For this reason, when using multi-screen projection, it is recommended to adjust the brightness to a slightly lower level, then 

setting the [CONSTANT BRIGHTNESS] mode to [ON].

[REF. WHITE BALANCE]
This feature allows you to adjust the white balance for all signals.
The white and black levels of the signal are adjusted for optimum color reproduction.

CONTRAST R/CONTRAST G/CONTRAST B
	������������������������������ These adjust the picture’s white color.
BRIGHTNESS R/BRIGHTNESS G/BRIGHTNESS B
	������������������������������ These adjust the picture’s black color.

3D GLASSES
Select 3D glasses method.

DLP® Link	������������� Select when using DLP® Link type 3D glasses.
OTHERS	����������������� Select when using a non 3D emitter type glasses. It is required to connect the 3D emitter to the 3D SYNC 

terminal of this projector. Please refer to page 40 about recommended items of 3D glasses and 3D emitter 
for this projector.
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[CONTROL]

TOOLS

ADMINISTRATOR MODE
This allows you to select MENU MODE, save settings, and set a password for the administrator mode.

MENU MODE Select either [BASIC] or [ADVANCED] menu.
(→ page 64)

—

NOT SAVE SETTING 
VALUES

Placing a check mark will not save your projector settings.
Clear this check box to save your projector settings.

—

NEW PASSWORD/
CONFIRM PASS-
WORD

Assign a password for the administrator mode. Up to 10 alphanumeric 
characters
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PROGRAM TIMER

This option turns on/standby the projector and changes video signals, and selects ECO mode automatically at a 
specified time.

NOTE:
•	 Before using [PROGRAM TIMER], make sure that the [DATE AND TIME] feature is set. (→ page 103)
	 Make sure that the projector is in the standby condition with the POWER cord connected.
	 The projector has a built-in clock. The clock will keep working for about two weeks after the main power is turned off. If the main 

power is not supplied to the projector for two weeks or more, it requires to set [DATE AND TIME SETTINGS] feature again.

Setting a new program timer
1.	 On the PROGRAM TIMER screen, use the ▲ or ▼ button to select [SETTINGS] and press the ENTER button.

	 The [PROGRAM LIST] screen will be displayed.

2.	 Select a blank program number and press the ENTER button.

	 The [EDIT] screen will be displayed.

3.	 Make settings for each item as required.

ACTIVE	������������������ Place a check mark to enable the program.
DAY	������������������������ Select days of the week for the program timer. To execute the program from Monday to Friday, select [MON-

FRI]. To execute the program in everyday basis, select [EVERYDAY].
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TIME	���������������������� Set the time to execute the program. Enter time in 24-hour format.
FUNCTION	������������� Select a function to be executed. Selecting [POWER] will allow you to turn on or off the projector by setting 

[ADVANCED SETTINGS]. Selecting [INPUT] will allow you to select a video source by setting [ADVANCED 
SETTINGS]. Selecting [LIGHT MODE] will allow you to select [LIGHT MODE] by setting [ADVANCED SET-
TINGS].

ADVANCED SETTINGS
	������������������������������ Select power on/off, a type of video source, or LIGHT MODE for the selected item in [FUNCTION].
REPEAT	������������������ Place a check mark to repeat the program continuing basis. To use the program this week only, clear the 

check mark.
4.	 Select [OK] and press the ENTER button.

	 This will complete the settings.

	 You will be returned to the [PROGRAM LIST] screen.

5.	 Select [BACK] and press the ENTER button.

	 You will be returned to the [PROGRAM TIMER] screen.

6.	 Select [OK] and press the ENTER button.

	 You will be returned to the [TOOLS] screen.

NOTE:
•	 Up to 30 different timer settings can be programmed.
•	 When [PROGRAM TIMER] is turned on, the [STANDBY MODE] setting is ignored.
•	 The Program Timer is executed on a set time basis, not in a program basis.
•	 Once the program not marked with a check in [REPEAT] has been executed, the check mark in the [ACTIVE] check box will be 

cleared automatically and the program will be disabled.
•	 When the on-time and the off-time set for the same time, the off-time setting will take preference.
•	 Two different sources are set for the same time, the larger program number will take preference. 
•	 The on-time setting will not be executed while the cooling fans are running or an error is occurring.
•	 If the off-time setting is expired under the condition in which the power off is not possible, the off-timer setting will not be executed 

until the power off becomes possible.
•	 Programs not marked with a check mark in [ACTIVE] of the [EDIT] screen will not be executed even if the Program Timer is 

enabled.
•	 When the projector is turned on by using the program timer and if you want to turn off the projector, set the off-time or do it 

manually so as not to leave the projector on for a long period of time.
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Activating the program timer

1.	 Select [ENABLE] on the [PROGRAM TIMER] screen and press the ENTER button.

	 The selection screen will be displayed.

2.	 Press the ▼ button to align the cursor with [ON] and then press the ENTER button.

	 Return to the [PROGRAM TIMER] screen.

NOTE:
•	 When the effective settings of the [PROGRAM TIMER] have not been set to [ON], the program will not be executed even if the 

[ACTIVE] items in the program list have been ticked.
•	 Even when the effective settings of the [PROGRAM TIMER] are set to [ON], the [PROGRAM TIMER] will not work until the [PRO-

GRAM TIMER] screen is closed.

Changing the programmed settings

1.	 On the [PROGRAM LIST] screen, select a program you want to edit and press the ENTER button.

2.	 Change the settings on the [EDIT] screen.

3.	 Select [OK] and press the ENTER button.

	 The programmed settings will be changed.

	 You will be returned to the [PROGRAM LIST] screen.

Changing the order of programs

1.	 On the [PROGRAM LIST] screen, select a program whose order you want to change and press the ▶ button.

2.	 Press the ▼ button to select ▲ or ▼.

3.	 Press the ENTER button a few times to select a row to which you wish to move the program.

	 The order of the programs will be changed.

Deleting the programs

1.	 On the [PROGRAM LIST] screen, select a program number you want to delete and press the ▶ button.

2.	 Press the ▼ button to select [DELETE].

3.	 Press the ENTER button.

	 The confirmation screen will be displayed.

4.	 Select [YES] and press the ENTER button.

	 The program will be deleted.

This will complete deleting the program.
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DATE AND TIME SETTINGS

You can set the current time, month, date, and year.
NOTE: The projector has a built-in clock. The clock will keep working for about 2 weeks after the main power is turned off. If the 
main power is off for 2 weeks or more, the built-in clock will cease. If the built-in clock ceases, set the date and time again. The 
built-in clock will not cease while in the standby mode.

TIME ZONE SETTINGS	�������������� Select your time zone.
DATE AND TIME SETTINGS	������ Set your current date (MM/DD/YYYY) and time (HH:MM). 
INTERNET TIME SERVER	��������� If you place a check mark, the projector’s built-in clock will be synchronized with an Internet 

time server in every 24 hours and at the time of projector’s startup.
UPDATE	������������������������������������ Synchronizes the projector’s built-in clock immediately. The UPDATE button is not available 

unless the INTERNET TIME SERVER check box is turned on.
SUMMER TIME SETTINGS	������� If you place a check mark, the clock for daylight saving will be enabled.

[MOUSE]
This function cannot be used in this device. It is used for future expansion purposes only.
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Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
•	 How to cancel the [CONTROL PANEL LOCK]
	 When the [CONTROL PANEL LOCK] is set to [ON], press the SOURCE button on the main body for about 10 seconds to cancel 

the [CONTROL PANEL LOCK].

TIP: 
•	 When the [CONTROL PANEL LOCK] is turned on, a key lock icon [  ] will be displayed at the bottom right of the menu.
•	 This CONTROL PANEL LOCK does not affect the remote control functions.

Enabling Security [SECURITY]
This feature turns on or off the SECURITY function.
Unless the correct keyword is entered, the projector cannot project an image. (→ page 35)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 115200 bps. 
The default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the 
equipment, a lower baud rate may be recommended for long cable runs).

NOTE:
•	 Select [38400bps] or less when using the supplied software programs.
•	 Your selected communication speed will not be affected even when [RESET] is done from the menu.
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Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL 
ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together 
using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER	�������Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID	�����������������������Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID setting.

NOTE: 
•	 When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support 

the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)
•	 Your setting will not be affected even when [RESET] is done from the menu.
•	 Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control 

ID.

Assigning or Changing the Control ID
1.	 Turn on the projector.

2.	 Press the ID SET button on the remote control.

	 The CONTROL ID screen will be displayed.

	 If the projector can be operated with the current remote control ID, the [AC-
TIVE] will be displayed. If the projector cannot be operated with the current 
remote control ID, the [INACTIVE] will be displayed. To operate the inactive 
projector, assign the control ID used for the projector by using the following 
procedure (Step 3).

3.	 Press one of numeric keypad buttons while pressing and holding the ID 
SET button on the remote control.

	 Example:

	 To assign “3”, press the “3” button on the remote control.

	 No ID means that all the projectors can be operated together with a single 
remote control. To set “No ID”, enter “000” or press the CLEAR button.

TIP: The range of IDs is from 1 to 254.
4.	 Release the ID SET button.

	 The updated CONTROL ID screen will be displayed.

NOTE: 
•	 The IDs can be cleared in a few days after the batteries are run down or removed.
•	 If one of buttons of the remote control without batteries is pressed accidentally, 

current specified ID will be cleared.
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Turning On or Off Remote Sensor [REMOTE SENSOR]
This option determines which remote sensor on the projector is enabled in wireless mode.
The options are: FRONT/BACK, FRONT, BACK, and HDBaseT. 

NOTE:
•	 The remote control of the projector will not be able to receive signals if the power supply of the HDBaseT transmission device 

connected to the projector is switched on when this has been set to “HDBaseT”.

TIP:
•	 If the remote control system does not function when direct sunlight or strong illumination strikes the remote control sensor of 

the projector, change another option.
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[NETWORK SETTINGS]

Important:
•	 Consult with your network administrator about these settings.
•	 When using a wired LAN connection, connect a LAN cable (Ethernet cable) to the LAN port (RJ-45) of the projector. (→ page 

133) 

TIP: The network settings you make will not be affected even when [RESET] is done from the menu.

Hints on How to Set Up LAN Connection 

To set up the projector for a LAN connection:
Select [WIRED LAN] → [PROFILES] → [PROFILE 1] or [PROFILE 2].
Two settings can be set for wired LAN.
Next turn on or off for [DHCP], [IP ADDRESS], [SUBNET MASK], and [GATEWAY] and select [OK] and press the 
ENTER button. (→ page 108)
To recall LAN settings stored in the profile number:
Select [PROFILE 1] or [PROFILE 2] for wired LAN, and then select [OK] and press the ENTER button. (→ page 108)
To connect a DHCP server:
Turn on [DHCP] for wired LAN. Select [ON] and press the ENTER button. To specify IP address without using the 
DHCP server, turn off [DHCP]. (→ page 108)
To receive error messages via e-mail:
Select [ALERT MAIL], and set [SENDER'S ADDRESS], [SMTP SERVER NAME], and [RECIPIENT'S ADDRESS]. 
Last, select [OK] and press the ENTER button. (→ page 110)
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WIRED LAN

PROFILES •	 The settings for using the built-in Ethernet/HDBaseT port in the 
projector can be recorded in the projector memory in two ways.
•	 Select [PROFILE 1] or [PROFILE 2] and then do settings for 
[DHCP] and the other options. 
	 After doing this, select [OK] and press the ENTER button. This 
will store your settings in memory.
•	 To recall the settings from memory:
	 After selecting [PROFILE 1] or [PROFILE 2] from the [PRO-
FILES] list.
	 Select [OK] and press the ENTER button. 
•	 Select [DISABLE] when not connecting to a wired LAN

—

DHCP Place a check mark to automatically assign an IP address to the 
projector from your DHCP server.
Clear this check box to register the IP address or subnet mask 
number obtained from your network administrator.

—

IP ADDRESS Set your IP address of the network connected to the projector 
when [DHCP] is turned off.

Up to 12 numeric 
characters

SUBNET MASK Set your subnet mask number of the network connected to the 
projector when [DHCP] is turned off.

Up to 12 numeric 
characters

GATEWAY Set the default gateway of the network connected to the projector 
when [DHCP] is turned off. 

Up to 12 numeric 
characters

AUTO DNS Place a check mark to automatically assign the IP address of your 
DNS server connected to the projector from your DHCP server.
Clear this check box to set the IP address of your DNS server 
connected to the projector.

Up to 12 numeric 
characters

DNS CONFIGURA-
TION

Set the IP address of your DNS server on the network connected 
to the projector when [AUTO DNS] is cleared.

Up to 12 numeric 
characters

RECONNECT Retry to connect the projector to a network. Try this if you have 
changed [PROFILES]. 

—
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PROJECTOR NAME

PROJECTOR NAME Set a unique projector name. Up to 16 alphanu-
meric characters and 
symbols

DOMAIN
Set a host name and domain name of the projector.

HOST NAME Set a host name of the projector. Up to 15 alphanumeric 
characters

DOMAIN NAME Set a domain name of the projector. Up to 60 alphanumeric 
characters
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ALERT MAIL

ALERT MAIL This option will notify your computer of lamp replace time or error 
messages via e-mail when using wireless or wired LAN. 

Placing a checkmark will turn on the Alert Mail feature.
Clearing a checkmark will turn off the Alert Mail feature.

Sample of a message to be sent from the projector:

Subject: [Projector] Projector Information
THE COOLING FAN HAS STOPPED.
[INFORMATION]
PROJECTOR NAME:  PX602UL Series
LIGHT HOURS USED:  0000[H]

—

HOST NAME Type in a host name. Up to 15 alphanumeric 
characters

DOMAIN NAME Type in a domain name of the network connected to the projector. Up to 60 alphanumeric 
characters

SENDER'S AD-
DRESS

Specify the sender’s address. Up to 60 alphanu-
meric characters and 
symbols

SMTP SERVER 
NAME

Type in the SMTP server name to be connected to the projector. Up to 60 alphanumeric 
characters

RECIPIENT'S AD-
DRESS 1, 2, 3

Type in your recipient’s address. Up to 60 alphanu-
meric characters and 
symbols

TEST MAIL Send a test mail to check if your settings are correct.
NOTE:
•	 If you entered an incorrect address in a test, you may not receive an 

Alert mail. Should this happen, check if the Recipient’s Address is 
correctly set.

•	 Unless any one of the [SENDER'S ADDRESS], [SMTP SERVER'S 
NAME] or [RECIPIENT'S ADDRESS 1-3] is selected, [TEST MAIL] is 
not available.

•	 Be sure to highlight [OK] and press the ENTER button before executing 
[TEST MAIL].

 

—
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NETWORK SERVICE

HTTP SERVER Set a password for your HTTP server. Up to 10 alphanumeric 
characters

PJLink This option allows you to set a password when you use the 
PJLink feature.
NOTE: 
•	 Do not forget your password. However, if you forget your password, 

consult with your dealer. 
•	 What is PJLink?
	 PJLink is a standardization of protocol used for controlling projectors 

of different manufacturers. This standard protocol is established by 
Japan Business Machine and Information System Industries Associa-
tion (JBMIA) in 2005.

	 The projector supports all the commands of PJLink Class 1.
•	 Setting of PJLink will not be affected even when [RESET] is done from 

the menu.
 

Up to 32 alphanumeric 
characters

AMX BEACON Turn on or off for detection from AMX Device Discovery when 
connecting to the network supported by AMX’s NetLinx control 
system.

TIP: 
When using a device that supports AMX Device Discovery, all AMX NetLinx 
control system will recognize the device and download the appropriate 
Device Discovery Module from an AMX server.

Placing a checkmark will enable detecting the projector from AMX Device 
Discovery.
Clearing a checkmark will disable detecting the projector from AMX 
Device Discovery. 

—

CRESTRON ROOMVIEW: Turn on or off when controlling the projector from 
your PC.
CRESTRON CONTROL: Turn on or off when controlling the 
projector from your controller.
•	 CONTROLLER IP ADDRESS: Enter your IP address of CREST-
RON SERVER.
•	 IP ID: Enter your IP ID of CRESTRON SERVER.

Up to 12 numeric 
characters

TIP: The CRESTRON settings are required only for use with CRESTRON ROOMVIEW.
For more information, visit http://www.crestron.com

http://www.crestron.com
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[SOURCE OPTIONS]

Setting Auto Adjust [AUTO ADJUST]
This feature sets the Auto Adjust mode so that the computer signal can be automatically or manually adjusted for 
noise and stability. You can automatically make adjustment in two ways: [NORMAL] and [FINE].

OFF	������������������������ The computer signal will not be automatically adjusted. You can manually optimize the computer signal.
NORMAL	���������������� Default setting. The computer signal will be automatically adjusted. Normally select this option.
FINE	����������������������� Select this option if fine adjustment is needed. It takes more time to switch to the source than when [NOR-

MAL]is selected.

TIP:
•	 The default setting when shipped from the factory is [NORMAL].
•	 When the AUTO ADJ. button is pressed, the same [FINE] adjustment is carried out.

[COLOR SYSTEM]
This feature allows you to select the TV video signal, which differs from country to country (NTSC, PAL, etc.).
This is set to [AUTO] by factory default. Set this if the projector cannot identify the signal automatically.

Selecting Default Source [DEFAULT INPUT SELECT]
You can set the projector to default to any one of its inputs each time the projector is turned on.

LAST	���������������������� Set the projector to default to the previous or last active input each time the projector is turned on.
AUTO	��������������������� Search for an active source in order of HDMI → DisplayPort → BNC → BNC(CV) → BNC(Y/C) → COMPUTER 

→ HDBaseT → SLOT and displays the first found source.
HDMI	��������������������� Display the digital source from the HDMI IN terminal every time the projector is turned on. 
DisplayPort	������������ Display the digital source from the DisplayPort IN terminal every time the projector is turned on. 
BNC	����������������������� Project the input signal from the BNC input terminal
BNC(CV)	���������������� Project the input signal from the BNC(CV) input terminal.
BNC(Y/C)	��������������� Project the input signal from the BNC(Y/C) input terminal.
COMPUTER	����������� Display the computer signal from the COMPUTER 1 IN terminal every time the projector is turned on.
HDBaseT	���������������� Project the HDBaseT or WIRED LAN signal.
SLOT	���������������������� Project the picture via the optional board (sold separately) inserted into the SLOT.
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Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video 
or S-Video.
The subtitles and text will be displayed a short while after the on-screen menu disappears.

OFF	������������������������ This exits the closed caption mode.
CAPTION 1-4	��������� Text is superimposed.
TEXT 1-4	���������������� Text is displayed.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is [BLUE].

NOTE: 
•	 Even when the background logo is selected, if two pictures are displayed in [PIP/PICTURE BY PICTURE] mode, the blue background 

is displayed without the logo when there is no signal.
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[POWER OPTIONS]

Selecting Power-saving in [STANDBY MODE]
Setting the power consumption in the standby mode.

NORMAL	���������������� In the standby mode, the power consumption of the projector is 0.5 W.
In the standby mode, the POWER indicator lights up in red while the STATUS indicator will go off.
•	 When set to [NORMAL], the following terminals and functions will be disabled. HDMI OUT terminals, 

Ethernet/HDBaseT port, LAN function, mail notification function
NETWORK STANDBY
	������������������������������ Compared to [NORMAL], the power consumption in the standby mode is higher but power can be supplied 

to the projector using a wired LAN.
In the standby mode, the power indicator will light up in orange while the status indicator will be turned off.

Important:
•	 When [NETWORK STANDBY] is selected, [AUTO POWER OFF] will turn grey in color and be disabled and [0:15] will be selected 

automatically.
•	 In the following conditions, the [STANDBY MODE] setting will be disabled and the projector will go into the sleep mode.

*	 Sleep mode refers to the mode whereby the functional restrictions due to the [STANDBY MODE] setting are removed.
•	 When [ENABLE] is selected under [NETWORK SERVICE] → [AMX BEACON]
•	 When [HDBaseT] is selected under [CONTROL] → [REMOTE SENSOR]
•	 When a signal is being received from a HDBaseT transmission device

•	 When [NORMAL] is selected, the [AUTO POWER ON SELECT] display turns grey in color and is disabled, and [OFF] is automati-
cally selected.

NOTE:
•	 When connecting to a HDBaseT transmission device sold commercially, if the transmission device is set to transmit remote control 

signals, the power consumption of the projector in the standby mode will increase.

TIP: 
•	 Your setting will not be affected even when [RESET] is done from the menu.
•	 The power consumption in the standby mode will not be included in calculating CO2 emission reduction.

Enabling Direct Power On [DIRECT POWER ON]
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the 
need to always use the POWER button on the remote control or projector cabinet.
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Turning On the Projector By Applying Computer Signal [AUTO POWER ON SELECT]
If set to [NETWORK STANDBY], the projector automatically detects the synchronizing signal input from the following 
selected terminals and projects the picture accordingly: Computer, HDMI, DisplayPort, HDBaseT, and SLOT.

OFF	������������������������ AUTO POWER ON SELECT function will be switch off.
HDMI, DisplayPort, COMPUTER, HDBaseT, SLOT
	������������������������������ When a computer signal of a selected input terminal is detected, the power supply of the projector will be 

turned on automatically and the computer screen will be projected.

NOTE: 
•	 If you want to activate the AUTO POWER ON SELECT function after powering OFF the projector, interrupt the signal from the input 

terminals or disconnect the computer cable from the projector and wait for at least 3 seconds before inputting the signal from 
the selected terminal. When the projector is turned off and enters NETWORK STANDBY mode, but signals from the computer 
continue to be sent the projector, the projector maintains NETWORK STANDBY mode and will not turn ON automatically. In addi-
tion, if signals from HDMI, DisplayPort or HDBaseT continue to be sent to the projector, depending on the settings of connected 
external devices, the projector may turn ON automatically even if it is powered off and NETWORK STANDBY mode is in effect.

•	 This function does not work when component signals come into COMPUTER 1 IN terminal or when computer signals are Sync 
on Green or Composite Sync.

Enabling Power Management [AUTO POWER OFF]
When this option is selected you can enable the projector to automatically turn off (at the selected time: 0:05, 0:10, 
0:15, 0:20, 0:30, 1:00) if there is no signal received by any input or if no operation is performed.

NOTE:
•	 The power will not go off automatically when a signal from the Ethernet/HDBaseT port is being projected.
•	 [AUTO POWER OFF] appears in grey when the [STANDBY MODE] is set to [NETWORK STANDBY] and [0:15] will be set automati-

cally.

Using Off Timer [OFF TIMER]
1.	 Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.

2.	 Press the ENTER button on the remote control.

3.	 The remaining time starts counting down.

4.	 The projector will turn off after the countdown is complete.

NOTE:
•	 To cancel the preset time, set [OFF] for the preset time or turn off the power.
•	 When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 

MINUTES] message will be displayed on the bottom of the screen.

Setting for the Optional Board [SLOT POWER]
When using the optional board installed in the slot, set the following options.

PROJECTOR ON	�����������������This feature will turn on or off the power to the optional board. 
OFF: Forcibly turn off the power to the optional board installed in the slot.
ON (Default): Turn on the power to the optional board installed in the slot.

PROJECTOR STANDBY	�������This feature will automatically enable or disable the optional board installed in the slot 
when the projector is in standby.

DISABLE: Select this option to disable the optional board in the projector standby.
ENABLE (Default): Select this option to enable the optional board in the projector standby.
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Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source (s) except 
the following:

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels. 
The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], [AS-
PECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [EDGE BLENDING], [MULTI 
SCREEN], [SCREEN TYPE], [GEOMETRIC CORRECTION], [REF. WHITE BALANCE], [ADMINISTRATOR MODE], 
[CONTROL PANEL LOCK], [SECURITY], [COMMUNICATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN 
MODE], [LIGHT HOURS USED], [TOTAL CARBON SAVINGS], and [WIRED LAN].

[ALL DATA (INCLUDING ENTRY LIST)]
Reset all the adjustments and settings for all the signals to the factory preset except [LANGUAGE], [BACKGROUND], 
[FILTER MESSAGE], [EDGE BLENDING], [MULTI SCREEN], [SCREEN TYPE], [GEOMETRIC CORRECTION], 
[REF. WHITE BALANCE], [ADMINISTRATOR MODE], [CONTROL PANEL LOCK], [SECURITY], [COMMUNICATION 
SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LIGHT HOURS USED], [TOTAL CARBON SAVINGS], 
and [WIRED LAN].
Also deletes all the signals in the [ENTRY LIST] and returns to the factory preset.

NOTE: Locked signals in Entry List cannot be reset.
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❽ Menu Descriptions & Functions [INFO.]
Displays the status of the current signal and light module usage. This item has nine pages. The information included 
is as follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

[USAGE TIME]

[LIGHT HOURS USED] (H)
[TOTAL CARBON SAVINGS] (kg-CO2)

•	 [TOTAL CARBON SAVINGS]

	 This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving cal-
culation is based on the OECD (2008 Edition). (→ page 31)

[SOURCE(1)]

INPUT TERMINAL	 RESOLUTION	
HORIZONTAL FREQUENCY	 VERTICAL FREQUENCY	
SYNC TYPE	 SYNC POLARITY	
SCAN TYPE	 SOURCE NAME	
ENTRY NO.
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[SOURCE(2)]

SIGNAL TYPE	 VIDEO TYPE	
BIT DEPTH	 VIDEO LEVEL	
LINK RATE	 LINK LANE
3D FORMAT

[SOURCE(3)]

INPUT TERMINAL	 RESOLUTION	
HORIZONTAL FREQUENCY	 VERTICAL FREQUENCY	
SYNC TYPE	 SYNC POLARITY	
SCAN TYPE	 SOURCE NAME	
ENTRY NO.

[SOURCE(4)]

SIGNAL TYPE	 VIDEO TYPE	
BIT DEPTH	 VIDEO LEVEL	
LINK RATE	 LINK LANE
3D FORMAT



119

5. Using On-Screen Menu

[WIRED LAN]

IP ADDRESS	 SUBNET MASK	
GATEWAY	 MAC ADDRESS

[VERSION(1)]

FIRMWARE	 DATA	
SUB-CPU

[OTHERS]

DATE TIME	 PROJECTOR NAME	
MODEL NO.	 SERIAL NUMBER	
CONTROL ID (when [CONTROL ID] is set)
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[HDBaseT]

SIGNAL QUALITY	 OPERATION MODE	
LINK STATUS	 HDMI STATUS
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❶ Mounting a lens (sold separately)
This projector can be used with 3 kinds of optional lenses (sold separately). The chart below shows compatible lenses 
according to the projector model. The descriptions here are for the NP35ZL (standard zoom) lens. Mount other lenses 
in the same manner. See page 164 for lens options.

Lens (model)

Projector (model name) NP34ZL
Short focus zoom

NP35ZL
Standard zoom

NP36ZL
Standard zoom

NP37ZL
Long focus zoom

PX602UL-WH/PX602UL-BK Yes Yes No Yes

PX602WL-WH/PX602WL-BK Yes Yes Yes Yes

Yes = can be mounted, No = cannot be mounted

 WARNING:
(1) Turn off the power and wait for the cooling fan to stop, (2) turn off the main power switch, (3) disconnect the 
power cord and wait for the unit to cool before mounting or removing the lens. Failure to do so can result in eye 
injury, electric shock, or burn injuries.

NOTE:
•	 The projector and lenses are made of precision parts. Do not subject them to shock or excessive forces.
•	 Remove the separately sold lens when moving the projector. If not, the lens could be subject to shock while the projector is being 

moved, damaging the lens and the lens shift mechanism.
•	 When dismounting the lens from the projector, return the lens position to the home position before turning off the power. Failure 

to do so may prevent the lens from being mounted or dismounted because of narrow space between the projector and the lens.
•	 Never touch the lens surface while the projector is operating.
•	 Be very careful not to let dirt, grease, etc., on the lens surface and not to scratch the lens surface.
•	 Perform these operations on a flat surface over a piece of cloth, etc., to prevent the lens from getting scratched.
•	 When leaving the lens off the projector for long periods of time, mount the dust cap on the projector to prevent dust or dirt from 

getting inside. If the lens remains detached from the projector for long periods of time, dust may collect within the optical unit 
and damage the lens, causing deterioration of projected image.

•	 Other types of lenses cannot be mounted on this projector. The NP34ZL/NP35ZL/NP36ZL/NP37ZL series of lenses cannot be 
mounted onto other projector models.

Part Names of the Lens Mount
Attaching the Lens Mount
Rotate and align the 3 flanges on the lens with the 3 flange catches on the lens mount. The lens can be secured to 
the mount using a lock mechanism.

“TOP” orientation indicator

Lens cap

Flange
(3 places)

Locking screw

Hook (3 places)

Lens hood

Lock release button

Lens capCatch
(3 places)

Front panel

Protective cap

Mount lock

Lens

6. Connecting to Other Equipment
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Using the lock mechanism
Release: Locking screw is tightened
The lens can be attached or detached (factory default setting).

Lock: Locking screw is untightened
The lens cannot be attached or detached. Pressing the lock release but-
ton all the way in disables the lock mechanism and allows the lens to be 
attached or detached.

Mounting the lens
Preparation: 
Prepare a flathead screwdriver.
*	 The illustration omits the projector cabinet.

1.	 Remove the lens hood.

(1)	Remove the 2 screws pinching and turning them counter-
clockwise by your fingers.

(2)	Remove the lens hood by turning it counterclockwise. The 
hooks on the lens hood will disengage from the front panel.

2.	 Remove the protective cap.

•	 The unit is shipped from the factory with the protective cap 
installed.

	 Turn the protective cap counterclockwise to release it from the 
catch. Remove the cap.

•	 Please store the protective cap in a safe place.

3.	 Remove the lens caps on either side of the lens.

•	 The NP35ZL lens unit is used as an example.

•	 Please store the lens cap in a safe place.

NOTE:
•	 Be sure to remove the lens cap. If the light source is turned on when 

the lens cap remains on the lens, it may be cause of malfunction.
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4.	 With the “TOP” orientation indicator facing upwards, insert 
the lens into the lens mount.

	 Align the flange on the upper portion of the lens with the catch 
on the left side of the lens mount.

NOTE:
•	 Insert the lens carefully to avoid it from damage by knocking against 

the lens mount.

5.	 Turn the lens clockwise until it clicks into place.

	 The 3 flanges have now engaged with the 3 catches and the 
lens unit has been mounted.

•	 To lock the lens unit see “Using the lock mechanism” on the 
previous page.

6.	 Mount the lens hood to the front panel.

(1)	Align the lens hood to the front panel. If the hood does not 
fit into the front panel, move it left and right until it is aligned 
properly.

(2)	Turn the lens hood clockwise or counterclockwise until the 
screw holes of the lens hood are aligned with the screw holes 
of the front panel.

	 The hooks in the rear will engage with the front panel flange.

(3)	Tighten the 2 screws removed in Step 1 by your fingers.
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Removing the lens
Preparation: 
Return the lens position to the home position. (→ page 19)
After the lens shift has moved, refer to the warning on page 19 and turn off the power.

1.	 Remove the lens hood.

	 Refer to Step 1 under “Mounting the lens”.

•	 If the lens unit is locked please see page 122 and follow the 
instructions under Using the Lock Function to unlock it.

2.	 Turn the lens counterclockwise to remove it from the catch, 
and slowly pull forward to remove.

•	 After removing the lens, mount the lens caps (front and back) 
included with the lens before storing the lens.

•	 To replace the lens, see Step 3 of “Mounting the lens”.

3.	 Mount the protective cap.

	 Align the flange on the protective cap to the left side of the catch 
and turn clockwise until it clicks into place.

4.	 Mount the lens hood to the panel.

	 Refer to Step 7 under “Mounting the lens”.
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❷ Making Connections
A computer cable, BNC cable (5-core type), HDMI cable, or a DisplayPort cable can be used to connect to a computer.
The connection cable is not enclosed with the projector. Please get ready a suitable cable for the connection.

Analog RGB signal connection

•	 Connect the computer cable to the display output terminal (mini D-sub 15 pin) on the computer and the COMPUTER 
1 IN terminal on the projector. Please use a computer cable attached with a ferrite core.

•	 When connecting the display output terminal (mini D-sub 15 pin) on the computer to the BNC input terminal, use 
a conversion cable to convert the BNC cable (5 core) to a mini D-sub 15 pin cable.

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER 1 IN  COMPUTER COMPUTER 1

BNC  BNC COMPUTER 2

COMPUTER 1 IN

Computer cable (sold commercially)

RGB - to - BNC cable 
(not supplied)

NOTE: Please check the operating manual of 
the computer as the name, position and direc-
tion of the terminal may differ depending on 
the computer.
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Digital RGB signal connection

•	 Connect a commercially available HDMI cable between the computer’s HDMI output terminal and the projector’s 
HDMI IN terminal.

•	 Connect a commercially available DisplayPort cable between the computer’s DisplayPort output terminal and the 
projector’s DisplayPort IN terminal.

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

HDMI IN  HDMI HDMI

DisplayPort IN  DisplayPort DisplayPort

DisplayPort INHDMI IN

HDMI cable (not supplied) DisplayPort cable (not supplied)
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Cautions when connecting an HDMI cable
•	 Use a certified High Speed HDMI® Cable or High Speed HDMI® Cable with Ethernet.

Cautions when connecting a DisplayPort cable
•	 Use a certified DisplayPort cable.

	

•	 Depending on the computer, some time may be required until the image is displayed.

•	 Some DisplayPort cables (commercially available) have locks.

•	 To disconnect the cable, press the button on the top of the cable’s terminal, then pull the cable out.

•	 Power can be supplied to the connecting device from the DisplayPort IN terminal (maximum of 1.65 W). However, 
power will not be supplied to the computer.

•	 When signals from a device that uses a signal converter adapter are connected to the DisplayPort IN terminal, in 
some cases the image may not be displayed.

•	 When the HDMI output of a computer is connected to the DisplayPort IN terminal, use a converter (commercially 
available).
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Cautions when using a DVI signal
•	 When the computer has a DVI output terminal, use a commercially available converter cable to connect the com-
puter to the projector’s HDMI IN terminal (only digital video signals can be input). 

HDMI IN

NOTE: When Viewing a DVI Digital Signal
•	 Turn off the power of the computer and projector before connecting devices.
•	 When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and rewinding.
•	 Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 stan-

dard. The cable should be within 197"/5 m long.
•	 Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
•	 To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI. Finally, turn on your PC.
	 Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, 

restart your PC.
•	 Some graphics cards have both analog RGB (15-pin D-Sub) and DVI (or DFP) outputs. Use of the 15-pin D-Sub terminal may 

result in no picture being displayed from the digital output of the graphics card.
•	 Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then 

reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
•	 The COMPUTER 1 IN terminals support Windows Plug and Play. The BNC input terminal does not support Windows Plug and 

Play.
•	 A Mac signal adapter (commercially available) may be required to connect a Mac computer.
	 To connect a Mac computer equipped with a Mini DisplayPort to the projector, use a commercially available Mini DisplayPort → 

DisplayPort converter cable.
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HDMI IN

HDMI OUT

Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer 
analog image you’re projecting.
•	 BNC(CV) component video signals and BNC(Y/C) S-video signals will not be output.
•	 Please refer to Page 52 when displaying the PIP/PBP screen.

NOTE:
•	 When outputting HDMI signals, turn on the power of the video device on the output side and keep it connected before inputting 

video signals into this device. The HDMI OUT terminals of the projector are equipped with repeater functions. When a device is 
connected to the HDMI OUT terminal, the resolution of the output signal is limited by the resolution supported by the connected 
device.

•	 In the case of the HDMI OUT terminal of the projector, the theoretical number of units that can be connected in a series is seven. 
The maximum number of units that can be connected may be reduced by the external environment and quality of the signal and 
cable, etc. The number of units that can be connected may differ depending on the HDCP version, restriction on the number of 
HDCP repeaters in the source device and the quality of the cable. The overall system needs to be checked in advance when build-
ing a system.

•	 When the [STANDBY MODE] is set to [NORMAL], video will not be output if the projector goes into the standby mode. Set the 
mode to [NETWORK STANDBY], turn on the power of the transmission device and keep it in a connected state. 

•	 When the [STANDBY MODE] of this device is set to [NORMAL], HDMI signals will not be output. To output HDMI signals, set the 
[STANDBY MODE] to [NETWORK STANDBY], turn on the power supply of the transmission device and keep it connected.

•	 HDMI repeater function will not be functioned if switching terminals and putting in/pulling out the HDMI cable is performed on 
the 2nd projector and after.

Computer cable (VGA) (not supplied)

HDMI cable (not supplied)
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Connecting Your Blu-ray Player or Other AV Equipment
Component video signal/S-video signal connection

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

BNC(CV)  BNC(CV) VIDEO

BNC(Y/C)  BNC(Y/C) S-VIDEO

CV Y C

BNC（CV）
BNC（Y） BNC（C）

BNC cable (not supplied)

Audio equipment
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Connecting Component Input

•	 Select the source name for its appropriate input terminal after turning on the projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER 1 IN  COMPUTER COMPUTER 1

BNC  BNC COMPUTER 2

NOTE:
•	 When the signal format is set to [AUTO] (default factory setting when shipped), the computer signal and component signal are 

automatically distinguished and switched. If the signals cannot be distinguished, select [COMPONENT] under [ADJUST] → 
[VIDEO] → [SIGNAL TYPE] in the on-screen menu of the projector.

•	 To connect to a video device with a D terminal, use the sold separately D terminal converter adapter (model ADP-DT1E).

COMPUTER 1 IN

15-pin - to - RCA (female) × 3 cable adapter 
(ADP-CV1E) BNC (male) - to - RCA (male) conversion 

cable × 3 (sold commercially)

Component video RCA × 3 cable (not sup-
plied)

Blu-ray player

Audio Equipment
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Connecting HDMI Input
You can connect the HDMI output of your Blu-ray player, hard disk player, or notebook type PC to the HDMI IN terminal 
of your projector.

Input terminal
SOURCE button on the projector 

cabinet
Button on the remote control

HDMI IN  HDMI HDMI

TIP: For users of audio video equipment with an HDMI terminal:
Select “Enhanced” rather than “Normal” if HDMI output is switchable between “Enhanced” and “Normal”.
This will provide improved image contrast and more detailed dark areas.
For more information on settings, refer to the instruction manual of the audio video equipment to be connected.

•	 When connecting the HDMI IN terminal of the projector to the Blu-ray player, the projector’s video level can be 
made settings in accordance with the Blu-ray player’s video level. In the menu select [ADJUST] → [VIDEO] → 
[VIDEO LEVEL] and make necessary settings.

HDMI IN

Audio cable (not supplied)

HDMI cable (not supplied)
Use High Speed HDMI® 
Cable.
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Connecting to a Wired LAN
The projector comes standard with a Ethernet/HDBaseT port (RJ-45) which provides a LAN connection using a LAN 
cable. 
To use a LAN connection, you are required to set the LAN on the projector menu. Select [SETUP] → [NETWORK 
SETTINGS] → [WIRED LAN]. (→ page 107).

Example of LAN connection
Example of wired LAN connection

Ethernet/HDBaseT

Server

Hub

LAN cable (not supplied)

NOTE: Use a Category 5 or higher LAN cable.
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Connecting to a HDBaseT transmission device (sold commercially)
HDBaseT is a connection standard for home appliances that is established by the HDBaseT Alliance.
Use a LAN cable sold commercially to connect the Ethernet / HDBaseT port of the projector (RJ-45) to a HDBaseT 
transmission device sold commercially.
The Ethernet/HDBaseT port of the projector supports HDMI signals (HDCP) from transmission devices, control signals 
from external devices (serial, LAN) and remote control signals (IR commands).

Connection example

Ethernet/HDBaseT

Computer (for control use)
Computer (for output use)

Example of a transmission device

Remote control

HDMI output video device

NOTE:
•	 Please use a shielded twisted pair (STP) cable of Category 5e or higher for the LAN cable (sold commercially).
•	 The maximum transmission distance over the LAN cable is 100 m. (the maximum distance is 70 m for a 4K signal)
•	 Please do not use other transmission equipment between the projector and transmission equipment. The picture quality may be 

deteriorated as a result.
•	 This projector is not guaranteed to work with all HDBaseT transmission devices sold commercially.



135

6. Installation and Connections

Portrait projection (vertical orientation)
By using a safety cover (sold separately), the projector can be mounted 
vertically to display computer images in portrait orientation.
If the safety cover is missing, the power will not turn on.
All screens, such as the on-screen menus, will be rotated in the counter-
clockwise direction.
The projector is equipped with a sensor to automatically detect the instal-
lation state.

 Precautions during installation
•	 Please do not install the projector in a vertical orientation on top of the floor or table on its own. If not, the pro-
jector may fall over, resulting in injury, damage or malfunction.

•	 For vertical installation, install the projector with the intake vent (safety cover) facing downwards. A stand for 
supporting the projector needs to be made for this purpose. In this case, the stand must be designed such that 
the center of gravity of the projector is located well within the legs of the stand. If not, the projector may fall over 
and result in injury, damage and malfunction.

•	 Do not obstruct the intake vent on the safety cover. The projector may otherwise overheat, causing fire and 
malfunction.

NOTE:
•	 When using a safety cover, the power turns on only when the projector ventilation intake is facing down. If the intake vent faces 

any other direction, the power will not turn on.
•	 If the projector is mounted vertically without a safety cover, the power will not turn on.
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Design and manufacturing conditions for the stand
1.	 To display images in portrait orientation, use a safety cover (sold separately). (→ page 137)

2.	 Please hire an installation service provider (for a fee) for the design and manufacture of a customized stand to be 
used for portrait projection. Please ensure that the design complies with the following conditions:

•	 There is an intake vent opening on the safety cover. Do not obstruct this opening.

•	 There are 2 ventilation holes at the bottom of the projector. These holes should remain unobstructed.

•	 Use the 6 screw holes at the back of the projector to secure it to the stand.

	 Screw hole center dimension: 300 × 300 (pitch = 150) mm

	 Screw hole dimension on the projector: M4 with a maximum depth of 8 mm

	 3 of the legs can be unscrewed for removal.

•	 Horizontal adjustment mechanism (for example, bolts and nuts in 4 places)

•	 Please design the stand so that it does not easily topple over.
*	 We recommend combining ceiling mounts (model NP15CM, sold separately) with an angle adjustment mechanism.

Reference drawings
*	 The drawing showing the dimensional requirements is not an actual stand design drawing.

32 34

150150

34

85

30
0

[Side View] [Front View]

Screw holes for 6 - 
M4 use

□ 84 × 108 holes  
(Intake vent)

□ 40 × 78 holes  
(Exhaust vent)

(Unit: mm)

Horizontal adjusterIntake vent
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Mounting the safety cover (sold separately)
The projector is equipped a switch for changing to vertical mount portrait projection. Mount the safety cover and place 
vertically to change to vertical orientation mode.

1.	 Insert and tighten the 7 screws (turning clockwise) to mount to the projector.

*	 If using in normal horizontal orientation, make sure to remove the safety cover.

	 To remove, unscrew the 7 screws (turning counter-clockwise).
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Stacking projectors
The projected image brightness can be doubled by gravity stacking up to two projectors without external support. This 
is called “Stacking Projection”.
2 projectors can be stacked on top of each other for “Stacking” setup.

 CAUTION:
A minimum of two persons are required to carry the projector. Otherwise the projector may tumble or drop, causing 
personal injury.

NOTE:
•	 Projectors with different model numbers cannot be gravity stacked.
	 Optional lenses with the same model numbers must be used for stacking projection.
•	 For stacking projectors, attach the supplied three stacking holders to the top of the lower projector. (→ next page)
•	 It does not support overlay accuracy by stacked projectors. Precise images as small texts and detailed graphics can not be clearly 

read or seen.
•	 Use a commercially available distribution amplifier to both the primary (upper) and the secondary (lower) projectors to distribute 

signal to two outputs of the two projectors.
•	 Notes for stacking

-	 Ask your service person for setting up and adjusting projectors.
-	 Set up the projectors in a place or structure in a way with sufficient strength to support the combined weight of the two projec-

tors. The single projector with a lens weighs up to approximately 20 kg/ 44 lbs.
-	 To prevent the projectors from falling, fasten them in a way to withstand earthquakes.
-	 Double stacking will cause room temperature to increase. Ventilate the room well.
-	 Do not attempt to stack projectors on the ceiling. Gravity stacking cannot be done on the ceiling.
-	 Warm up the projectors for one hour before the desired projection is obtained.
-	 Make sure that the position of the upper projector does not exceed its specifications. When setting up the two projectors, 

adjustable height range for the tilt feet on the upper projector is added to the total adjustable range.
-	 Set up the projectors so that the projected image shows as little geometric distortions as possible. The lens is different in 

geometric distortion between wide(+) and tele (−) for zoom.
-	 Adjust the horizontal lens shift to the lens center.

 s
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Attaching Stacking Holders
Attach three stacking holders to three locations on the top of the lower projector.

Preparation:
Tools required are Phillips screwdriver (plus-head) and three stacking holders packaged with the projector.
Loosen the tilt feet (three locations) of the projector.

1.	 Remove rubber caps and screws at three locations.

(1)	Use your tweezers or nail to pinch and pull up the rubber cap.

(2)	Remove the screw from a square hole.
(1) (2)

2.	 Attach the three stacking holders at three locations.

(1)	Place a stacking holder in a square hole.

(2)	Use the screw removed at Step 1 to fix the stacking holder in the square hole.

(3)	Put the rubber cap removed at Step 1 back into the square hole.

	 •	 Snap the tabs on both of the rubber cap into the slits on both sides in the square hole.
(1) (2) (3)
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3.	 Put another projector on the first projector.

	 Put each tilt foot of the upper projector on the stacking holders (three locations).

•	 Each tilt foot has a rubber. Place each tilt foot rubber on stacking holders (three locations).

Foot rubber

TIP:
•	 To remove the stacking holders, perform the above steps in reverse order.
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❶ Cleaning the Lens
•	 Turn off the projector before cleaning.

•	 The projector has a plastic lens. Use a commercially available plastic lens cleaner.

•	 Do not scratch or mar the lens surface as a plastic lens is easily scratched.

•	 Never use alcohol or glass lens cleaner as doing so will cause damage to the plastic lens surface.

 WARNING
•	 Please do not use a spray containing flammable gas to remove dust attached to the lens, etc. Doing so may 
result in fires.

❷ Cleaning the Cabinet
Turn off the projector, and unplug the projector before cleaning.
•	 Use a dry soft cloth to wipe dust off the cabinet.

	 If heavily soiled, use a mild detergent. 

•	 Never use strong detergents or solvents such as alcohol or thinner. 

•	 When cleaning the ventilation slits or the speaker using a vacuum cleaner, do not force the brush of the vacuum 
cleaner into the slits of the cabinet.

Vacuum the dust off the ventilation slits.

•	 Poor ventilation caused by dust accumulation in ventilation openings (intake, exhaust, also at the bottom of the 
projector) can result in overheating and malfunction. These areas should be cleaned regularly.

•	 Do not scratch or hit the cabinet with your fingers or any hard objects

•	 Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the lens, or the screen. Do not leave a rubber or vinyl product 
in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off. 
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❶ Operating Environment for Software Included on CD-ROM
Names and Features of Bundled Software Programs

Name of software program Features

Virtual Remote Tool
(Windows only)

When the computer and projector are connected using a network (wired LAN), 
such operations as turning the projector’s power on and off and switching the 
signal can be performed. It is also possible to send an image to the projector 
and register it as the background logo. Once the image is registered, it can be 
locked to prevent the logo from being overwritten.

PC Control Utility Pro 4
PC Control Utility Pro 5 (for Mac 
OS)

This is a software program used to operate the projector from the computer 
when the computer and the projector are connected with LAN. (→ page 133)
•	 PC Control Utility Pro 4 can be used with a serial connection.

NOTE:
•	 To connect the projector to the network by using the Virtual Remote Tool, PC Control Utility Pro 4, PC Control Utility Pro 5, please 

configure the settings of [SETUP] → [NETWORK SETTINGS] in the on-screen menu (→ page 107).

Download service
For the update information about these software programs, visit our website:
URL: http://www.nec-display.com/dl/en/index.html

Operating Environment

[Windows]

Supported OS Windows 8.1, Windows 8.1 Pro, Windows 8.1 Enterprise, Windows 8, Windows 
8 Pro, Windows 8 Enterprise
Windows 7 Home Basic, Windows 7 Home Premium, Windows 7 Professional, 
Windows 7 Ultimate, Windows 7 Enterprise
Windows Vista Home Basic, Windows Vista Home Premium, Windows Vista 
Business, Windows Vista Ultimate, Windows Vista Enterprise
Windows XP Home Edition (32-bit version) Service Pack 3 or later
Windows XP Professional (32-bit version) Service Pack 3 or later

[Mac]

Supported OS Mac OS X v10.6, v10.7, v10.8, v10.9

http://www.nec-display.com/dl/en/index.html
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❷ Installing Software Program

Installation for Windows software

The software programs except PC Control Utility Pro 5 support Windows 8.1, Windows 8, Windows 7, Windows Vista, 
and Windows XP.

NOTE:
•	 To install or uninstall each software program, the Windows user account must have “Administrator” privilege (Windows 8.1, 

Windows 8, Windows 7, Windows Vista) or “Computer Administrator” privilege (Windows XP).
•	 Exit all running programs before installation. If another program is running, the installation may not be completed.
•	 To run Virtual Remote Tool or PC Control Utility Pro 4 on Windows 8.1, Windows 8, Windows XP Home Edition, and Windows 

XP Professional, “Microsoft .NET Framework Version 2.0” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is 
available from Microsoft’s web page. Download and install it on your computer.

 
1	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 The menu window will be displayed.
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2	 Click a software program you wish to install on the menu window.

	 The installation will start.

•	 Follow the instructions on the installer screens to complete the installation.

TIP:

Uninstalling a Software Program
Preparation:
Exit the software program before uninstalling. To uninstall the software program, the Windows user account must 
have “Administrator” privilege (Windows 8.1, Windows 8, Windows 7, and Windows Vista) or “Computer Administra-
tor” privilege (Windows XP).

• For Windows 8.1/Windows 8/Windows 7/Windows Vista
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Click “Uninstall a program” under “Programs”

	 The “Programs and Features” window will be displayed.

3	 Select the software program and click it.

4	 Click “Uninstall/Change” or “Uninstall”.

	 • When the “User Account Control” windows is displayed, click “Continue”.

	 Follow the instructions on the screens to complete the uninstallation.

• For Windows XP
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Double-click “Add / Remove Programs”.

	 The Add / Remove Programs window will be displayed.

3	 Click the software program from the list and then click “Remove”.

	 Follow the instructions on the screens to complete the uninstallation.
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Using on Mac OS

Step 1: Install PC Control Utility Pro 5 on the computer.

1.	 Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive. 

	 The CD-ROM icon will be displayed on the desktop.

2.	 Double-click the CD-ROM icon. 

	 The CD-ROM window will be displayed.

3.	 Double-click the “Mac OS X” folder.

4.	 Double-click “PC Control Utility Pro 5.pkg”. 

	 The installer will start.

5.	 Click “Next”. 

	 “END USER LICENSE AGREEMENT” screen will be displayed.

6.	 Read “END USER LICENSE AGREEMENT” and click “Next”. 

	 The confirmation window will be displayed

7.	 Click “I accept the terms in the license agreement”. 

	 Follow the instructions on the installer screens to complete the installation.

TIP:

• Uninstalling a software program
1.	 Put the “PC Control Utility Pro 5” folder to the Trash icon.

2.	 Put the configuration file of PC Control Utility Pro 5 to the Trash icon.

•	 The configuration file of PC Control Utility Pro 5 is located in “/Users/<your user name>/Application Data/NEC 
Projector User Supportware/PC Control Utility Pro 5”.
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❸ Operating the Projector Via the LAN (Virtual Remote Tool)
This will help you perform operations such as projector’s power on or off and signal selection via a LAN connection. It 
is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you 
can lock the logo to prevent it from changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, Logo transfer to the projector, and remote 
control operation on your PC.

Virtual Remote screen

Remote Control Window Toolbar

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 148)

NOTE:
•	 Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:
	 (Only via serial or LAN connection)

*	 File size: Within 256 kilobytes
*	 Image size: Within the resolution of the projector
*	 File format: PNG (Full color)

•	 Logo data (image) sent using the Virtual Remote Tool will be displayed in the center with the surrounding area in black.
•	 To put the default “NEC logo” back in the background logo, you need to register it as the background logo by using the image file 

(PX602UL-WH/PX602UL-BK: \Logo\NEC_logo2011_WUXGA.png, PX602WL-WH/PX602WL-BK: \Logo\NEC_logo2011_1280x800.
png) included on the supplied NEC Projector CD-ROM.
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Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 133) and “10. 
Controlling the Projector by Using an HTTP Browser” (→ page 42)

Start Virtual Remote Tool

Start using the shortcut icon
•	 Double-click the shortcut icon  on the Windows Desktop.

Start from the Start menu
•	 Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] 

→ [Virtual Remote Tool].

	 When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

	 The “Easy Setup” feature is not available on this model. Click “Close Easy Setup”.

	 Closing the “Easy Setup” window will display the “Projector List” window.

	 Select your projector you wish to connect. This will display the Virtual Remote screen.

NOTE:
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via network connection.

TIP:
•	 The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window.
	 To do so, click to place a check mark for “  Do not use Easy Setup next time” on the screen.
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Exiting Virtual Remote Tool
1	 Click the Virtual Remote Tool icon  on the Taskbar.

	 The pop-up menu will be displayed.

2	 Click “Exit”.

	 The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool
• Displaying the help file using the taskbar
1	 Click the Virtual Remote Tool icon  on the taskbar when Virtual Remote Tool is running.

	 The pop-up menu will be displayed.

2.	 Click “Help”.

	 The Help screen will be displayed.

• Displaying the help file using the Start Menu.
1.	 Click “Start”. “All programs” or “Programs”. “NEC Projector User Supportware”. “Virtual Remote Tool”. and 

then “Virtual Remote Tool Help” in this order.

	 The Help screen will be displayed.
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❹ Controlling the Projector over a LAN (PC Control Utility Pro 4/
Pro 5)
Using the utility software “PC Control Utility Pro 4” or “PC Control Utility Pro 5” included on the companion NEC Pro-
jector CD-ROM, the projector can be controlled from a computer over a LAN.
PC Control Utility Pro 4 is a program compatible with Windows. (→ this page)
PC Control Utility Pro 5 is a program compatible with Mac OS. (→ page 152)

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, event 
schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4/Pro 5. For information on how to use 
PC Control Utility Pro 4/Pro 5, see Help of PC Control Utility Pro 4/Pro 5. (→ page 151, 152)

Step 1: Install PC Control Utility Pro 4/Pro 5 on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start PC Control Utility Pro 4/Pro 5.

TIP:
•	 PC Control Utility Pro 4 can be used with a serial connection.

Using on Windows

Step 1: Install PC Control Utility Pro 4 on the computer

NOTE:
•	 To install or uninstall the program, the Windows user account must have [Administrator] privilege (Windows 8.1, Windows 8, 

Windows 7, Windows Vista and Windows XP)
•	 Exit all running programs before installation. If another program is running, the installation may not be completed.

1	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.
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TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 the menu window will be displayed.

2	 Click “PC Control Utility Pro 4” on the menu window.

	 The installation will start.

	 When the installation is complete, the Welcome window will be displayed.

3	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

	 Read “END USER LICENSE AGREEMENT” carefully.

4	 If you agree, click “I accept the terms in the license agreement” and then click “Next”.

•	 Follow the instructions on the installer screens to complete the installation.

•	 When the installation is complete, you will return to the menu window.

TIP:
• Uninstalling PC Control Utility Pro 4
To uninstall PC Control Utility Pro 4, do the same procedures stated as in “Uninstalling a Software Program”. (→ page 144, 145)
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Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 133) and “10. 
Controlling the Projector by Using an HTTP Browser” (→ page 42)

Step 3: Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4”.

NOTE: 
•	 For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/

sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the 
scheduler.

[Example] For Windows 7:
Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer 
to sleep” → “Never”. 
NOTE: 
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN) 

connection.

TIP:

Viewing the Help of PC Control Utility Pro 4
•	 Displaying the Help file of PC Control Utility Pro 4 while it is running.

	 Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.

	 The pop-up menu will be displayed.

•	 Displaying the help file using the Start Menu.

	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4 Help”.

	 The Help screen will be displayed.
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Using on Mac OS

Step 1: Install PC Control Utility Pro 5 on the computer
1.	 Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.

	 The CD-ROM icon will be displayed on the desktop.

2.	 Double-click the CD-ROM icon.

	 The CD-ROM window will be displayed.

3.	 Double-click the “Mac OS X” folder.

4.	 Double-click “PC Control Utility Pro 5.pkg”.

	 The installer will start.

5.	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

6.	 Read “END USER LICENSE AGREEMENT” and click “Next”.

	 The confirmation window will be displayed

7.	 Click “I accept the terms in the license agreement”.

	 Follow the instructions on the installer screens to complete the installation.

Step 2: Connect the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 133) and “10. 
Controlling the Projector by Using an HTTP Browser” (→ page 42)

Step 3: Start PC Control Utility Pro 5
1.	 Open your Applications folder in Mac OS.

2.	 Click the “PC Control Utility Pro 5” folder.

3.	 Click the “PC Control Utility Pro 5” icon.

	 PC Control Utility Pro 5 will start.

NOTE: 
•	 For the Schedule function of the PC Control utility Pro 5 to work, you must have your computer running and not in sleep mode. 

Select “Energy Saver” from the “System Preferences” in Mac and disable its sleep mode before running the scheduler.
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN) 

connection.
 
TIP:

Viewing the Help of PC Control Utility Pro 5
• Displaying the Help file of PC Control Utility Pro 5 while it is running. 
•	 From the menu bar, click “Help” → “Help” in this order. 

	 The Help screen will be displayed.

• Displaying the Help using the Dock 
1.	 Open “Application Folder” in Mac OS.

2.	 Click the “PC Control Utility Pro 5” folder.

3.	 Click the “PC Control Utility Pro 5 Help” icon.

	 The Help screen will be displayed.
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❶ Throw distance and screen size
This projector can be used with 3 kinds of optional lenses (sold separately). The chart below shows compatible lenses 
according to the projector model. Refer to the information on this page and use a lens suited for the installation envi-
ronment (screen size and throw distance). For instructions on mounting the lens, see page 121.

Lens (model)

Projector (model name) NP34ZL NP35ZL NP36ZL NP37ZL

PX602UL-WH/PX602UL-BK Yes Yes No Yes

PX602WL-WH/PX602WL-BK Yes Yes Yes Yes

Yes = can be used, No = cannot be used

Lens types and throw distance
PX602UL-WH/PX602UL-BK

Screen size Lens model name
NP34ZL NP35ZL NP37ZL

inch m inch m inch m
50" 40 - 51 1.0 - 1.3 51 - 64 1.3 - 1.7 63 - 123 1.6 - 3.2
60" 48 - 62 1.2 - 1.6 62 - 77 1.6 - 2.0 76 - 148 2.0 - 3.8
80" 64 - 83 1.7 - 2.1 83 - 104 2.1 - 2.7 103 - 198 2.6 - 5.1
100" 81 - 104 2.1 - 2.6 104 - 130 2.7 - 3.3 129 - 248 3.3 - 6.3
120" 97 - 125 2.5 - 3.2 124 - 156 3.2 - 4.0 155 - 298 4.0 - 7.6
150" 122 - 157 3.1 - 4.0 156 - 195 4.0 - 5.0 194 - 373 4.9 - 9.5
200" 163 - 209 4.1 - 5.3 208 - 261 5.3 - 6.6 260 - 498 6.6 - 12.7
240" 195 - 251 5.0 - 6.4 250 - 313 6.4 - 8.0 312 - 598 7.9 - 15.2
300" 244 - 314 6.2 - 7.9 313 - 392 7.9 - 10.0 391 - 748 9.9 - 19.0

TIP
Calculation of the throw distance from the screen size
NP34ZL lens throw distance (inch/m) = H × 0.96 to H × 1.23 : 40"/1.0 m (min.) to 314"/7.9 m (max.)
NP35ZL lens throw distance (inch/m) = H × 1.23 to H × 1.54 : 51"/1.3 m (min.) to 392"/10.0 m (max.) 
NP37ZL lens throw distance (inch/m) = H × 1.53 to H × 2.94 : 63"/1.6 m (min.) to 748"/19.0 m (max.) 
“H” (Horizontal) refers to the screen width.
* Figures differ by several % with the table above because the calculation is approximate.
Ex.: Throw distance when projecting on a 150" screen with the PX602UL-WH/PX602UL-BK using the NP35ZL lens:
According to the “Screen Size (for reference)” table (→ page 155), H (screen width) = 127.2"/323.1 cm.
The throw distance is 127.2"/323.1 cm × 1.23 to 127.2"/323.1 cm × 1.54 = 156.5"/397.4 cm to 195.9"/497.6 cm (because of the 
zoom lens).
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PX602WL-WH/PX602WL-BK

Screen size Lens model name
NP34ZL NP35ZL/NP36ZL NP37ZL

inch m inch m inch m
50" 42 - 54 1.1 - 1.4 54 - 68 1.4 - 1.7 67 - 129 1.7 - 3.3
60" 51 - 65 1.3 - 1.7 65 - 81 1.7 - 2.1 80 - 155 2.1 - 4.0
80" 68 - 87 1.7 - 2.2 87 - 109 2.2 - 2.8 108 - 208 2.8 - 5.3
100" 85 - 109 2.2 - 2.8 109 - 136 2.8 - 3.5 135 - 260 3.5 - 6.6
120" 102 - 131 2.6 - 3.3 131 - 164 3.3 - 4.2 163 - 313 4.2 - 8.0
150" 128 - 164 3.3 - 4.2 164 - 205 4.2 - 5.2 204 - 392 5.2 - 10.0
200" 171 - 219 4.4 - 5.6 219 - 274 5.6 - 6.9 273 - 523 6.9 - 13.3
240" 206 - 263 5.2 - 6.7 263 - 329 6.7 - 8.3 328 - 628 8.3 - 15.9
300" 257 - 330 6.5 - 8.3 330 - 411 8.3 - 10.4 411 - 786 10.4 - 19.9

TIP
Calculation of the throw distance from the screen size
NP34ZL lens throw distance (inch/m) = H × 1.01 to H × 1.29 : 42"/1.1 m (min.) to 330"/8.3 m (max.)
NP35ZL/NP36ZL lens throw distance (inch/m) = H × 1.29 to H × 1.61 : 54"/1.4 m (min.) to 411"/10.4 m (max.) 
NP37ZL lens throw distance (inch/m) = H × 1.61 to H × 3.08 : 67"/1.7 m (min.) to 786"/19.9 m (max.) 
“H” (Horizontal) refers to the screen width.
* Figures differ by several % with the table above because the calculation is approximate.
Ex.: Throw distance when projecting on a 150" screen with the PX602WL-WH/PX602WL-BK using the NP36ZL lens:
According to the “Screen Size (for reference)” table (→ page 155), H (screen width) = 127.2"/323.1 cm.
The throw distance is 127.2"/323.1 cm × 1.29 to 127.2"/323.1 cm × 1.61 = 164.1"/416.8 cm to 204.8"/520.2 cm (because of the 
zoom lens).
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Projection range for the different lenses

50-300"

50-300"
50-300"

50-300"

NP34ZL
PX602UL-WH/PX602UL-BK: 40–314"/1.0–7.9 m
PX602WL-WH/PX602WL-BK: 42–330"/1.1–8.3 m

NP36ZL PX602WL-WH/PX602WL-BK: 54–411"/1.4–10.4 m

PX602UL-WH/PX602UL-BK: 63–748"/1.6–19.0 m
PX602WL-WH/PX602WL-BK: 67–786"/1.7–19.9 mNP37ZL

PX602UL-WH/PX602UL-BK: 51–392"/1.3–10.0 m
PX602WL-WH/PX602WL-BK: 54–411"/1.4–10.4 mNP35ZL

Tables of screen sizes and dimensions

Screen height

Screen width

16:10 screen size 	
(diagonal)

Size (inches) Screen width Screen height
(inches) (cm) (inches) (cm)

50 42.4 107.7 26.5 63.7
60 50.9 129.2 31.8 80.8
80 67.8 172.3 42.4 107.7

100 84.8 215.4 53.0 134.6
120 101.8 258.5 63.6 161.5
150 127.2 323.1 79.5 201.9
200 169.6 430.8 106.0 269.2
240 203.5 516.9 127.2 323.1
300 254.4 646.2 159.0 403.9
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Lens shifting range
This projector is equipped with a lens shift function for adjusting the position of the projected image by using the LENS 
SHIFT buttons (→ page 19). The lens can be shifted within the range shown below.

NOTE: 
•	 Please do not use the lens shift function when projecting portrait images. Please use it with the lens in the center.

Legend: V “Vertical” refers to the screen height and H “Horizontal” refers to the screen width. The lens shift range is 
expressed as a ratio of height and width, respectively.

100%V

50%V

50%V
20%V* 20%V*

20%V*20%V*

100%H

15%H

15%H

15%H

15%H

10%H

10%H 10%H

10%H

Height of projected image

Width of projected image

Value of X

PX602UL-WH/PX602UL-BK 20%V

PX602WL-WH/PX602WL-BK 30%V

*	 The lens shift range is the same for ceiling installation.

(Example) When using to project on a 150" screen
According to the “Table of screen sizes and dimensions” (→ page 155), H = 127.2"/323.1 cm, V = 79.5"/201.9 cm.
Adjustment range in the vertical direction: the projected image can be moved upwards 0.5 × 79.5"/201.9 cm ≈ 
39.8"/101 cm, downwards approximately 39.8"/101 cm (when the lens is at the center position). Adjustment range in 
the horizontal direction: the projected image can be moved to the left 0.15 × 127.2"/323.1 cm ≈ 19.1"/48 cm, to the 
right approximately 19.1"/48 cm.
*	 Figures differ by several % because the calculation is approximate.
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❷ Mounting the Optional Board (sold separately)
CAUTION
Before mounting or removing the optional board, be sure to turn off the projector, wait for the fans to stop and turn 
off the main power switch.

Tool needed: Phillips screwdriver (plus-head)

1.	 Turn off the main power switch of the projector.

2.	 Loosen the two screws on the SLOT cover of the terminals.

	 Remove the two screws and the SLOT cover.

NOTE: Keep the two screws and the slot cover.

3.	 Insert the optional board into the slot.

	 Make sure that the board is inserted into the slot in the correct orientation.

	 Incorrect orientation may cause miscommunication between the optional board and projector.
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4.	 Tighten the two screws on both sides of the slot.

•	 Be sure to tighten the screws.

	 This will complete installation of the optional board.

	 To select the optional board source, select SLOT as the input.

NOTE:
•	 Mounting the optional board may cause the fans to run in the standby mode for the purpose of cooling depending on the optional 

board. The fan speed may also increase in order to cool the projector properly. Both of these instances are considered normal 
and not a malfunction of the projector.
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❸ Compatible Input Signal List
Analog Computer Signal

Signal Resolution ( dots ) Aspect Ratio Refresh Rate ( Hz )
VGA 640 × 480 4 : 3 60/72/75/85/iMac
SVGA 800 × 600 4 : 3 56/60/72/75/85/iMac
XGA 1024 × 768 4 : 3 60/70/75/85/iMac
XGA+ 1152 × 864 4 : 3 60/70/75/85

WXGA

1280 × 768 *1 15 : 9 60
1280 × 800 *1 16 : 10 60
1360 × 768 *2 16 : 9 60
1366 × 768 *2 16 : 9 60

Quad-VGA 1280 × 960 4 : 3 60/75/85
SXGA 1280 × 1024 5 : 4 60/75/85
SXGA+ 1400 × 1050 4 : 3 60/75
WXGA+ 1440 × 900 16 : 10 60
WXGA++ 1600 × 900 16 : 9 60
UXGA 1600 × 1200 *3 4 : 3 60/65/70/75
WSXGA+ 1680 × 1050 16 : 10 60
WUXGA 1920 × 1200 *3 16 : 10 60 (Reduced Blanking)
2K 2048 × 1080 17 : 9 60
Full HD 1920 × 1080 *3 16 : 9 60
MAC 13" 640 × 480 4 : 3 67
MAC 16" 832 × 624 4 : 3 75
MAC 19" 1024 × 768 4 : 3 75
MAC 21" 1152 × 870 *4 4 : 3 75
MAC 23" 1280 × 1024 5 : 4 65

Component
Signal Resolution ( dots ) Aspect Ratio Refresh Rate ( Hz )

HDTV (1080p) 1920 × 1080 16 : 9 50/60
HDTV (1080i) 1920 × 1080 16 : 9 50/60
HDTV (720p) 1280 × 720 16 : 9 50/60
SDTV (480p) 720 × 480 4:3 / 16:9 60
SDTV (576p) 720 × 576 4:3 / 16:9 50
SDTV (480i) 720 × 480 4:3 / 16:9 60
SDTV (576i) 720 × 576 4:3 / 16:9 50

Composite Video/S-Video
Signal Aspect Ratio Refresh Rate ( Hz )

NTSC 4 : 3 60
PAL 4 : 3 50
PAL60 4 : 3 60
SECAM 4 : 3 50
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HDMI
Signal Resolution ( dots ) Aspect Ratio Refresh Rate ( Hz )

VGA 640 × 480 4 : 3 60
SVGA 800 × 600 4 : 3 60
XGA 1024 × 768 4 : 3 60
HD 1280 × 720 *1 16 : 9 60

WXGA
1280 × 768 *1 15 : 9 60
1280 × 800 *1 16 : 10 60
1366 × 768 *2 16 : 9 60

Quad-VGA 1280 × 960 4 : 3 60
SXGA 1280 × 1024 5 : 4 60
SXGA+ 1400 × 1050 4 : 3 60
WXGA+ 1440 × 900 16 : 10 60
WXGA++ 1600 × 900 16 : 9 60
WSXGA+ 1680 × 1050 16 : 10 60
UXGA 1600 × 1200 *3 4 : 3 60
Full HD 1920 × 1080 *3 16 : 9 60
WUXGA 1920 × 1200 *3 16 : 10 60 (Reduced Blanking)
2K 2048 × 1080 17 : 9 60
WQHD  
iMac 27"

2560 × 1440 16 : 9 60

WQXGA 2560 × 1600 16 : 10 60 (Reduced Blanking)

4K
3840 × 2160 16 : 9 23.98/24/25/29.97/30
4096 × 2160 17 : 9 24

HDTV(1080p) 1920 × 1080 16 : 9 50/60
HDTV(1080i) 1920 × 1080 16 : 9 50/60
HDTV (720p) 1280 × 720 16 : 9 50/60
SDTV (480i/p) 720/1440 × 480 4:3 / 16:9 60
SDTV (576i/p) 720/1440 × 576 4:3 / 16:9 50

HDMI 3D
Signal Resolution ( dots ) Refresh Rate ( Hz ) Aspect Ratio 3D Format

1920 × 1080p

23.98/24

16 : 9

Frame Packing
Side By Side
Top and Bottom

25
Side By Side
Top and Bottom

50
Side By Side
Top and Bottom

59.94/60
Side By Side
Top and Bottom

1920 × 1080i
50

Top and Bottom
Side By Side

59.94/60
Top and Bottom
Side By Side

1280 × 720p

50
Frame Packing
Side By Side
Top and Bottom

59.94/60
Frame Packing
Side By Side
Top and Bottom
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DisplayPort
Signal Resolution ( dots ) Aspect Ratio Refresh Rate ( Hz )

VGA 640 × 480 4 : 3 60
SVGA 800 × 600 4 : 3 60
XGA 1024 × 768 4 : 3 60
HD 1280 × 720 *1 16 : 9 60

WXGA
1280 × 768 *1 15 : 9 60
1280 × 800 *1 16 : 10 60
1366 × 768 *2 16 : 9 60

Quad-VGA 1280 × 960 4 : 3 60
SXGA 1280 × 1024 5 : 4 60
SXGA+ 1400 × 1050 4 : 3 60
WXGA+ 1440 × 900 16 : 10 60
WXGA++ 1600 × 900 16 : 9 60
WSXGA+ 1680 × 1050 16 : 10 60
UXGA 1600 × 1200 *3 4 : 3 60
Full HD 1920 × 1080 *3 16 : 9 60
WUXGA 1920 × 1200 *3 16 : 10 60 (Reduced Blanking)
2K 2048 × 1080 17 : 9 60
WQHD  
iMac 27"

2560 × 1440 16 : 9 60

WQXGA 2560 × 1600 16 : 10 60 (Reduced Blanking)

4K
3840 × 2160 16 : 9 23.98/24/25/29.97/30
4096 × 2160 17 : 9 24

HDTV(1080p) 1920 × 1080 16 : 9 50/60
HDTV (1080i) 1920 × 1080 16 : 9 50/60
HDTV (720p) 1280 × 720 16 : 9 50/60
SDTV (480i/p) 720/1440 × 480 4:3 / 16:9 60
SDTV (576i/p) 720/1440 × 576 4:3 / 16:9 50

DisplayPort 3D
Signal Resolution ( dots ) Refresh Rate ( Hz ) Aspect Ratio 3D Format

1920 × 1080p

23.98/24

16 : 9

Side By Side
Top and Bottom

25
Side By Side
Top and Bottom

50
Side By Side
Top and Bottom

59.94/60
Side By Side
Top and Bottom

100 Frame Sequential
120 Frame Sequential

1920 × 1080i
50

Top and Bottom
Side By Side

59.94/60
Top and Bottom
Side By Side

1280 × 720p

50
Side By Side
Top and Bottom

100 Frame Sequential

59.94/60
Frame Packing
Side By Side
Top and Bottom

120 Frame Sequential

*1	 Native resolution on WXGA model (PX602WL-WH/PX602WL-BK)
*2	 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu.
	 The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [16:9] for [ASPECT RATIO].
*3	 Native resolution on WUXGA model (PX602UL-WH/PX602UL-BK)
*4	 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu.
	 The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [4:3] for [ASPECT RATIO].

•	 Signals exceeding the projector’s resolution are handled with Advanced AccuBlend.
•	 With Advanced AccuBlend, the size of characters and ruled lines may be uneven and colors may be blurred.
•	 Upon shipment, the projector is set for signals with standard display resolutions and frequencies, but adjustments may be required 
depending on the type of computer.
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❹ Specifications
Model name PX602UL-WH/PX602UL-BK/PX602WL-WH/PX602WL-BK
Method Single DLP® chip
Specifications of main parts

DMD panel Size PX602UL-WH/PX602UL-BK: 0.67" (aspect ratio: 16:10)
PX602WL-WH/PX602WL-BK: 0.65" (aspect ratio: 16:10)

Pixels (*1) PX602UL-WH/PX602UL-BK: 2,304,000 (1920 dots × 1200 lines)
PX602WL-WH/PX602WL-BK: 1,024,000 (1280 dots × 800 lines)

Projection lenses Zoom Manual (zoom range depends on lens)
Focus Manual
Lens shifting Manual

Light source 3.5W Laser Diode
Optical device Optical isolation by dichroic mirror, combining by dichroic prism

Light output (*2) (*3) 6,000 lm
Contrast ratio (*2) (all white/all black) 10,000:1 with dynamic contrast
Screen size (throw distance) 50" to 300" (throw distance depends on lens)
Color reproducibility 10-bit color processing (approx. 1.07 billion colors) (*4)

Scanning frequency Horizontal Analog: 15 kHz, 24 to 100 kHz (24 kHz or greater for RGB inputs), conforming to 
VESA standards
Digital: 15 kHz, 24 to 153 kHz, conforming to VESA standards

Vertical Analog: 48 Hz, 50 to 85 Hz, 100, 120 Hz conforming to VESA standards
Digital: 24, 25, 30, 48 Hz, 50 to 85 Hz, 100, 120 Hz conforming to VESA standards

Main adjustment functions Power zoom, power focus, power lens shift, input signal switching (HDMI/DisplayPort/
BNC/BNC(CV)/BNC(Y/C)/COMPUTER/HDBaseT/SLOT), auto image adjustment, pic-
ture maginification, muting (video), power on/standby, on-screen display/selection, etc.

Max. display resolution (horizontal × 
vertical)

Analog: 1920 × 1200 (handled with Advanced AccuBlend)
Digital: 4096 × 2160 (handled with Advanced AccuBlend)

Input signals
R,G,B,H,V RGB: 0.7Vp-p/75Ω

Y: 1.0Vp-p/75Ω (with Negative Polarity Sync)
Cb, Cr (Pb, Pr): 0.7Vp-p/75Ω
H/V Sync: 4.0Vp-p/TTL
Composite Sync: 4.0Vp-p/TTL
Sync on G: 1.0Vp-p/75Ω (with Sync)

Composite video 1.0Vp-p/75Ω
S-Video Y: 1.0Vp-p/75Ω

C: 286Vp-p/75Ω
Component Y: 1.0Vp-p/75Ω (with Sync)

Cb, Cr (Pb, Pr): 0.7Vp-p/75Ω
DTV: �480i, 480p, 720p, 1080i, 1080p (60Hz) 

576i, 576p, 720p, 1080i, 1080p (50Hz)
DVD: Progressive signal (50/60Hz)

Input/output terminals
Computer/Com-
ponent

Video input Mini D-Sub 15-pin × 1, BNC terminal × 5

HDMI Video input HDMI® Terminal type A × 1
Deep Color (color depth): 8-/10-/12-bit compatible
Colorimetry: RGB, YcbCr444 and YcbCr422 compatible
LipSync compatible, HDCP compatible (*5), Supports 4K and 3D

Video output Repeater
Audio input HDMI: Sampling frequency – 32/44.1/48 kHz, Sampling bits – 16/20/24 bits

HDBaseT Video input Deep Color (color depth): Support 8/10/12 bits
Colorimetry: Support RGB, YCbCr444 and YCbCr422 
Support LipSync , HDCP (*5), 4K , 3D 

Audio input Sampling frequency: 32/44.1/48 kHz
Sampling bit: 16/20/24 bit

DisplayPort Video input DisplayPort × 1
Data rate: 2.7Gbps/1.62Gbps
No. lanes: 1 lane/2 lanes/4 lanes
Color depth: 6-bit, 8-bit, 10-bit
Colorimetry: RGB, YcbCr444 and YcbCr422 compatible
HDCP compatible (*5)

Audio input DisplayPort: Sampling frequency – 32/44.1/48 kHz, Sampling bits – 16/20/24 bits
BNC (CV) Video input BNC × 1
BNC (Y/C) Video input BNC × 2
PC control terminal D-Sub 9-pin × 1
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Model name PX602UL-WH/PX602UL-BK/PX602WL-WH/PX602WL-BK
USB port USB type A × 1
Ethernet/HDBaseT port RJ-45 × 1, Supports BASE-TX
Remote terminal Stereo mini jack × 1
3D SYNC output terminal 5 V / 10 mA, synchronized signal output for 3D use

Usage environment Operating temperature: 5 to 40°C (*6)

Operating humidity: 20 to 80% (with no condensation)
Storage temperature: -10 to 60°C (*6)

Storage humidity: 20 to 80% (with no condensation)
Operating altitude: 0 to 3000 m/10,000 feet 
(760 to 3000 m/2500 to 10,000 feet: Set [FAN MODE] to [HIGH])

Power supply 100-240 V AC, 50/60Hz
Power con-
sumption

LIGHT 
MODE

NORMAL 560 W (100-130 V)/530 W (200-240 V)
ECO1 440 W (100-130 V)/420 W (200-240 V)
ECO2 280 W (100-130 V)/270 W (200-240 V)

STAND-
BY 
MODE

NORMAL 0.5 W
NETWORK 
STANDBY

6.0 W

Rated input current 6.8 A-2.5 A
External dimensions 19.1" (width) × 7.7" (height) × 20.0" (depth)/484.4 (width) × 195.0 (height) × 509.0 

(depth) mm (not including the lens hood and protruding parts)
19.1" (width) × 8.5" (height) × 22.6" (depth)/484.4 (width) × 217.0 (height) × 574.8 
(depth) mm (including the lens hood and protruding parts)

Weight 40.3 lbs/18.3 kg (not including lens)

*1	 Effective pixels are more than 99.99%. 
*2	 This is the light output value that results from setting the [LIGHT MODE] to [NORMAL] and setting the [PRESET] to [HIGH-BRIGHT] 
while using the NP35ZL lens for NP-PX602UL-WHJD, or NP36ZL lens for NP-PX602WL-WHJD (sold separately).

	 The light output value is lower when setting the [LIGHT MODE] to [ECO1] or [ECO2]. ([ECO1]: about 80%, [ECO2]: about 50%). 
If any other mode is selected as the [PRESET] mode, the light output value may drop slightly.

*3	 Compliance with ISO21118-2005 
*4	 Full color (approx. 16.77 million colors or greater) when the HDBaseT input terminal is selected.
*5	 HDMI® (Deep Color, Lip Sync) with HDCP 
	 What is HDCP/HDCP technology? 
	 HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system 
for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI). 

	 If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With 
the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed 
due to the decision/intention of the HDCP community (Digital Content Protection, LLC). 

	 Video: Deep Color; 8/10/12-bit, LipSync 
	 Audio: LPCM; up to 2 ch, sample rate 32/44.1/48 KHz, sample bit; 16/20/24-bit
*6	 The upper threshold of operating temperature is changed depends on the altitude.
	 0–760 m (0–2500 feet): 5–40°C
	 760–1500 m (2500–5000 feet): 5–35°C
	 1500–3000 m (5000–10000 feet): 5–30°C
	 35 to 40°C – “Forced eco mode”
•	 These specifications and the product’s design are subject to change without notice.

For additional information visit:
US: http://www.necdisplay.com/
Europe: http://www.nec-display-solutions.com/
Global: http://www.nec-display.com/global/index.html
For information on our optional accessories, visit our website or see our brochure.

http://www.necdisplay.com/
http://www.nec-display-solutions.com/
http://www.nec-display.com/global/index.html
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Option lens (sold separately)
Option lens for PX602UL-WH/PX602UL-BK
NP34ZL Power lens shift, Power zoom, Power focus

(Throw ratio 0.96–1.23:1, F 2.3–2.57, f = 0.55–0.71"/14.03–17.95 mm)
NP35ZL Power lens shift, Power zoom, Power focus

(Throw ratio 1.23–1.54:1, F 2.0–2.32, f = 0.71–0.89"/18.07–22.59 mm)
NP37ZL Power lens shift, Power zoom, Power focus

(Throw ratio 1.53–2.94:1, F 2.3–3.39, f = 0.89–1.69"/22.56–42.87 mm)

Option lens for PX602WL-WH/PX602WL-BK
NP34ZL Power lens shift, Power zoom, Power focus

(Throw ratio 1.01–1.29:1, F 2.3–2.57, f = 0.55–0.71"/14.03–17.95 mm)
NP35ZL Power lens shift, Power zoom, Power focus

(Throw ratio 1.29–1.61:1, F 2.0–2.32, f = 0.71–0.89"/18.07–22.59 mm)
NP36ZL Power lens shift, Power zoom, Power focus

(Throw ratio 1.29–1.61:1, F 2.0–2.32, f = 0.71–0.89"/18.07–22.59 mm)
NP37ZL Power lens shift, Power zoom, Power focus

(Throw ratio 1.61–3.08:1, F 2.3–3.39, f = 0.89–1.69"/22.56–42.87 mm)
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❺ Cabinet Dimensions

Unit: mm (inch)
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150 (5.9)
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300 (11.8) Lens center

Lens center

6-M4×L8 (Max) for Ceiling Mount*

*	 The screws specifications for Ceiling Mount:
	 Screw type: M4
	 Maximum screw length: 8 mm (0.31")
	 Minimum screw length: 6 mm (0.24")

 CAUTION:
Do not attempt to mount the projector on a ceiling yourself.
The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of 
bodily injury.
In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 
with any local building codes. Please consult your dealer for more information.
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❻ Pin assignments and signal names of main terminals
COMPUTER 1 IN/ Component Input Terminal (Mini D-Sub 15 Pin) 

Connection and signal level of each pin

51 42 3
10

11 12 13 14 15
6 97 8

Signal Level
Video signal : 0.7Vp-p (Analog)
Sync signal : TTL level

Pin No. RGB Signal (Analog) YCbCr Signal
1 Red Cr
2 Green or Sync on Green Y
3 Blue Cb
4 Ground
5 Ground
6 Red Ground Cr Ground
7 Green Ground Y Ground
8 Blue Ground Cb Ground
9 No Connection
10 Sync Signal Ground
11 No Connection
12 Bi-directional DATA (SDA)
13 Horizontal Sync or Composite Sync
14 Vertical Sync
15 Data Clock

HDMI IN Terminal (Type A) 

1 3 5 7 9 11 13 15 17 19
2 4 6 8 10 12 14 16 18

Pin No. Signal Pin No. Signal
1 TMDS Data 2+ 11 TMDS Clock Shield
2 TMDS Data 2 Shield 12 TMDS Clock−
3 TMDS Data 2− 13 CEC
4 TMDS Data 1+ 14 Disconnection
5 TMDS Data 1 Shield 15 SCL
6 TMDS Data 1− 16 SDA
7 TMDS Data 0+ 17 DDC/CEC grounding
8 TMDS Data 0 Shield 18 +5 V power supply
9 TMDS Data 0− 19 Hot plug detection
10 TMDS Clock +

DisplayPort IN Terminal

1 3 5 7 9 11 13 15 17 19
2 4 6 8 10 12 14 16 18 20

Pin No. Signal Pin No. Signal
1 Main link lane 3− 11 Grounding 0
2 Grounding 3 12 Main link lane 0+
3 Main link lane 3+ 13 Configuration 1
4 Main link lane 2− 14 Configuration 2
5 Grounding 2 15 Supplementary channel +
6 Main link lane 2+ 16 Grounding 4
7 Main link lane 1− 17 Supplementary channel −
8 Grounding 1 18 Hot plug detection
9 Main link lane 1+ 19 Return

10 Main link lane 0− 20 +3.3 V power supply
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Ethernet/HDBaseT Port (RJ-45) 

1 2 3 4 5 6 7 8

Pin No. Signal
1 TxD+/HDBT0+
2 TxD−/HDBT0−
3 RxD+/HDBT1+
4 Disconnection/HDBT2+
5 Disconnection/HDBT2−
6 RxD−/HDBT1−
7 Disconnection/HDBT3+
8 Disconnection/HDBT3−

USB Port (Type A) 

1

3

2

4

Pin No. Signal
1 VBUS
2 D−
3 D+
4 Grounding

PC CONTROL Port (D-Sub 9 Pin) 

12345

6789

Communications protocol

Pin No. Signal
1 Unused
2 RxD  reception data
3 TxD  transmission data 
4 Unused
5 Grounding
6 Unused
7 RTS  transmission request
8 CTS  transmission allowed
9 Unused
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❼ Troubleshooting
This section helps you resolve problems you may encounter while setting up or using the projector.

Indicator Messages

POWER Indicator

Indicator display Projector status Procedure

Off Power is off. –

Flashing Blue (short flashes) Preparing to turn power on Wait a while.

Blue (long flashes) Off timer (enabled)
Program timer (off time enabled)

–

Orange (short flashes) Projector cooling Wait a while.

Orange (long flashes) Program timer (on time enabled) –

Lit Blue Power on –

Red Standby mode (NORMAL) –

Orange Standby mode (NETWORK STANDBY) –

STATUS Indicator

Indicator display Projector status Procedure

Off No problem, or STAND-
BY MODE - “NETWORK 
STANDBY”

–

Flashing Red (cycles 
of 4)

Fan problem The cooling fan has stopped turning. Contact an NEC 
projector customer support center for repairs.

Flashing Orange Network conflict It is not possible to connect the projector’s built-in LAN 
and wireless LAN simultaneously to the same network. 
To connect the projector’s built-in LAN and wireless LAN 
simultaneously, connect them to different networks.

Lit Green STANDBY MODE in 
sleep mode*

–

Orange Button has been 
pressed while projector 
is in key lock mode

The projector’s keys are locked. The setting must be can-
celed to operate the projector. (→ Page 104)

Projector’s ID number 
and remote control’s ID 
number do not match

Check the control IDs. (→ Pages 105)

*	 Sleep mode refers to the state whereby the functional restrictions due to the standby mode setting are removed.
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LIGHT Indicator

Indicator display Projector status Procedure

Off The light module is 
turned off.

–

Lit Green Light module lit –

TEMP. Indicator

Indicator display Projector status Procedure

Off No problem

Flashing Red (cycles 
of 2)

Temperature problem The temperature protector has been activated. If the room 
temperature is high, move the projector to a cool place. If 
the problem still persists, contact an NEC projector cus-
tomer support center.

Lit Orange High surrounding tem-
perature (Forced ECO 
Mode)

The surrounding temperature is high. Lower the room 
temperature.

If the temperature protector is activated
If the projector’s internal temperature rises abnormally, the light module turns off and the temperature indicator flashes 
(repeatedly in cycles of 2).
It may happen that the projector’s temperature protector is simultaneously activated and the projector’s power turns off.
If this happens, do the following:
-	 Unplug the power cord from the power outlet.

-	 If using in a place where the surrounding temperature is high, move the projector to a different, cool place.

-	 If there is dust in the ventilation holes, clean. (→ page 141)

-	 Wait as such about 1 hour for the projector’s internal temperature to lower.
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Common Problems & Solutions
(→ “POWER/STATUS/LIGHT Indicator” on page 168, 169.)

Problem Check These Items

Does not turn on
or shut down

•	 Check that the power cord is plugged in and that the power button on the projector cabinet or the remote 
control is on. (→ pages 13, 14)

•	 Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the 
room where you are presenting is particularly warm, move the projector to a cooler location.

•	 The light module may fail to light. Wait a full minute and then turn on the power again.
•	 Set [FAN MODE] to [HIGH] when using the projector at altitudes approximately 760 m/2500 feet or higher. 

Using the projector at altitudes approximately 760 m/2500 feet or higher without setting to [HIGH] can 
cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes 
and turn on the projector. (→ page 97)

	 If you turn on the projector immediately after the light module is turned off, the fans run without displaying 
an image for some time and then the projector will display the image. Wait for a moment.

•	 In case it’s hard to think the trouble is not caused on the above mentioned conditions, unplug the power 
cord from the outlet. Then wait 5 minutes before plugging it in again. (→ page 24)

Will turn off •	 Ensure that the [OFF TIMER], [AUTO POWER OFF] or [PROGRAM TIMER] is off. (→ page 100, 115)

No picture •	 Check if the appropriate input is selected. (→ page 16) If there is still no picture, press the SOURCE button 
or one of the source buttons again.

•	 Ensure your cables are connected properly.
•	 Use menus to adjust the brightness and contrast. (→ page 76)
•	 Check that the SHUTTER (lens shutter) or AV MUTE (image off) buttons are not pressed.
•	 Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 116)
•	 Enter your registered keyword if the Security function is enabled. (→ page 35)
•	 If the HDMI IN or the DisplayPort IN signal cannot be displayed, try the following.

-	 Reinstall your driver for the graphics card built in your computer, or use the updated driver.
	 For reinstalling or updating your driver, refer to the user guide accompanied with your computer or 

graphics card, or contact the support center for your computer manufacturer.
	 Install the updated driver or OS on your own responsibility.
	 We are not liable for any trouble and failure caused by this installation.

•	 Signals may not be supported depending on the HDBaseT transmission device. IR and RS232C cannot be 
used in certain cases as well.

•	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning 
on the power to the notebook PC.

	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector 
before being powered up.
*	 If the screen goes blank while using your remote control, it may be the result of the computer’s screen-

saver or power management software.
•	 See also the page 172.

Picture suddenly 
becomes dark

•	 Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the 
case, lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 97)

Color tone or hue is 
unusual

•	 Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 
97)

•	 Adjust [HUE] in [PICTURE]. (→ page 77)

Image isn’t square to 
the screen

•	 Reposition the projector to improve its angle to the screen. (→ page 18)
•	 Use the Keystone correction function to correct the trapezoid distortion. (→ page 32)

Picture is blurred •	 Adjust the focus. (→ page 21)
•	 Reposition the projector to improve its angle to the screen. (→ page 18)
•	 Ensure that the distance between the projector and screen is within the adjustment range of the lens. 

(→ page 153)
•	 Has the lens been shifted by an amount exceeding the guaranteed range? (→ page 156)
•	 Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned 

on. Should this happen, let the projector stand until there is no condensation on the lens.

Image is scrolling 
vertically, horizontally 
or both

•	 Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is 
supported by the projector. (→ page 159)

•	 Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. (→ page 79)
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Problem Check These Items

Remote control does 
not work

•	 Install new batteries. (→ page 10)
•	 Make sure there are no obstacles between you and the projector.
•	 Stand within 22 feet (7 m) of the projector. (→ page 11)

Indicator is lit or 
blinking

•	 See the POWER/STATUS/LIGHT Indicator. (→ page 168, 169)

Cross color in RGB 
mode

•	 Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 23)
•	 Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 

78)

For more information contact your dealer.
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If there is no picture, or the picture is not displayed correctly.

•	 Power on process for the projector and the PC.

	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on 
the power to the notebook PC.

	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector before 
being powered up.

NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, 
this means there is no signal being output from the computer. (→ page 117 or go to next step)

•	 Enabling the computer’s external display.

	 Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. 
When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usu-
ally, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on 
or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through 
external display selections.

•	 Non-standard signal output from the computer

	 If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed 
correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each 
notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. 
Refer to your computer’s documentation for detailed information.

•	 Image displayed is incorrect when using a Mac

	 When using a Mac with the projector, set the DIPswitch of the Mac adapter (not supplied with the projector) ac-
cording to your resolution. After setting, restart your Mac for the changes to take affect.

	 For setting display modes other than those supported by your Mac and the projector, changing the DIP switch on 
a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to 
the 13" fixed mode and then restart your Mac. After that, restore the DIP switches to a displayable mode and then 
restart the Mac again.

NOTE: A Video Adapter cable manufactured by Apple Computer is needed for a MacBook which does not have a mini D-Sub 
15-pin terminal.

•	 Mirroring on a MacBook

*	 When using the projector with a MacBook, output may not be set to 1024 × 768 unless “mirroring” is off on your 
MacBook. Refer to owner’s manual supplied with your Mac computer for mirroring.

•	 Folders or icons are hidden on the Mac screen

	 Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple 
menu and arrange icons.
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❽ PC Control Codes and Cable Connection
PC Control Codes

Function	 Code Data

POWER ON	 02H	 00H	 00H	 00H	 00H	 02H

POWER OFF	 02H	 01H	 00H	 00H	 00H	 03H

INPUT SELECT HDMI	 02H	 03H	 00H	 00H	 02H	 01H	 A1H	 A9H

INPUT SELECT DisplayPort	 02H	 03H	 00H	 00H	 02H	 01H	 A6H	 AEH

INPUT SELECT BNC	 02H	 03H	 00H	 00H	 02H	 01H	 02H	 0AH

INPUT SELECT BNC(CV)	 02H	 03H	 00H	 00H	 02H	 01H	 06H	 0EH

INPUT SELECT BNC(Y/C)	 02H	 03H	 00H	 00H	 02H	 01H	 0BH	 13H

INPUT SELECT COMPUTER	 02H	 03H	 00H	 00H	 02H	 01H	 01H	 09H

INPUT SELECT HDBaseT	 02H	 03H	 00H	 00H	 02H	 01H	 20H	 28H

INPUT SELECT SLOT	 02H	 03H	 00H	 00H	 02H	 01H	 ABH	 B3H

PICTURE MUTE ON	 02H	 10H	 00H	 00H	 00H	 12H

PICTURE MUTE OFF	 02H	 11H	 00H	 00H	 00H	 13H

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

Cable Connection
Communication Protocol

Baud rate	�����������������������������������������38400 bps
Data length	��������������������������������������8 bits
Parity	�����������������������������������������������No parity
Stop bit	��������������������������������������������One bit
X on/off	��������������������������������������������None
Communications procedure..............Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Terminal (D-SUB 9P)

NOTE 1: Pins 1, 4, 6 and 9 are no used.

NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.

1 52 43

6 7 98

To GND of PC

To RxD of PC

To TxD of PC

To RTS of PC

To CTS of PC
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❾ Troubleshooting Check List
Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by 
referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem 
more efficiently.
*	 Print this page and the next page for your check.

Frequency of occurrence  □ always  □ sometimes (How often?_____________________)  □ other (__________________)

Power
□	 No power (POWER indicator does not light blue). See also “Status 

Indicator (STATUS)”.
□	 Power cord’s plug is fully inserted into the wall outlet.
□	 No power even though you press and hold the POWER button.
□	 The main power switch is in the “ON (I)” position.

□	 Shut down during operation.
□	 Power cord’s plug is fully inserted into the wall outlet.
□	 [AUTO POWER OFF] is turned off (only models with the [AUTO 

POWER OFF] function).
□	 [OFF TIMER] is turned off (only models with the [OFF TIMER] 

function).

Video and Audio
□	 No image is displayed from your PC or video equipment to the 

projector.
□	 Still no image even though you connect the projector to the PC 

first, then start the PC.
□	 Enabling your notebook PC’s signal output to the projector.

•	 A combination of function keys will enable/disable the exter-
nal display. Usually, the combination of the “Fn” key along 
with one of the 12 function keys turns the external display 
on or off. 

□	 No image (blue or black background, no display).
□	 Still no image even though you press the AUTO ADJUST button.
□	 Still no image even though you carry out [RESET] in the 

projector’s menu.
□	 Signal cable’s plug is fully inserted into the input terminal
□	 A message appears on the screen.

( _____________________________________________ )
□	 The source connected to the projector is active and available.
□	 Still no image even though you adjust the brightness and/or 

the contrast.
□	 Input source’s resolution and frequency are supported by the 

projector.
□	 Image is too dark.

□	 Remains unchanged even though you adjust the brightness 
and/or the contrast.

□	 Image is distorted.
□	 Image appears to be trapezoidal (unchanged even though you 

carry out the [KEYSTONE] adjustment).

□	 Parts of the image are lost.
□	 Still unchanged even though you press the AUTO ADJUST 

button.
□	 Still unchanged even though you carry out [RESET] in the 

projector’s menu.
□	 Image is shifted in the vertical or horizontal direction.

□	 Horizontal and vertical positions are correctly adjusted on a 
computer signal.

□	 Input source’s resolution and frequency are supported by the 
projector.

□	 Some pixels are lost.
□	 Image is flickering.

□	 Still unchanged even though you press the AUTO ADJUST 
button.

□	 Still unchanged even though you carry out [RESET] in the 
projector’s menu.

□	 Image shows flickering or color drift on a computer signal.
□	 Still unchanged even though you change [FAN MODE] from 

[HIGH] to [AUTO].
□	 Image appears blurry or out of focus.

□	 Still unchanged even though you checked the signal’s resolution 
on PC and changed it to projector’s native resolution.

□	 Still unchanged even though you adjusted the focus.

Other
□	 Remote control does not work.

□	 No obstacles between the sensor of the projector and the 
remote control.

□	 Projector is placed near a fluorescent light that can disturb the 
infrared remote controls.

□	 Batteries are new and are not reversed in installation. 

□	 Buttons on the projector cabinet do not work (only models with the 
[CONTROL PANEL LOCK] function)
□	 [CONTROL PANEL LOCK] is not turned on or is disabled in 

the menu.
□	 Still unchanged even though you press and hold the SOURCE 

button for a minimum of 10 seconds.



175

9. Appendix

In the space below please describe your problem in detail.

Information on application and environment where your projector is used

Projector PC

Blu-ray player

Projector

Model number:
Serial No.:
Date of purchase:
Light module operating time (hours):
Eco Mode:	 □ OFF  □ ON
Information on input signal:

Horizontal synch frequency	 [      ] kHz
Vertical synch frequency	 [      ] Hz
Synch polarity	 H □ (+)  □ (−)
	 V □ (+)  □ (−)
Synch type	 □ Separate  □ Composite
	 □ Sync on Green

STATUS Indicator:
Steady light	 □ Orange  □ Green
Flashing light	 [      ] cycles

Remote control model number:

Installation environment

Screen size:	 inch
Screen type: � □ White matte  □ Beads  □ Polarization 

□ Wide angle  □ High contrast
Throw distance:	 feet/inch/m
Orientation:  □ Ceiling mount  □ Desktop
Power outlet connection:
□	 Connected directly to wall outlet
□	 Connected to power cord extender or other (the 

number of connected equipment______________)
□	 Connected to a power cord reel or other (the number 

of connected equipment______________)

Computer

Manufacturer:

Model number:

Notebook PC □ / Desktop □

Native resolution:

Refresh rate:

Video adapter:

Other:

Video equipment

VCR, Blu-ray player, Video camera, Video game or other

Manufacturer:

Model number:
Signal cable

NEC standard or other manufacturer’s cable?
Model number:            Length:        inch/m

Distribution amplifier
Model number:

Switcher
Model number:

Adapter
Model number:
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